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Preface

This manual

The ProTool/Pro Runtime User’s Guide is a part of the SIMATIC HMI
documentation. It describes:

� commissioning the ProTool/Pro RT runtime software,

� downloading the configuration,

� operating the configuration.

The description is applicable for the following Windows-based systems:

� SIMATIC Panel PC FI25, FI45, PC670, PC670 Touch, PC 870, PC 870 Touch,
PC IL 70,

� Standard PC,

� SINUMERIK Panel PC OP010, OP012, OP015,

� SIMOTION Panel PC P012K, P015K, P012T, P015T.

Organization of the manual

The user’s guide is organized into the following chapters:

Chapter Contents

1 - 2 Introduction and overview of functions

3 Area of use, short description of the objects within a configuration
and an overview of connection options to the PLC

4 - 5 Conditions for initial start up, restarting and downloading the
configuration

6 Operating the runtime software

7 Handling recipes and data records

Appendix HMI System Messages
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Conventions

The following conventions are used in this User’s Guide:

VAR_23 Text which appears on the screen is displayed in a typewriter
font. This text includes: commands, file names, entries in dialog
boxes and system messages.

Tag Dialogs, and fields and buttons in the dialogs, appear in italics.

File → Edit Series of menu items are linked by arrows. The entire path to the
menu item is always specified.

F1 Key names are written in a different typeface.

History

The various editions of this User’s Guide correspond to the following versions of
the ProTool configuration software:

Edition Comment ProTool Version

07/98 First edition From V5.0

01/99 Revised edition of the guide From V5.1

12/99 New: devices, screen objects, recipes From V5.2

07/00 New: PLC drivers, screen objects, touch
panel operation

From V5.2 + Service
Pack 2

12/01 New: devices, screen objects, PLC
drivers

From V 6.0
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Trademarks

The following names are registered trademarks of the Siemens AG:

� HMI

� MP 270

� MP 270B

� MP 370

� ProAgent

� ProTool

� ProTool/Lite

� ProTool/Pro

� SIMATIC

� SIMATIC HMI

� SIMATIC Multi Panel

� SIMATIC Multifunctional Platform

� WinCC

� WinCC Add-on
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Other support

In case of technical queries, please contact the Siemens representatives in the
subsidiaries and branches responsible for your area.

Customer and Technical Support

Available round the clock, worldwide:

Johnson City

Nuremberg

Singapore

SIMATIC Hotline

Worldwide (Nuremberg)

Technical Support

(FreeContact)

Local time: Mon.-Fri. 7:00 to 17:00

Telephone: +49 (180) 5050-222

Fax: +49 (180) 5050-223

E-Mail: techsupport@
ad.siemens.de

GMT: +1:00

Worldwide (Nuremberg)

Technical Support 

(fee-based, only with SIMATIC
Card)
Local time: Mon.-Fri. 0:00 to 24:00

Telephone: +49 (911) 895-7777

Fax: +49 (911) 895-7001

GMT: +01:00

Europe / Africa (Nuremberg)

Authorization

Local time: Mon.-Fri. 7:00 to 17:00

Telephone: +49 (911) 895-7200

Fax: +49 (911) 895-7201

E-Mail: authorization@
nbgm.siemens.de

GMT: +1:00

America (Johnson City)

Technical Support and
Authorization
Local time: Mon.-Fri. 8:00 to 19:00

Telephone: +1 423 461-2522

Fax: +1 423 461-2289

E-Mail: simatic.hotline@
sea.siemens.com

GMT: –5:00

Asia / Australia (Singapore)

Technical Support and
Authorization
Local time: Mon.-Fri. 8:30 to 17:30

Telephone: +65 740-7000

Fax: +65 740-7001

E-Mail: simatic.hotline@
sae.siemens.com.sg

GMT: +8:00

The languages spoken by the SIMATIC Hotlines are generally German and English, the Authorization Hotline is also
provided in French, Italian and Spanish.
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SIMATIC Customer Support Online Services

The SIMATIC Customer Support provides you with additional information about
SIMATIC products through online services:

� General current information can be obtained

– in the Internet under http://www.ad.siemens.de/simatic

� Current product information and downloads which you may find useful are
available:

– in the Internet under http://www.ad.siemens.de/simatic-cs and

– via the Bulletin Board System (BBS) in Nuremberg (SIMATIC Customer
Support Mailbox) under the number +49 (911) 895-7100

To dial the mailbox, use a modem with a capacity up to V.34 (28.8 kBaud)
whose parameters are set as follows: 
– 8, N, 1, ANSI, or 
– dial via ISDN (x.75, 64 kBit).

� Your contact partner for Automation & Drives can be found in the contact
partner database

– in the Internet under
http://www3.ad.siemens.de/partner/search.asp

Abbreviations

The abbreviations used in this manual have the following meaning:

AG (PLC) Programmable Logic Controller

AM Alarm Message

ANSI American National Standards Institute

AS 511 Protocol of the PU interface to SIMATIC S5

ASCII American Standard Code for Information Interchange

EM Event Message

CF Compact Flash

CPU Central Processing Unit

CSV Comma Separated Values

DP Decentralized Periphery

DSN Data Source Name

HMI Human Machine Interface

ISA Instrument Society of America

LED Light Emitting Diode

MPI Multipoint Interface (SIMATIC S7)

OLE Object Linking and Embedding

OP Operator Panel

OPC OLE for Process Control

PC Personal Computer
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PELV Protected Extra Low Voltage

PLC Programmable Logic Controller

PPI Point to Point Interface (SIMATIC S7)

PU Programming Unit

RAM Random Access Memory

SELV Safety Extra Low Voltage

USB Universal Serial Bus

USV Unterbrechungsfreie Stromversorgung

A list of all the specialist terms together with their explanations is provided in the
Glossary at the end of this guide.
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SIMATIC HMI Documentation

Target groups 

This manual is part of the SIMATIC HMI Documentation. The documentation is
aimed at the following target groups:

� Beginners

� Users

� Configuration planners

� Programmers

� Service engineers

Documentation structure

The SIMATIC HMI Documentation includes the following components:

� User guides for

– configuration software

– runtime software

– communication between PLC and operating unit

� Equipment manuals for the following operating units:

– SIMATIC PC

– MP (Multi Panel)

– OP (Operator Panel)

– TP (Touch Panel)

– TD (Text Display)

– PP (Pushbutton Panel)

� Online help for the configuration software

� Installation guides

� Quick reference manuals
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The following table provides an overview of the SIMATIC HMI Documentation
helpful for this manual.

Documentation Target group Contents

ProTool

Online Help

Configuration
planners

Contains the following information while working with
ProTool on the configuration computer:

� context-sensitive help,

� detailed instructions and examples,

� detailed information,

� all information from the user guides.

ProTool/Pro Runtime

User’s Guide

Commissioning
engineers, 
Users

Provides information on working with ProTool/Pro
Runtime software. It contains

� installation of the ProTool/Pro Runtime visualization
software

� commissioning and running the software on
Windows-based systems.

Copy Protection

Start-up Guide

Commissioning
engineers, 
Users

The ProTool/Pro Runtime visualization software is a
copyright product. This manual contains information on
the installation, repair and deinstallation of
authorizations.

Application Example

Start-up Guide

Beginners ProTool is supplied with example configurations and
the corresponding PLC programs. This documentation
describes how you

� load the examples onto the operating unit and PLC,

� run the examples, and

� upgrade the connection to the PLC to suit your own
specific application.

Communication for
Windows-based Systems

User’s Guide

Programmers Provides information on connecting Windows-based
systems to the following PLCs:

� SIMATIC S5

� SIMATIC S7

� SIMATIC 505

� SIMATIC WinAC

� SIMOTION

� PLCs from other manufacturors

This documentation describes

� the configuration and parameters necessary to
connect the units to the PLC and network,

� the user data areas which serve for data exchange
between the operating unit and PLC.
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Introduction

What is ProTool/Pro? 

SIMATIC ProTool/Pro is an easy-to-use, high-performance visualization software
enabling the visualization of processes and runs under Windows 98 SE,
Windows ME, Windows NT 4.0 SP6a and Windows 2000 SP2.

Modern automation concepts make great demands on process visualization. In
particular, process control in the machine-oriented sector must be able to fulfill the
demands made for high-performance and simple control of the processes. The aim
is to present process data to the operator quickly and clearly, and in a form which
can be easily understood; as a trend curve graphic, for example. It is becoming
increasingly important that process representations are presented in ways which
simplify the task of associating the graphics with the actual process. In addition,
there is a growing demand for the possibility to archive data, for quality control
purposes for example. This makes it necessary to archive process data even in the
machine-oriented sector. SIMATIC ProTool/Pro satisfies these demands.

SIMATIC ProTool/Pro has been designed for the visualization and operation of
machines and small plants. The high-performance runtime software enables
reliable process control by providing short response times. One-touch operation on
the machine and reliable data acquisition present no problems.

ProTool/Pro components 

SIMATIC ProTool/Pro consists of the ProTool/Pro CS configuration software and
ProTool/Pro Runtime (ProTool/Pro RT) process visualization software. Both
systems can run under Windows 98 SE, Windows ME, Windows NT 4.0 SP6a and
Windows 2000 SP2 operating systems.

ProTool/Pro CS is used to create a configuration on the configuration computer
(PC or PU) under Windows. ProTool/Pro RT is the program used to run the
configuration and visualize the process under Windows. ProTool/Pro RT is also
used on the configuration computer to test and simulate the project file generated.

1
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Windows-based systems 

SIMATIC ProTool/Pro RT can be run on the following Windows-based systems:

� SIMATIC Panel PC FI25, FI45, PC670, PC670 Touch, PC 870, PC 870 Touch,
PC IL 70

� Standard PC 

� SINUMERIK Panel PC OP010, OP012, OP015

� SIMOTION Panel PC P012K, P015K, P012T, P015T

Authorization

If the SIMATIC ProTool/Pro RT runtime software is installed on a standard PC or a
SIMATIC Panel PC, the corresponding authorization license is required to enable
unrestricted operation: If no authorization license is available, ProTool/Pro RT runs
in Demo mode.

� PC:
The authorization ust be ordered separately.

� SIMATIC operating units with runtime software supplied:
The authorization is supplied with the unit (e.g. Panel PC 670).

Functionality

The SIMATIC ProTool/Pro RT runtime software distinguishes itself through its full
graphic user interface which implements windows techniques. In addition to the
standard functions provided by SIMATIC operating units up to now, it also offers:

� simple process visualization with a Windows-conform user interface

� a large selection of standard input/output fields, bars, trend curves, vector
graphics and buttons

� integrated alarm logging system

� dynamic positioning of objects

� the archiving of messages and process values

� recipes

� Visual Basic Script for user functions

� standard connections to SIMATIC S5, SIMATIC S7 and SIMATIC 505 as well
as to PLCs from other manufacturers

A complete overview of the full functional scope of the SIMATIC ProTool/Pro RT
runtime software is provided in Chapter 2.

Objectives

This guide has been conceived for commissioning, maintenance and system
support engineers. It describes the commissioning and operation of the
SIMATIC ProTool/Pro RT runtime software.
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Further information 

Detailed descriptions of the creation of projects and configuration software
functions are provided in the ProTool Configuring Windows-based Systems user’s
guide and in the online help for ProTool/Pro CS. 

Information on how to link the software to the various types of PLC can be found in
the user’s guide entitled “Communication for Windows-based Systems”. 

Any new information, which could not be included in the manuals before going to
press, is provided in the readme.pdf file in the ProTool Information System which
can be referred to after installing ProTool/Pro Runtime. The docs directory contains
further relevant documents as pdf files.
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Functionality 

The table below summarizes the scope of functions offered by ProTool/Pro RT. The values
stated are maximum values that can be managed by the operating unit. These values are
restricted by the size of the memory.

Functions

Event messages Number 2,000Event messages

Display In message line/message window/
message display

Event messages

View all queued messages In message page/message display

Event messages

Length of message text per line 70 characters (font-dependent) for
message texts configurable in 

ProTool, 
255 characters for message texts

configurable in Step7

Event messages

Lines per message 1

Event messages

Process values in the message
text

8

Event messages

Edit messages �

Event messages

Color-coding of different
message states

�

Alarm messages Number 2,000Alarm messages

Display In message line/message window/
message display

Alarm messages

Display type First/Last, selectable

Alarm messages

View all queued messages In message page/message display

Alarm messages

Length of message text per line 70 characters (font-dependent) for
message texts configurable in 

ProTool, 
255 characters for message texts

configurable in Step7

Alarm messages

Lines per message 1

Alarm messages

Process values in the message
text

8

Alarm messages

Acknowledging individual alarm
messages

�

Alarm messages

Acknowledge several alarm
messages simultaneously (group
acknowledgement)

16 acknowledgment groups

Alarm messages

Edit messages �

Alarm messages

Color-coding of different
message states

�

2
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Functions

Alarm_S Display S7 messages �

Message logging Output to printer �

Volatile message buffer Capacity 1,024 message eventsVolatile message buffer

Viewing event/alarm messages �

Volatile message buffer

Delete �

Volatile message buffer

Print �

Volatile message buffer

Message events queued
simultaneously (max.)

� Event messages:
or

� Alarm messages:

500

250

Archiving Messages

Process values

�

�

Archiving

Archive type Cyclic/Sequence archive

Archiving

No. of archives 100

Archiving

Max. no. of tags which can be
archived

100

Archiving

No. of sequence archives 40

Archiving

Entries per archive 500,000

Archiving

Memory location � File (CSV)
� Database (OBCD)

Message acquisition Time of occurrence Date/timeMessage acquisition

Message events Arrived, departed, acknowledged

Screens Number 300Screens

View �

Screens

Printing (Print Screen) �

Screens

Screen objects � Graphics
� Text
� Output field
� Input field
� Symbolic output field
� Selection field
� Date and time
� Graphic display
� Graphics list
� Graphic box
� Vector graphic
� Button
� Status button
� State view
� Switches
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Functions

Screens Screen objects � Hidden button
� Trend view
� Bar
� Message view
� Single message display
� Status/Force
� Password list
� Recipe display
� Slider controls
� Analog display
� Digital/Analog clock
� SIMATIC HMI Symbol Library

Screens

Operator prompting � Softkey icons 1)

� Dynamic attributes
� Call/Hide objects
� TAB sequence
� Help text

Screens

Fixed window �

Limit monitoring Inputs/outputs �

Conversion functions Inputs/outputs �

Help text Lines/characters 7/35 (font-dependent)Help text

For messages �

Help text

For screens �

Help text

For screen objects � Input field
� Selection field
� Button
� Status button
� Switches
� Hidden button

Print functions Print screen �Print functions Print screen �Print functions

Direct message logging �

Print functions

Shift report �

Password protection Number of passwords

Password level

50

10 (0...9)

Recipes Number 1,000Recipes

User data length 8,000 bytes per data record

Recipes

Total number of entries 20,000

Recipes

Entries per recipe 2,000

Online language switch Number of languages 5

PU functions 
(Status/Force)

SIMATIC S5 �PU functions 
(Status/Force) SIMATIC S7 �

Screen Blanking circuit 2) �

Scheduler Trigger functions cylically or once �
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Functions

VB Script User-specific expansions of
functionality

�

Simulator Simulation of
� Value changes within tags
� Event messages
� Alarm messages

�

�

�

LED control Operator guidance 1) �

Communication SIMATIC S5
� AS511
� PROFIBUS-DP

�

�

Communication SIMATIC S5
� AS511
� PROFIBUS-DP

�

�

Communication

SIMATIC S7/M7
� PPI (S7 protocol)
� MPI (S7 protocol)
� PROFIBUS-DP

(S7 protocol)
� SIMATIC WinAC from

Version  2

�

�

�

�

Communication

SIMATIC S7/M7
� PPI (S7 protocol)
� MPI (S7 protocol)
� PROFIBUS-DP

(S7 protocol)
� SIMATIC WinAC from

Version  2

�

�

�

�

Communication

SIMATIC S7/M7
� PPI (S7 protocol)
� MPI (S7 protocol)
� PROFIBUS-DP

(S7 protocol)
� SIMATIC WinAC from

Version  2

�

�

�

�

Communication

OPC
� Client/Server �

Communication

SIMATIC 505
� NITP
� PROFIBUS-DP

�

�

SIMOTION �

SIMATIC WinAC �

Communication Connection to PLCs from other manufacturersCommunication

Allen Bradley (PLC-5, SLC500)
� DF1
� DH+
� DH485

�

�

�

Communication

LG (Lucky Goldstar)
� GLOFA GM �

Communication

Mitsubishi FX  / 
Mitsubishi Protocol 4

�

Communication

GE Fanuc �

Communication

Omron Hostlink/Multilink �

Communication

Modicon
� Modbus �

Communication

Telemecanique TSX
� Adjust
� Uni-Telway

�

�

1) Not for standard PCs and touch screens
2) Standard screen saver for standard PC and SIMATIC Panel PC.
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Product Description

Area of use 

The SIMATIC ProTool/Pro RT runtime software shows its strengths wherever a
dedicated hardware visualization configuration has reached its limits. SIMATIC
ProTool/Pro RT can run on the following Windows-based systems under
Windows 98 SE, Windows ME, Windows NT 4.0 SP6a and Windows 2000:

� SIMATIC Panel PC FI25, FI45, PC670, PC670 Touch, PC 870, PC 870 Touch,
PC IL 70

� Standard PC

� SINUMERIK Panel PC OP010, OP012, OP015

� SIMOTION Panel PC P012K, P015K, P012T, P015T

SIMATIC ProTool/Pro RT is offered as a pure software variant, e.g. for PCs.

The runtime software is capable of communicating with a wide range of PLCs. An
overview is provided in Chapter 3.2.

Function extensions in the ProTool/Pro CS configuration software 

Since the runtime software can run on any Windows-based PC, the functions with
which the user is familiar can be combined according to individual requirements
and run on one hardware system.

SIMATIC ProTool/Pro CS offers an extended range of functions, which has
become possible as a result of a standardized operating system platform:

� New communication, transfer and downloading possibilities via USB and
Ethernet interfaces guarantee a high degree of configuration efficiency.

� Remote transfer using the ProTool/Pro RT Start menu. 

� Simulation of the configuration on the configuration computer (no PLC
required).

� The new screen objects simplify the creation of process screens considerably.
Simple vector graphics can be created and dynamically updated directly in
ProTool/Pro CS. Graphics from numerous other graphics programs can be
integrated in a project. The user interface can be set out with a Windows� look
and feel familiar to many users. 

� Archiving enables process data, such as tags and messages, to be buffered
over long periods. The amount of data that can be archived depends on the
size of the hard disk. 

3
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� Expand the functionality of ProTool/Pro RT: Visual Basic scripts (VB Script)
enable the implementation of your own functions. 

� Optimized screen objects for touch-based operation enable operation without a
keyboard via operating unit touch panels. 

� The screen object Recipe view enables easy and quick handling of recipes and
data records with a minimum of process configuration requirements. A specific
system can be mapped in Recipe screens and the user interface individually
laid out for editing data records. 

� The configuration software is now even easier to use. Readily available screen
objects, e.g. to display and edit recipes, messages and passwords or for
system diagnostics in respect of PLCs, simplify the creation of individual
screens.

� Menu options are available with which to convert existing projects for a new
target device. Use the Clipboard to copy sections from existing projects and
insert them in a new project. 

� Test the project without the plant being connected by using the simulator
supplied. This means it is no longer necessary to load a project on the target
system in order to test it. 
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3.1 Brief Description of Various Objects in a Project

Objects in a projects 

A ProTool/Pro project is mainly comprised of screens with which to operate and
monitor a machine or plant. It is also possible to configure more objects, such as
messages, archives, recipes and scripts. Links are established to the PLC by
means of tags. The operating unit displays values from the PLC and accepts
values entered manually.

This section provides information on operating the following objects:

� Screens (Page 3-4)

� Messages (Page 3-8)

� Tags (Page 3-10)

� Functions (Page 3-11)

� Archives (Page 3-12)

� Reports (Page 3-14)

� Scripts (Page 3-15)

� Scheduler (Page 3-15)

Information is also provided on the following topics:

� Printing (Page 3-16)

� LED control (Page 3-16)

Information concerning recipes is provided in Chapter 7.
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3.1.1 Screens

The process is visualized by means of screens. Screens show the operator the
current process status in the form of numeric values, bar graphs and trend curves
or in the analog displays. The current position of a production process can be
displayed by means of dynamic screen objects.

The configuration software contains screen objects, listed in the table below, which
can be used to create screens.

Screen object Description

Graphics Graphics can be used in the configuration, for
example, to display the system or as explanatory
symbols for display and operating elements which
have been configured.

Text Texts are used in the configuration to label
display and operating elements, for example.
Texts cannot be modified on the operating unit.

The importance of different texts within a screen
can be distinguished by assigning different fonts
and formats.

Texts can be configured to cover several lines
and in different languages.

Input field The input field is used to enter values which are
then transferred to the PLC. The values can be in
numeric or alphanumeric form. Depending on the
limit values configured, inputs are rejected that
are not within the respective specified range of
values.

The input can be protected by means of a
password.

Output field An output field displays current values from the
PLC in numeric or alphanumeric form.

Symbolic output field A symbolic output field displays current values
from the PLC as plain text.

Example:

Instead of the values 0 and 1 the symbolic output
field displays the texts Motor OFF and Motor
ON.

Selection field Values are not entered in the selection field
character by character but are selected from a
text list. This enables, for example, a motor to be
switched on and off by means of the entries ON
and OFF.
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DescriptionScreen object

Date/Time This screen object is used to display and enter
the calendar date and time. The way in which the
date and time are displayed depends on the
language set on the operating unit.

Graphic display The graphic display enables the dynamic
positioning of graphics from external graphic
programs in the project.
Example:

Instead of using a numeric value indicator, the
position of an object (transported product) can be
visualized by a dynamic graphic.

Graphic list A graphic list displays current values from the
PLC in the form of a graphic. It assigns a graphic
to each tag value. The value of the tag during
runtime determines which graphic is selected
from the list and displayed on the operating unit.
Example:
Instead of the values 0 and 1, the graphic list
displays graphical representations for open and
closed valves.

Graphic box A graphic box enables the selection of a graphic
by selecting an entry from a graphics list.
Example:
Using a graphic selection list it is possible to
design the user interface as language
independent, for example.

Vector graphics The following vector graphic objects can be
configured:

� Line

� Rectangle/Square

� Rounded rectangle/square

� Circle/Ellipse

� Polyline/Polygon

These objects are combined to form vector
graphics with simple, basic geometrical shapes in
your configuration. The type, color and width of
the lines and their transparency, color filling,
rounding radius, etc. can be configured as
desired.

Button A button is a virtual key on the operating unit
screen that can be assigned one or more
functions, depending on the configuration. After
pressing the button, the functions configured for
the event press are triggered. On releasing the
button, the functions configured for the event
release are triggered. 
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DescriptionScreen object

Status button A Status button is a display and operating
element which has one of two states: Touched
and Untouched. The states can be indicated by
means of text or graphics.

The Status button can be configured to be locking
(switch function) or non-locking (keying function).

State view The state viewcan be used to configure a warning
display or the indicate the status of a unit which
cannot be viewed from the operating unit (e.g. a
motor).
The response of the State viewcan be configured.

Switch A switch serves to enter and display a binary
status. It can only be switched on or off.

Invisible button An invisible button is a transparent button that is
not displayed on the operating unit. If invisible
buttons are located over graphics, for example, it
is possible to operate part of the graphic, e.g. a
motor or valve.

After pressing the button, the functions configured
for the event press are triggered. On releasing
the button, the functions configured for the event
release are triggered.

Trend view A trend view provides a particularly clear
representation of process data when displayed as
a continual progression.

Several different trend curves can be displayed
simultaneously in the trend curve display, e.g.
current and archived trend curves.

Bar Bars represent values from the PLC as
rectangular areas. The operating unit thus
provides a clear indication of how far the current
value is from the limit values, or if a setpoint value
has been reached, at a glance. Bars are often
used to represent fill levels or workpiece
numbers.

Direction, scaling, bar and background color and
labeling the Y-axis can be configured as required.
In order to identify limit values, limit value lines
can be called in.

Message view Special filter criteria are configured in the
message view for displaying the volatile message
buffer and/or message archive.

Simple message view A single message display can provide a subset of
the functionality of a message display. It can be
used, for example, to simply realize a message
line in a screen.
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DescriptionScreen object

Status/Force By implementing Status/Force, the operating unit
can be used to access the connected PLC
(SIMATIC S5 and SIMATIC S7) in order to read
and write values directly. PLC operands can be
monitored and modified without having to connect
an additional programming unit or PC to the PLC.

This facility is of special use during the testing
and commissioning phases of the configuration.

Password list The password list can be used to display, enter
and modify passwords on the operating unit.

Recipe view A recipe view can be used to create, save and
transfer data records on the operating unit.

Slider control Use a slider control to enter and display
numerical values in analog form. To enter values,
move the slider to the required position.

When used as a display element, the value is
represented by the position of the slider.

Analog display An analog display indicates numerical values by
means of a pointer instrument.

Digital/Analog clock A digital/analog clock enables the system time to
be displayed either as digits or as a traditional
clock with hands.

SIMATIC HMI Symbol Library The SIMATIC HMI Symbol Library, containing
numerous graphics from production and
techniques, enables graphics to be created in the
project in both abundance and realistically.
They include:
valves, motors, tank containers, conveyor belts,
cooling systems and heating equipment as well
as ISA symbols.

Information on operating the screen objects is provided in Chapter 6.
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3.1.2 Messages

Message classes 

Messages on the operating unit indicate events and statuses related to control
processes. ProTool/Pro differentiates between the following message categories:

� Event Messages
indicate a status in the process, for example, Motor ON. Event messages are
configured. 

� Alarm Messages
indicate an equipment failure, for example, Motor temperature too high.
Alarm messages are configured. Alarm messages must be acknowledged due
to their critical nature.

� HMI System Messages
are triggered by the operating unit. They are not configured. System messages
indicate, for example, incorrect operations or communication faults.

� SIMATIC Diagnostic Events
provide information on the status of the SIMATIC S7 and SIMOTION. They are
not configured in the ProTool/Pro CS configuration software. Refer to the S7
and SIMOTION manuals for the error number indicated on the operating unit to
determine the cause of the error.

Buffering messages

All message events (arrived, cleared, acknowledged) are stored in an internal
volatile buffer. This buffer can contain 1024 message events. If a message archive
has been configured, the message events are also stored in this message archive.
The message archive capacity is only restricted by the storage medium. 

Display messages 

The events stored in the message buffer can be displayed according to different
criteria. The following predefined objects are available for display purposes:

� Message line (refer to Page 6-19) 

� Message window (refer to Page 6-19) 

� Message page (refer to Page 6-22) 

� Message buffer (refer to Page 6-23) 

� Message view

– Message view with full functionality (refer to Page 6-24)

– Simple message view with restricted functionality (refer to Page 6-26)
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3.1.3 ALARM_S 

Definition

ALARM_S is a message number procedure. The message identification numbers
are assigned automatically by the configuration in STEP 7 or SIMOTION SCOUT.
The unique assignment of the message text is made according to these numbers.
The advantage here is that the message texts can be used on various operating
units but only need to be entered once.

If a fault occurs, the operating unit receives the message by means of the
message number. The associated message is determined and issued according to
the number.

In addition to the message status (arrived, cleared, acknowledged), the PLC also
stores the time. This information is retained even after the message has been sent,
so that individual network components (e.g. operating units) can log on later and
be updated.

Configuring ALARM_S messages

ALARM_S messages are not configured in ProTool CS but in STEP 7, e.g. for
S7-300/400-CPUs, or in SIMOTION SCOUT. Therefore, the display of ALARM_S
messages can only be configured when a SIMATIC S7 PLC is used and the
ProTool/Pro CS configuration software has been integrated in STEP 7 or SCOUT
respectively.

When defining the configuration, it is useful to set the time of occurrence of a
message to be displayed with milliseconds.

Detailed information on the configuration of ALARM_S messages is available in the
ProAgent/MP and ProAgent/PC user guides.

Restarting S7 CPUs

Depending on the hardware configuration of the CPUs, it is possible that under
certain circumstances all queued ALARM_S messages will be deleted when S7
CPUs are restarted. Older stocks of S7 300 CPUs cannot inform the operating
units involved of the restart. The result of this is that messages are indicated on
the operating unit as being queued although the CPU has already deleted them.

Remedy:
Disconnect the connection between the operating unit and CPU and then
reconnect them again. Use the function Connect_Disconnect_PLC if configured.
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3.1.4 Tags

Definition

Tags are fixed memory locations on the operating unit into which values are written
and/or read. The actions can be initiated from the PLC or by operations executed
on the operating unit.

Global and local tags

A fundamental distinction is made between the following types of tag:

� Global tags 
Global tags are process tags. They are used to establish a connection to the
PLC. An address must be assigned in the PLC for each global tag. The
operating unit accesses this address to write to or read from it.

� Local tags 
Local tags have no connection to the PLC. They are only available in the
operating unit. Local tags are created in order, for example, to enter limit values
via the operating unit.

� VB script tags 
Internal script tags must be defined with the DIM instruction and are only valid
within the VB Script procedure.
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3.1.5 Functions

Purpose

The  ProTool/Pro CS configuration software provides a range of functions which
can be used in a project. Functions serve to:

� set up the project on a process-specific basis,

� control the process,

� utilize properties of the operating unit,

� define system settings online on the operating unit.

Using functions

Functions are configured to events. These functions are linked to objects within the
project, e.g. to buttons, keys, fields or screens. In addition, events must be defined
that trigger the functions, for example “Press button” or “Release button”. 

Not every function is available for each object. ProTool/Pro CS only provides those
functions in the selection list which can actually be used with the particular object
being configured.

When configuring functions, it is normally necessary to enter input parameters. For
example, in the case of the function Select_Screen, an input parameter is the
name of the screen to be opened.
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3.1.6 Archives

Purpose

Different archives can be set up for message events and tags:

� Message events
these relate to arriving, departing and acknowledging in the case of alarm
messages.

� Tags
these can be assigned to a previously defined archive during configuration.
During the process, it is necessary to specify when the value of the tag should
be written to the archive.

Alternatively, it is possible to specify the name of a file or an existing database for
the archives.

Archive storage in a CSV file 

ProTool/Pro RT enables archives to be stored in a CSV file. In CSV format, table
columns are separated by hyphens and table rows are terminated by a line feed.
This enables archive data to be evaluated or edited easily, e.g. using an external
text editor or a spreadsheet program. 

In order to store the archive data in a CSV file, a directory must be specified in the
ProTool/Pro CS configuration software. The storage location is thus referenced.

Archive storage in a database 

ProTool/Pro RT also enables archives to be stored directly in a database instead of
a file. This means that the entire functionality of the database is available for
further processing and evaluating the archive data. The following databases have
been tested and approved for ProTool/Pro RT:

� MS Data Engine 97 and 2000

� MS Access 97 and 2000

� MS SQL Server 7.0 and 2000

In order to store archive data, a so called Data Source Name (DSN) must be
specified in the ProTool/Pro CS configuration software instead of a directory name.
The DSN is provides a precise reference to the database and its location. 
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The following example emphasizes the necessary steps when using MS Access: 

Step Action

1 Configuring the archive in ProTool/Pro CS 

� Select the Archive dialog, Settings tab, Database memory location
for the archive to be stored in a database.

� Enter the name in Data Source Name under which the archive
should be registered.

� Enter the size of the archive and select the option FIFO buffer.

2 Configure the database on the runtime computer 

� Activate the Windows Start menu, choose Settings → Control Panel
and select the ODBC32 configuration program.

� Insert a new User DSN by using the Add button. The required
database driver must be selected.

� Enter the DSN configured in ProTool/Pro CS in the dialog which
appears. This dialog is specific to the database.

� No other settings are necessary for MS Access.

� More settings must be defined for MS SQL servers. Please refer to
the database manual for information on these settings.

Note

� The number of archives possible may also be restricted by the database used,
e.g. by the configuration, license, etc. 
Please refer to your database manual for information on this.

� If process data is stored on disks, archiving is completed without an
acknowledgement as soon as the disk is full.
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3.1.7 Reports 

Application

Reports are used to document process data and completed production cycles. Use
the ProTool/Pro CS configuration software to define the content and layout of the
various reports and configure the event which should trigger report printout. Up to
10 different reports can be configured. Each report can comprise a maximum of 10
pages.

In this way, for example, it is possible to configure a report which is printed at the
end of a shift in order to document non-production times. It is also possible to
configure a report which can be used for documentation purposes within the scope
of a product or quality test (ISO 9000).

Triggering events

Printout of the report during runtime is triggered either automatically (e.g. via a
scheduler) or manually (e.g. via a function key or softkey).

In order to automatically print a report at the end of each shift, for example, the
Print_report function is configured on the timer.

In order to trigger printout of the report manually, configure the Print_report
function to a function key, for example.

The following events can be configured to trigger printout:

� Scheduler

� Softkey/Function key

� Modification of a tag value

� Script

Print message buffer

A report can be configured so that it can be used to print the message buffer
contents. The following can be configured: the message categories to be printed,
the columns (message number, date, time, message text, etc.) and sorting (most
recent or oldest message first).
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Special printing features

� In order that the report is correctly printed, the printer connected during runtime
must support the paper format and layout of the report. Reports are printed in
Graphics mode. Due to the quantity of data involved, a network or USB printer
should be connected.

� In the report, a tag value is read out and printed at the moment of printing. In
the case of reports covering several pages, there may be a longer period of
time between printing the first and last page. Therefore, it is possible that the
same tag is assigned a different value on the last page than on the first.

3.1.8 Scripts

Purpose

ProTool provides scrips which represent an interface for scripting using the
Microsoft Visual Basic Script (VBScript). VBScript enables the configuration
software to be extended with customized functions. VB scripts are used similarly to
functions. 

Documentation

The detailed Microsoft documentation on VB scripts is contained within the scope
of the ProTool/Pro CS configuration software supplied.

3.1.9 Scheduler

Purpose

A scheduler defines a periodically recurring or unique moment in time (per minute,
hourly, daily, weekly, monthly, annually or one-off) at which specific functions are
initiated. The functions, e.g. printing or archiving functions, are triggered when the
event Time_expired occurs. 

Change scheduler

Schedulers are preset during configuration. If the scheduler is linked to a time
variable (scheduler type “daily”, “annually” and “once”) and the time variable is
assigned to an input field for date and time, for instance, the scheduler times can
be modified on the operating panel. Simply overwrite the times currently defined in
the input fields with new values.
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3.1.10 Printing

Print functions

The following print functions are available in Online mode:

� Hardcopy 
If the Hardcopy function is implemented in the configuration, the screen
currently displayed can be printed out.

� Print messages 
Each message event which occurs (arrived, cleared, acknowledged) is logged
via the printer.

� Print report 
(Refer to Chapter 3.1.7)

� Print message buffer 
(Refer to Chapter 3.1.7)

3.1.11 LED control 

Purpose

The Light Emitting Diodes (LEDs) in the function keys on the SIMATIC operating
unit can be controlled from the PLU. An LED which lights up or flashes can be
used to indicate to the user, for example, that a certain function key on the
operating unit must be operated. 

Condition

In order that the PLC can trigger the LED, the relevant LED Assignment data area
in the PLC must be set up and specified in the project in the project window under
Area Pointers. The assignment of the individual LEDs to the bits in the LED
Assignment must be defined when configuring the function keys.

Detailed information on LED control is provided in the Communication for
Windows-based Systems user’s guide.
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3.2 Connecting to the PLC

Overview

Table 3-1 provides an overview of the connection options of the
SIMATIC ProTool/Pro RT runtime software with various PLCs:

Table 3-1 ProTool/Pro RT connection options 

SIMATIC S5 via AS511

� S5-90U

� S5-95U

� S5-100U (CPU 100, 102, 103)

� S5-115U (CPU 941, 942, 943, 944, 945)

� S5-135U (CPU 928A, 928B)

� S5-155U (CPU 946/947, 948)

SIMATIC S5 via PROFIBUS-DP 1)

� S5-95U L2-DP Master

� S5-115U (CPU 943, 944, 945) 2)

� S5-135U (CPU 928B) 2)

� S5-155U (CPU 946/947, 948) 2)

SIMATIC S7 via PPI

� S7-212

SIMATIC S7 via MPI

� S7-200 (besides S7-212)

� S7/M7-300 (all CPUs)

� S7/M7-400 (all CPUs)

SIMATIC S7 via PROFIBUS-DP 3)

� S7-200 (all CPUs with integrated PROFIBUS-DP interface) 4)

� S7/M7-300 (all CPUs with integrated PROFIBUS-DP interface) 4)

� S7/M7-300 with CPU342-5 4)

� S7/M7-400 (all CPUs with integrated PROFIBUS-DP interface) 4)

� S7/M7-400 with CP443-5 4)

SIMATIC S7 via SIMATIC WinAC 5) 

� Internal communication

SIMATIC 505 via NITP

� Point-to-point connection via RS232/RS422

SIMATIC 505 via PROFIBUS-DP 6)

� All CPUs via CP5434-DP

SIMOTION
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Table 3-1 ProTool/Pro RT connection options, continued

OPC 7) 

� Client/Server 

Allen Bradley via DF1, DH+ (KF2) and DH485

� PLC-5

� SLC 500
LG (Lucky Goldstar)

� GLOFA GM

Mitsubishi 

� FX

� Protocol 4
Modicon 

� Modbus

Telemecanique via Adjust and Uni-Telway 

� TSX

GE Fanuc SNP/SNPX

Omron Host-Link

1) Special function block required (refer to the user’s guide entitled 
Communication for Windows-based Systems)

2) With IM308C or CP5431
3) ProTool/Pro RT is an active node; communication takes place using the S7 protocol
4) Refer to Catalog ST70
5) Only with Windows NT
6) Special application required ((refer to the user’s guide entitled 

Communication for Windows-based Systems)
7) Only with Windows NT and Windows 2000.

Information on how to link the software to the various types of PLC can be found in
the user’s guide entitled “Communication for Windows-based Systems”.
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Requirements for Commissioning

Which components do you need? 

The SIMATIC ProTool/Pro CD contains both the configuration software for all
operating units and the runtime software to run the configuration. If the
configuration should be run on an operating unit without the runtime software being
installed at the factory (e.g. PC or SIMATIC Panel PC), both the runtime software
and the authorization must have been installed on the system beforehand. The
authorization for PCs must be ordered separately on a license disk. 

The license is subdivided according to the number of process tags, the so called
Power Tags. A process tag contains a connection to the PLC. Licenses are
available for power tags with 128, 256, 512 and 2048 tags. In addition, upgrades
(power packs) are available for upgrading to a greater number of power tags. 

4
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4.1 Target Devices 

Operating units supported 

The subsequent descriptions in this guide only relate to the following
Windows-based systems:

� OP37/Pro

� SIMATIC Panel PC FI25, FI45, PC670, PC670 Touch, PC 870, PC 870 Touch,
PC IL 70

� Standard PC

� SINUMERIK Panel PC OP010, OP012, OP015

� SIMOTION Panel PC P012K, P015K, P012T, P015T

The SIMATIC ProTool/Pro CS configuration software supports all SIMATIC
operating units and Windows-based PCs. These operating units are divided into
the following groups:

� Text displays 
TD17

� Text-based display operator panels 
OP3, OP5, OP7, OP15A, OP15C, OP17

� Graphic display operator panels 
OP25, OP27, OP35, OP37

� Touch panels 
TP27-6, TP27-10, TP37

� Windows-based systems 

– Panels 
TP170 A, TP170 B, OP170 B, TP 270, OP 270

– Multi Panels 
MP270 , MP 270B, MP 370
OP37/Pro

– Panel PCs 
FI25, FI45, PC670, PC670 Touch 

– PC

� C7 units 
C7-621, C7-623, C7-624, C7-626, C7-633, C7-634

Please refer to the respective equipment manuals for a more detailed description of
the SIMATIC operating units MP 270B, MP 370, TP 170A, TP 170B, OP 170B,
TP 270 and OP 270.

Supported PLCs

An overview of the runtime software connection options to various PLCs is
provided in Chapter 3.2.
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4.2 System Requirements for PCs 

Operating system

SIMATIC ProTool/Pro RT can be run under the following operating systems:

� Microsoft� Windows� 98 SE

� Microsoft� Windows� ME

� Microsoft� Windows� NT 4.0 with Service Pack 6a 

� Microsoft� Windows� 2000 SP2

If the necessary Microsoft Service Pack is not installed on your PC, the service
packs required for Windows NT 4.0 and Windows 2000 including Internet
Explorer V6.0 are available on two additional CDs supplied.
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Hardware 

The PC hardware must fulfill the following requirements in order to operate the
ProTool/Pro RT runtime software: 

Hardware Minimum requirements Rec.

Operating system Windows 98 SE, Windows ME Windows NT 4.0 SP 6a, Windows 2000 SP2

for multilingual configurations

Windows 2000 SP2 MUI

Processor Pentium II, 233 MHz ≥Pentium III, 500 MHz

RAM 1) 64 MB ≥128 MB

Graphics VGA SVGA with hardware acceleration

Resolution 640 x 480 800 x 600

Hard disk  2) ≥100 MB

Floppy disk drive 3) 3.5’’ / 1.44 Mbytes

CD-ROM For software installation

The PC hardware must fulfill the following requirements in order to operate the
ProTool configuration software:

Hardware Minimum requirements Rec.

Processor Pentium II, 233 MHz ≥Pentium III, 500 MHz

RAM 1) 64 MB ≥128 MB

Graphics SVGA SVGA with hardware acceleration

Resolution 800 x 600 4)

Hard disk  2) ≥300 Mbyte for ProTool + 40 Mbyte each further language

CD-ROM For software installation

1) The amount of RAM required mainly depends on the size of the project, which is largely dependent on
the size of the graphics used.

2) Without taking archives into account. In addition to the space for ProTool/Pro RT, Windows� also
requires a certain amount of free hard disk space, i.e. memory space must be reserved for the swap
file. The following equation has proved applicable:
Size of the swap file = 3 x size of the RAM memory. 
For further information, please refer to the Windows� documentation.

3) For authorization of the runtime software.
4) ProTool/Lite also 640 x 480.
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4.3 Electrical Installation

Connecting an OP37/Pro to the PLC 

The OP37/Pro is connected to the PLC via the IF1A or IF1B interface. The
interface to be used depends on the design (RS 232, RS 422 or RS 485).

Table 4-1 indicates which PLC can, in principle, be connected to which interface of
the OP37/Pro. For more detailed information on this, please refer to the OP37/Pro
Equipment Manual. 

Table 4-1 Using the OP37/Pro interfaces 

PLC OP37/Pro interface

SIMATIC S5 IF1 A

SIMATIC S7 IF1 B

In the OP37/Pro BIOS, use the Integrated
Peripherals mask to set the Internal MPI/DP entry
to IRQ5 (presetting). This activates the ASPC2.

SIMATIC 505 IF1A or IF1B

If the IF1B interface is used, change the interface
setting in the OP37/Pro BIOS. This is carried out
in the Integrated Peripherals screen under the
Serial 1 entry.

Allen Bradley via

� DF1

� DH+ (via KF2 module)

� DH485 (via KF3 module)

IF1A or IF1B

If the IF1B interface is used, change the interface
setting in the OP37/Pro BIOS. This is carried out
in the Integrated Peripherals screen under the
Serial 1 entry.

LG (Lucky Goldstar)

� GLOFA GM

IF1A or IF1B

If the IF1B interface is used, change the interface
setting in the OP37/Pro BIOS. This is carried out
in the Integrated Peripherals screen under the
Serial 1 entry.

Mitsubishi FX IF1A or IF1B

If the IF1B interface is used, change the interface
setting in the OP37/Pro BIOS. This is carried out
in the Integrated Peripherals screen under the
Serial 1 entry.
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Table 4-1 Using the OP37/Pro interfaces, continued

OP37/Pro interfacePLC

Modicon

� Modbus

IF1 A

Telemecanique TSX IF1 B

In the OP37/Pro BIOS, use the Integrated
Peripherals mask Serial 1 entry to change the
interface.

Detailed information on connection to the PLC and cables to be used is provided in
the online help to the ProTool/Pro CS configuration software and in the
Communication for Windows-based Systems User’s Guide.

Connecting a PC to the PLC 

The PC is connected to the PLC via one of the interfaces COM1 to COM4. Please
refer to the hardware manual provided by the manufacturer for instructions on how
to carry out the electrical installation of your PC. A communications processor is
required to connect the PC to SIMATIC S7.

Table 4-2 indicates which communications processors are approved for use with
the PC. 

Table 4-2 Approved communications processors

Communications processor SIMATIC S5 via
PROFIBUS-DP

SIMATIC S7

CP5611 1) � �

CP5511 1) � �

CP5412-A2 2) – �

CP5613 2) – �

CP5614 2) – � 3)

1) Installation instructions can be found on Page 5-9

2) SIMATIC NET driver software is required

3) Use Master connection
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Table 4-3 indicates the basic options for connecting the PC to the PLC. Detailed
information on connection to the PLC and cables to be used is provided in the
online help to the ProTool/Pro CS configuration software and in the Communication
for Windows-based Systems User’s Guide.

Table 4-3 Using the PC’s interfaces 

PLC Interface on PC

SIMATIC S5 via AS511 COM1 to COM4

An RS232/TTY converter cable is required.

SIMATIC S5 via
PROFIBUS-DP

Via communications processor

(see Table 4-2)

SIMATIC S7 Via communications processor

(see Table 4-2)

SIMATIC 505 COM1 to COM4, RS232 interface

SIMATIC WinAC COM1 to COM4, RS232 interface

SIMOTION COM1 to COM4, RS232 interface

OPC Ethernet network card

Allen Bradley via

� DF1

� DH+ (via KF2 module)

� DH485

COM1 to COM4, RS232 interface

LG (Lucky Goldstar)

� GLOFA GM

COM1 to COM4, RS232 interface

Mitsubishi FX / Protocol 4 COM1 to COM4, RS232 interface

Modicon

� Modbus

COM1 to COM4, RS232 interface

GE Fanuc COM1 to COM4, RS232 interface

Omron Hostlink/Multilink COM1 to COM4, RS232 interface

Telemecanique TSX COM1 to COM4
with RS485 interface card
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Commissioning ProTool/Pro Runtime

Initial startup

The procedure for commissioning is dependent on whether the operating unit is a
ready-to-operate unit with the runtime software installed at the factory (e.g. FI25 or
FI45) or a PC, for example, on which the runtime software must be installed by the
user.

� Ready-to-operate SIMATIC operating unit
The ready-to-operate SIMATIC operating units are those in which the operating
system and ProTool/Pro RT runtime software are fully installed at the factory.
An authorization may not be necessary for the runtime software or it is supplied
with the unit, depending on the unit concerned.

� SIMATIC operating unit with runtime software supplied
Before a SIMATIC operating unit can be started up for the first time with the
runtime software supplied (e.g. Panel PC670), the runtime software must be
installed.

The runtime software authorization to use it is acquired with the operating unit; it
is enclosed with the unit.

� PC without runtime software
If a PC is used, the runtime software must be installed from the SIMATIC
ProTool/Pro CD. In addition, an authorization for the runtime software is
required for each PC. The authorization must be ordered separately.

5
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Action

The initial commissioning is organized into three steps. Not all the steps described
below are relevant to all the operating units.

Step Action Operating unit

1 Install and configure the Windows� operating system
(Chapter 5.1)

PC

2 Install the ProTool/Pro RT runtime software
(Chapter 5.2)

PC

SIMATIC Panel PC

3 Download, test and start the project (Chapter 5.5) All

Save configuration

The operating unit hard disk may cease to function after several years of use in a
hostile industrial environment. In order to ensure that all the programs and settings
can be reinstalled on a new hard disk without any problems, a detailed description
is enclosed with the SIMATIC operating unit explaining how to make a backup copy
of the configuration defined the hard disk.

Carry out the backup procedure according to the instructions set out in the
description so that the operating unit is ready for use after replacing the hard disk
and installing the backup data. 
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5.1 Installing and Configuring Windows

The following instructions describe the procedure for installing and configuring
Windows�. These steps are necessary for the ProTool/Pro RT runtime software to
run correctly. Make a note of all the settings so that the runtime software can be
run if the operating unit hard disk needs to be replaced for any reason. 

Step Action

1 Install Windows (PC only)

Information on commissioning Windows� is provided in the Windows
manual supplied.

2 Install the Service Pack for Windows� NT4.0 SP6a (PC only).

Install Service Pack 6a for Windows NT; it is contained on the CD
supplied. Start the following program on the CD-ROM:

\servicep\winnt\deutsch\nt4sp6_i.exe

This program guides the user through the installation procedure. This
directory contains documents from Microsoft that give a detailed
description of the installation procedure.

3 Install printer driver

The  ProTool/Pro RT runtime software can be used with any printer for
which a corresponding Windows printer driver is available. The printer
must be installed under Windows as the default printer because
ProTool/Pro RT only accesses the standard printer. No settings have to
be made for the printer in the runtime software itself.

The printer driver and installation instructions for your printer are
supplied by the printer manufacturer. Windows itself actually includes
suitable printer drivers for many printers. The printer drivers can be set
up via Start → Settings→ Printer→ New printer. The printer must be
specified as the default printer when installing it.

Define the following settings to enable messages to be printed line by
line:

For Windows� 98 SE:

The Forward print jobs to printer option must be set under
printer properties. To do this, select the Properties dialog of the printer.
Click the Spool Settings button on the Details tab. The dialog Settings
for printing in background opens, in which to select the Print directly to
the printer option.

For Windows� NT and Windows� 2000:

The  Print directly to the printer option must be set under
the printer properties. To do this, select the Properties dialog of the
printer. Click the Print directly to the printer option on the Print job
scheduling tab.
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ActionStep

4 Activate multilanguage support  1) 

In the case of certain languages with special character sets, such as
Greek, Polish, Russian, Slovenian, Czech or Hungarian, the
multilanguage support must be activated if Windows��98 SE and
Win ME are used. To do this, select Start → Settings → Control Panel.
Activate multilanguage support under Add/Remove Programs →
Windows Setup → Multilanguage Support.

5 Setting the time zone

Ensure that the correct time zone is set on the PC on which the runtime
software is to run. To set the time zone in Windows, select Start →
Settings → Control Panel → Date/Time → Time Zone.

6 Set screen saver  (option) 

The majority of modern monitors no longer need a screen saver, indeed
a screen saver can actually be harmful to the CRT. These monitors
have a power management function which means they switch
themselves off as soon as the video signal has not been changed for a
specific period of time, which the user can define. A conventional
screen saver prevents, or at least delays, activation of this switch-off
function which can lengthen the service life of the screen. However, if a
screen saver is required, only the standard screen savers incorporated
into Windows are approved for use with ProTool/Pro RT.

7 Coloration of screen objects  (3D objects)

The coloration of screen objects, such as message display, is defined in
the Windows screen property settings under Start → Settings → Control
Panel → Display → Appearance.

1) Not necessary for Windows� NT and Windows� 2000

5.2 Install ProTool/Pro RT

Note

Chapter 5.2 is only relevant for operating units which are not ready to operate,
such as PC670 or a standard PC.
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5.2.1 Install the runtime software

Condition

The ProTool/Pro RT runtime software is contained on the SIMATIC ProTool/Pro
CD. The runtime software requires a license (authorization) to be able to run it.
This is acquired on purchasing a SIMATIC operating unit with runtime software; it is
enclosed with the unit. In the case of a PC, the license (authorization) must be
ordered separately.

If no license has been ordered, ProTool/Pro RT can only run in Demo mode. When
running in Demo mode, a message appears at regular intervals stating that the
runtime software is not licensed.

A detailed description on installation of the license disk is provided in the
documentation enclosed entitled Start-up Guide Copy Protection.

Installation

Proceed as follows to install the runtime software:

Step Action

1 Install the runtime software from the CD.

If the ’autorun’ function for your CD-ROM drive is activated, the CD
browser starts automatically after inserting the CD. If ‘autorun’ is not
active, start the install.exe  program in the root directory of the
CD-ROM. 

2 Use Language to select the user interface language of the Setup
program. 

3 Select Installation and start the installation with ProTool/Pro RT.

4 Follow the installation instructions displayed on the screen.

5 Install the license when prompted.

If there is no license available for the runtime software during
installation, it can be loaded later. Call in the authorsw.exe program
on the license disk and install the license. 
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5.2.2 Communication

Connection to the PLC

ProTool/Pro RT supports communication with the PLCs listed in Chapter 3.2.
Connect the operating unit to the PLC in order that the project can also be tested
when connected to the PLC. The simulator can also be started to test the project
(Page 5-14). In this case, there is no need for a connection to the PLC. 

Communication with PROFIBUS-DP

If the ProTool/Pro RT runtime software is to be run on SIMATIC S7 using the
profile PROFIBUS-DP and no connection is established, it is possible that the bus
parameters are incorrect.

Proceed as follows to reset the parameters to their default values:

Step Action

1 Activate the Start menu and select Settings → Control Panel and open
the Set PU/PC interface dialog.
PROFIBUS must be selected in Component configuration used.

2 Click on the Properties button.
In Network Parameters, DP is selected as the profile.

3 Select Universal (DP/FMS) and confirm the selection with OK.

4 Click on the Properties button again.
In Profile, select DP again and confirm the selection with OK.

MPI setting

Step Action

1 Activate the Start menu and select Settings → Control Panel and open
the Set PU/PC interface dialog.

2 Press the Properties button and set the parameters for the operating
unit on the MPI Network tab control so that it is the only master on the
bus.

Note
If several operating units must be operated via MPI, ensure that only
one unit is the master on the bus.

Detailed information on communication between the PLC and operating unit is
provided in the Communication for Windows-based Systems User’s Guide. 
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5.2.3 ProTool/Pro Runtime integrated in PC workstation from Step 7

Special feature

1. The content of the SIMATIC NET CD is installed on the runtime PC from
7/2001.

2. ProTool/Pro RT is installed in the HW Config in the PC workstation.

3. The check box S7RTM is installed is activated in the SIMATIC Manager of the
PC workstation.

Further information is available on the SIMATIC NET CD.

Action

1. Start the Components Configurator.

2. Add ProTool/Pro RT.

Ensure that the same index and name are selected as in the HW Config from
Step 7.

Condition

ProTool can be integrated as a standalone application or in the SIMATIC Step 7
configuration software when a SIMATIC PLC is used and the Step 7 configuration
software is installed on the system. It is possible to select icons and data blocks
from SIMATIC STEP 7 in ProTool as tags. This prevents errors caused by
repeated input.

If, for example, a WinAC PLC is installed on a PC workstation on which the runtime
is also installed, it can be triggered as the PLC in ProTool Runtime. In addition, it is
also possible to communicate with SIMATIC PLCs outside the PC workstation via a
network.
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SIMATIC manager

When working with ProTool integrated in SIMATIC STEP 7, the SIMATIC Manager
is available for use with the ProTool projects. The following tasks can be completed
without opening ProTool:

� Generate and transfer ProTool projects

� Start ProTool RT via File → Start Runtime

� Export and import texts for translation

� Define language settings

� Copy or move ProTool projects

� Archive and dearchive ProTool projects within the scope of SIMATIC STEP 7
projects

Please refer to the documentation on the SIMATIC Manager for more detailed
information.

Switch STEP 7 integration from ProTool

If ProTool has been installed integrated in SIMATIC STEP 7, the ProTool File
menu provides the menu item Integration in STEP 7. This enables ProTool to be
integrated in or deinstalled from (i.e. operated in standalone mode) SIMATIC
STEP 7. After switching the integration mode, ProTool is automatically restarted.

The integration of ProTool in SIMATIC STEP 7 is still possible via the ProTool
Setup, regardless of this.

In integrated mode, it is also possible to deinstall individual projects so that they
can be processed by ProTool in standalone mode (e.g. on another configuration
computer).

Integrating and removing individual ProTool projects

Projects created using ProTool in standalone mode cannot be called in directly via
the SIMATIC Manager. In order to include such projects in a STEP 7 project, they
must be integrated.

To do this, activate ProTool and select the menu items File → Integrate.

Conversely, in order to process projects, which were created integrated in
SIMATIC STEP 7, in ProTool in standalone mode without SIMATIC STEP 7 being
available, these projects must first be deinstalled.

To do this, activate ProTool and select the menu items File → Unintegrate.
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5.3 Retrofitting a Communication Processor 

Condition

SIMATIC Net CD 7/2001 is not installed.

Purpose

The steps described below are only necessary if a CP5511 or CP5611
communication processor is retrofitted to enable connection to a SIMATIC S7.

Information on the other communication processors is provided in the installation
manual enclosed with the respective component.

Recommended procedure

First, install the runtime software before installing the communications processor.
Proceed as follows:

Step Action

1 Install the runtime software.

2 Switch off the operating unit.

3 Slot in the communications processor.

4 Start up the operating unit again.

The communications processor is detected and configured
automatically (Plug&Play function) when the PC is booted.

If the communications processor is installed before the runtime software, the
communications processor cannot be activated by the installation program.

Remedy:

Step Action

1 Activate the Start menu, select Settings → Control Panel → System
and select the device manager.

2 Remove the unrecognized component, PCI Network Controller, from
the list.

3 Start up the operating unit again.

The communications processor is detected and configured
automatically (Plug&Play function) when the PC is booted.
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5.4 Settings for the OP37/Pro 

Settings in BIOS 

Different settings must be defined in the BIOS of the OP37/Pro, according to the
connection used. In the case of serial connections, the corresponding COM
interface must be activated.

Information on this is provided in the OP37/Pro equipment manual, the
Communication for Windows-based Systems User’s Guide and in the ProTool/Pro
CS configuration software online help.

Note
Restart the OP37/Pro after carrying out any changes in the BIOS so that the new
BIOS settings take effect.

Direct key module 

The hardware based control of the direct key module outputs via the OP37/Pro
keyboard can be used without restrictions. However, the runtime software
ProTool/Pro RT does not support defining ports by means of messages.

5.5 Downloading, Testing and Commissioning the Project 

5.5.1 Scenarios 

Overview

ProTool/Pro RT is the application with which a project can be run online. However,
this project must first be created with the ProTool/Pro CS configuration software.
Detailed information on how to create projects can be found in the online help of
the ProTool/Pro CS configuration software and in the ProTool Configuring
Windows-based Systems User’s Guide.

A number of scenarios are possible for testing the project:

� The ProTool/Pro RT runtime software is installed on the same PC as the
ProTool/Pro CS configuration software (Page 5-11).

� The ProTool/Pro RT runtime software is installed on a different PC from the
ProTool/Pro CS configuration software. In this case, the project must be
downloaded from the configuration computer to the target PC (Page 5-11).

� The project is first tested using the simulator. The project can be tested on the
same PC as that on which the configuration software is installed (Page 5-14).
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Configuration software and runtime software are on the same PC 

1. Create the project, for example, under the name Myproject.pdb, and then
compile it. Once compilation has been completed, a compiled file with the
extension *.fwd is stored in the same directory as the project file (for example,
Myproject.fwd).

2.  Start the ProTool/Pro RT runtime software directly from the configuration
software currently running using the icon depicted. 

3. If the PC is connected to the PLC, the project can be tested immediately in
connection with the PLC.

Information on how to simulate the project without a PLC using the simulation
program is provided in Chapter 5.5.3.

Configuration software and runtime software are on different systems

Create the project, for example, under the name Myproject.pdb, and then
compile it. Once compilation has been completed, a compiled file with the
extension *.fwd, e.g. Myproject.fwd is stored in the same directory. Windows
provides the following options for downloading the compiled files:

� Copy the *.fwd file on to a floppy disk and then from the disk to the target
system (PC). If the project is too large for one disk, use the disk transfer option.

� Disk transfer: 
In ProTool/Pro CS, select the menu option File →Download and select drive A:\
in the Destination Directory dialog. The operation-capable project file is
transferred to one or more disks in a compressed form.

In order to decompress the compressed project file on the target device,
activate the Start menu and select SIMATIC → ProTool/Pro RT → ProTool/Pro
disk transfer. Select the compressed file, e.g. Myproject.f00 in the Transfer
dialog and enter the destination directory in which the decompressed project file
should be copied.

� Copy the *.fwd file from Windows� 98 SE to the target system via a parallel or
serial cable using the Direct Cable Connection option.

� Copy the file *.fwd  file from Windows � NT or Windows� 2000 to the target
system via a parallel or serial cable using the Dial-Up Connection option.

� Copy the *.fwd file to the target system via a network.

Double-click on the compiled project file to start the runtime software on the target
system.

Note
Before starting up a new project, delete all the archive files on your operating unit
which were not created with the new project.
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5.5.2 Start Menu for PC

Figure 5-1 Start menu for PCs

Start the PC Loader (Start menu) via the Windows Start menu SIMATIC →
ProTool/Pro RT → ProTool/Pro RT Loader. The PC Loader offers the following
options.

Press the Transfer button to switch the operating unit to download mode in order to
load a configuration.

Press the Start button to start the runtime software automatically.

After pressing the Settings button, the following window opens in which various
settings can be defined.
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Figure 5-2 Settings window

� The Channel section of the Setting menu can be used to activate the required
communication channel. In addition to the serial communication channel, a
second channel can also be selected to download data from the configuration
computer to the operating unit.

� The Directories section enables the following settings to be made:

– Configuration file 
The predefined storage location for the project file can be changed here.
During the next downloading process, the configuration is stored in the
storage location specified. 

– Configuration backup file 
The predefined storage location for the source file of your configuration can
be changed here. This file can be used for restoring (downloading back) the
configuration. External Flash cards or network connections can be set for the
operating unit. 

– Autostart application 
Path
This defines the storage location for the ProTool/Pro runtime project. The
path for a standard installation is:
c:\siemens\PtProRun\PtProRun.exe
Wait (s)
It is possible to define the number of seconds the Start menu should remain
on screen before the runtime is started (1 s, 3 s, 5 s, 10 s or constantly). If
no ProTool/Pro runtime project is available, the unit automatically switches to
download mode.

Press the Exit button to close the PC Loader.
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5.5.3 Simulation of a project 

Function

The scope of delivery in respect of the ProTool/Pro RT runtime software contains a
simulator with which to test the project without a PLC. The simulator is a separate
application. It enables the user to test whether the screens, screen objects,
messages, etc. which have been configured function correctly.

The simulator simulates the PLC and 

� modifies the values of configured tags in a definable way:
e.g. incrementally, decrementally, sinusoidally, randomly or by shift bits,

� sets bits in bit-by-bit organized area pointers:
by shifting the bits in the two area pointers Event Messages and Alarm
Messages, it is possible, for example, to trigger all the configured messages on
the operating unit. 

A condition for simulation is that the ProTool/Pro RT runtime software is also
installed on the configuration computer.

Principle

There are several methods of simulating a finished project:

� Simulation with connection to the PLC

The project can be simulated by running it directly during the runtime. In this
case, tags and area pointers are only capable of functioning when the
configuration computer is connected to a corresponding PLC.

If the computer is connected to a PLC, the runtime provides an authentic
simulation of the configured operating unit.

For simulation with ProTool/Pro RT, select the menu item File → Test → Start
Runtime.

� Simulation without connection to the PLC

The simulation program automatically installed with ProTool/Pro RT can be
used to simulate a project, including tags and area pointers, without the
necessity of a connection to a PLC. The tag and area pointer parameters are
entered in a simulation table which is read in during the simulation from
ProTool/Pro RT.

For simulation using the simulator, select the menu item File → Test → Start
Simulator.

� Simulation in integrated mode

If a configuration is created integrated in STEP 7, PLCSIM V5.0 can be used to
simulate connection to a PLC. Please refer to the STEP 7 documentation for
more detailed information.
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The following steps describe the basic steps necessary to simulate a project
without a connection to a PLC. Step-by-step instructions are provided in Table 5-1.

1. First of all, create a project as it is to run later when connected to the PLC.

2. Save and compile the project.

3.  Start the simulator directly from the running configuration software by
clicking on the icon depicted or via menu options File → Test → Start Simulator.
If the simulator is started without having compiled the project beforehand,
compilation is automatically triggered.

4. When the project is simulated for the first time, the simulator is started with a
new, empty simulation table. If a simulation table already exists for the project, it
is opened. 

All the settings are saved in simulation table *.sim defined for the simulation of
tags and area pointers (refer to Figure 5-3).

5. Now manipulate the project tags and area pointers in the simulation table.

6. It is possible to watch how the values change by switching the task from the
simulator to the project. 

Simulation table 

Figure 5-3 Simulation table (example)

Figure 5-3 illustrates an example of a simulation table. All the settings defined in
this table for simulating the project can be saved in a file. In this case, select File →
Save in the simulator and enter a file name (*.sim). 

This means that the project can be simulated again at a later date with saved
settings. A condition for this is that the tags and area pointers to be simulated in the
project have not be altered in the meantime.
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Tags

Tags available 
Not all the configured tags are provided in the simulation table. Only referenced
tags are available for the simulation, i.e. only those tags used in the project e.g. in
a screen object.

Archive tags 
In order to be able to simulate archive tags, activate the option Read continuously
when configuring the tags in the tag dialog on the Options tab control.

Data formats

PLC-specific data formats
Since the simulator can only simulate the project offline, i.e. without a connection to
the PLC, the data formats are converted to internal ProTool/Pro CS formats.
Therefore, PLC-specific data formats cannot be realized.

Date and time 
The simulator converts data formats for date and time, e.g. DATE, DATE AND
TIME and TIME OF DAY, to an internal format which contains both the time as well
as the date. If simply the time is entered for such a tag in the simulation table, for
example, the missing part, in this case the date, is also modified. Therefore, enter
the full value with time and date when simulating tags with time or date dependent
formats.
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Operate simulator 

The following instructions provide a detailed description of the procedures for
operating the simulator.

Table 5-1 Simulator operation, step-by-step 

Step Action

1 Start the simulator directly from the running configuration software by
clicking on the icon depicted or via menu options File → Test → Start
Simulator.

2 When the project is simulated for the first time, the simulator is started with a
new, empty simulation table. If a simulation table already exists for the project,
it is opened. 

All the settings are saved in simulation table *.sim defined for the simulation
of tags and area pointers (refer to Figure 5-3).

2

Note
Use the two menu options File → Open and File → Save to open and save the
simulation tables in the simulator. This does not open and save the project to
be simulated. To do this, use the corresponding menu options in the
configuration software.

3 Now manipulate the project tags and area pointers in the simulation table.

Use the Tag column to select all the tags and area pointers to be modified and
observed during the simulation.

3

Click on the following symbol in the last line for each tag to be inserted:

4 Use the Format column to select the data format in which the values should be
represented in the table, e.g. Text, Dec, Hex or Bin.

The formats available are dependent on the configured data type.

5 Use the Write Cycle column to specify the intervals (in seconds) at which the
value is to be written in the project.
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Table 5-1 Simulator operation, step-by-step, continued

ActionStep

6 Use the Simulation column to specify the manner in which the value of the tag
is to be simulated:

� Sine 
The value of the tag is changed in the form of a sine curve.

� Random  
The value of the tag is changed via a random function.

� Incrementation 
The value of the tag is continuously increased up to a specified maximum
value. The progression of the values corresponds to a positive saw-tooth
curve.

� Decrementation 
The value of the tag is continuously decreased down to a specified
minimum value. The progression of the values corresponds to a negative
saw-tooth curve.

� Shift bit
A set bit is continuously shifted one position forward. The previous position
is reset each time. This enables all the configured event messages in the
area pointer Event Messages, for example, to be triggered in succession.

� Display
The current value of the tag is displayed.

The simulation types available are dependent on the configured data type.

7 Use the Set value column to specify the start value for the simulation. This is a
numerical value. If you have selected the Shift bit option beforehand in the
Simulation column, the most significant bit of the value is taken as the initial bit
and the subsequent bits are appended after this bit.

To set a single value, enter it here, directly.

8 Enter minimum and maximum values in the MinVal and MaxVal columns,
respectively, for the simulation. The sinus curve, for example, is written within
the value range defined here.

9 Use the Cycle column to specify the interval, in seconds, in which a tag value
should be written in a project, e.g. sinusoidal.

10 If the check box is activated in the Start column, the simulation is started with
the specified values. After switching the task to project, the value changes are
visualized and can be observed.

To stop simulation, deactivate the Start check box.
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Example of a simulation 

The example in Figure 5-4 uses a sine curve to illustrate how the values of a tag
are written into the configuration in accordance with the settings in the simulator.
The following settings have been made in the simulator:

� Set value = 0

� MaxVal = 5

� MinVal = –5

� Write cycle = 10 * 1s

� Cycle = 100 * 1s

Start value = 0

Maximum value = 5

Minimum value = –5

Period = 100 s

= Time stamp at which a value is written into the project

Figure 5-4 Simulating a tag as a sine curve



Commissioning ProTool/Pro Runtime Release 12/01

5-20
User’s Guide ProTool/Pro Runtime 

6AV6594-1CA06-0AB0

5.6 Starting a Project 

Running a project in online operation

Once a project has been created, there are a number of different options with
which to start it. A condition for this is that the compiled project is initially
downloaded to the target system in cases where the configuration computer is not
simultaneously the target system.

� Double-click on the *.fwd file generated. In this way, the ProTool/Pro RT
runtime software is started with the selected file.

� Call in the ProTool/Pro RT runtime software under the program group SIMATIC
→ ProTool Pro RT → ProTool Pro RT. The project file to be started can be
selected when the runtime software is running.

� Call in the ProTool/Pro RT runtime software from the command line. The
command could, for example, be as follows:
c:\siemens\ptprorun\ptprorun.exe c:\proj\myproject.fwd

� If a project should be opened directly following startup of the runtime software,
the file must be entered in the initialization file ptprorun.ini. The initialization
file is located in the same directory as the ProTool/Pro RT runtime software.
Enter the name of the project in the [configuration] section. The line
entered could read as follows:

LoadConfigFile=MyProject.fwd

Set up program icon 

If the user wants to be able to start the project from the desktop by clicking on the
program icon, the following settings must be made:

Step Action

1 Position the mouse on a free area of the desktop and click the right-hand mouse
button. Select New → Link from the context menu which appears.

2 Click on the Browse button in the subsequent dialog and select the program
ptprorun.exe.

3 Enter a name for the icon in the next dialog which appears.

4 Click on the Complete button.

5 Click on the new icon with the right mouse button and select menu option
Properties from the context menu which appears. Enter the ProTool/Pro RT
runtime software and the project to be started in the Target field. The call could
appear as follows, for instance:

c:\siemens\ptprorun\ptprorun.exe c:\project\myproject.fwd

Start project when booting the system

In order to automatically run a project each time the system is started, the
corresponding entry must be made in the Startup group in Windows. Firstly, create
an icon on the desktop as described above and then move this icon to the Startup
group by means of the Windows Explorer.
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Start the project using the PC Loader menu

To start a project via the PC Loader menu (refer to Ch. 5.5.2 on Page 5-12), load
the relevant project by using the Transfer button and start the runtime software by
using the Start button.

5.7 Further Downloading Options

Set up direct cable connection

A direct cable connection between PCs enables the transfer of files from one PC to
another. This method of data transfer can also be used to download a compiled
project file. A direct cable connection must be set up on both computers to be
connected. The PC direct connection can be set up to be serial or parallel.

Tables 5-2 and 5-3 provide a step-by-step description of how to configure the
runtime PC (PC on which the configuration runs) and the configuration PC (PC on
which the configuration was created) for a direct PC cable connection.

Table 5-2 Setting up a parallel direct connection on the runtime PC 

Settings on the runtime PC

Step Action

1 Start the Direct Cable Connection program under 
Start → Programs → Accessories  → Direct Cable Connection. 1)

2 Use the Direct Cable Connection dialog box to activate the Host
Computer option. 2)

3 Activate Start → Settings → Control Panel → Network to check the
properties of the communication driver in the Configuration tab control.
Only IPX/SPX-compatible protocol must be activated on the Bindings
tab of the Properties dialog box .

4 Then start the Direct Cable Connection program (steps 1 and 2).

5 Select Parallel cable to LPT1 as the connection setting.

6 In the next dialog box, click the File and Printer Enable button.

7 Click on the File and Printer Enable button once again in the next dialog
box that appears for entering the network settings. Activate the Other
users can access my files option.

8 The Password Protection option in the next dialog box must be
deactivated.

9 The runtime PC now monitors the interface and waits for data from the
configuration PC.
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Table 5-2 Setting up a parallel direct connection on the runtime PC, continued

ActionStep

10 Now enable one of the drives or a directory, for example c:\ptproj,
so that it can be accessed by the configuration PC. To do this, select
the desired directory in the Windows Explorer. Click the right mouse
button to open the context menu and select the Enable menu item.
Enter an enable name, for example PTProj.

1) If the program is not on the PC, install it before doing anything else. Select Start
→ Settings → Control Panel → Add/Remove Programs. Then select the Windows
Setup tab, double-click Communications and then activate the Direct Cable
Connection check box.

2) If a dial-up network has not been installed, a prompt appears requesting insertion of
the Windows CD-ROM. The dial-up network is installed and the PC may be restarted.

The ProTool/Pro RT runtime software is thus installed on the PC. Data can then be
downloaded, e.g. the compiled project file. The next step to take is to install and
configure the direct cable connection on the configuration PC.

Table 5-3 Setting up a parallel direct connection on the configuration PC 

Settings on the configuration PC

Step Action

1 Start the Direct Cable Connection program under 
Start → Programs → Accessories  → Direct Cable Connection. 1)

2 In the Direct Cable Connection dialog, mark the option Guest
Computer. 2)

3 Activate Start → Settings → Control Panel → Network to check the
properties of the communication driver in the Configuration tab control.
Only IPX/SPX-compatible protocol must be activated on the Bindings
tab of the Properties dialog box.

4 Then start the Direct Cable Connection program (steps 1 and 2).

5 Select Parallel cable to LPT1 as the connection setting.

6 Connection to the runtime PC is now set up.

7 Once the connection has been set up, a prompt appears requesting the
name of the runtime PC. The name (e.g. PC670) is located under Start
→ Settings → Control Panel → Network on the Identification tab.
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Table 5-3 Setting up a parallel direct connection on the configuration PC, continued

ActionStep

8 Use Windows Explorer to link a drive with the directory provided on the
runtime PC (e.g. D:\). To do this, select the Explorer menu option
Options → Connect Network Drive. In this case, it is possible to connect
a drive with a network path enabled on the runtime, e.g.
\PC670\PTProj.

9 Then use Windows Explorer, for example, to simply copy a compiled
project file from the configuration PC to the runtime PC. It is also
possible to download the compiled project file directly from the
ProTool/Pro CS configuration software  to the runtime PC. Select the
menu option File → Download and use the Destination Directory dialog
to select the linked drive (e.g. D:\). Subsequently, each time a
downloading process is activated, the compiled project file is
automatically transferred to the runtime PC.

1) If the program is not on the PC, install it before doing anything else. Select Start
→ Settings → Control Panel → Add/Remove Programs. Select the Windows Setup
tab. Double-click Communications and then activate the Direct Cable Connection
check box.

2) If a dial-up network has not been installed, a prompt appears requesting insertion of
the Windows CD-ROM. The dial-up network is installed and the PC may be restarted.

Setting up a dial-up network connection

The Dial-Up Network provided by Windows� 98 SE or the RAS package from
Windows NT 4.0 SP6a and Windows 2000 SP2 can be implemented to set up a
virtual network using  serial or parallel cables, via Internet or modems.

Information concerning the installation of dial-up networks is provided in the
Windows documentation. n the case of Windows 98 SE, Windows NT and
Windows 2000 SP2, all the necessary components are supplied.
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Operating ProTool/Pro Runtime

6.1 General Operation 

Overview

The operation of processes during runtime is dependent on the project created.
This chapter only contains general information regarding settings for the runtime
software and controlling predefined screen objects. Screen objects provide the
user with general system functions. Screen objects can be used in screens
implemented in a project and configured according to individual requirements.

Methods of operation

The ProTool/Pro RT runtime software can be operated via a mouse, keyboard or
touch screen. In the case of mouse or touch panel operation, it is of particular
advantage to integrate buttons, status buttons, switches and hidden buttons in the
project. When it is possible to influence a screen object by means of a mouse
action, the cursor symbol changes, by means of a button on the PC e.g. by the
symbol  .

Pressing several keys

Note

Never press more than one function key/softkey or button (when using touch
panels) on the operating unit at the same time. Otherwise, actions may be
inadvertently triggered under certain circumstances.

6
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Operating screens via the keyboard
The navigation options indicated in the Table 6-1 are available for carrying out
actions on a screen using the keyboard.

The type of cursor control via the keyboard can be defined in the ProTool/Pro CS
configuration software (refer to Page 6-8). This guide describes the settings for
ProTool versions from V 5.2.

Table 6-1 Operating screens via the keyboard 

Navigation PC SIMATIC Panel PC

Move to next field right/left 

Move to next field
below/above

Move in field right/left

� Use the ENTER key
– to apply values (e.g. in input fields)
– to open list boxes

� Use the ESCAPE key to cancel input.

� Use the TAB key to access the next screen object
which can be acted upon according to the
configured tabulator sequence. 
By pressing it simultaneously with the SHIFT key,
access is made in the reverse sequence.

� In order to navigate between screens on the PC, for
example, the function keys depicted on the right
can be assigned functions, e.g. Select Screen: 

...

...

� In the case of a SIMATIC operating unit, it is
possible to assign a different number of global and
local function keys, according to the unit.

The name of these keys is dependent on the unit,
e.g.:

!
Caution

If a function key is pressed before changing screens, it is possible that the
corresponding function is triggered before the new screen has appeared.
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Operating Windows via the keyboard
It is possible to control the operating unit operating system via the keyboard, if
necessary. Detailed information on this is provided in the Windows manual. The
most important key combinations for the SIMATIC Panel PCs are depicted in
Table 6-2.

Table 6-2 Operating Windows via the keyboard 

Navigation Operating Unit

Open Start menu

Display pop-up menu for the marked element

Mark all

Display the properties of the marked element

Explorer:

Change folders

Change display area

Activate menu bar

Dialogs:

Continue to next field

Return to previous field

Open next tab control

Open previous tab control
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Touch panels 

Touch panels, e.g. Panel PC670 Touch, are operated by directly touching the
operating elements on the contact sensitive screen. This represents the basic
difference between touch panel operation and mouse operation.

In order to enter values, the touch panel automatically displays a screen keyboard
after touching an entry field, for example. The screen keyboard is also displayed
automatically if a password needs to be entered in order to activate a password
protected function. After completing the input, the screen keyboard is automatically
hidden. Depending on the input field configured, the screen keyboard provides
buttons for pure numeric input or for alphanumeric input.

The screen keyboard is positioned dynamically during runtime. In this way, the
corresponding input field always remains visible on the operating unit. 

Figure 6-1 illustrates an example of a German screen keyboard for Panel PCs to
enter alphanumeric values.

Figure 6-1 Example of a screen keyboard for Panel PCs

If the function Use_On_Screen_Keyboard_ON/OFF has been configured in your
project, it is possible to suppress the screen keyboard, e.g. to implement an
external keyboard or as a result of certain operating situations. 

Fixed window

The fixed window is a configurable window positioned at the top edge of the
screen. The content of the fixed window is independent of the current screen.
Therefore, it is particularly suited for displaying process magnitudes or the time and
date.

An operating element configured in the fixed window is available in every screen.
When using touch panels, for example, a button can be configured in the fixed
window to represent a globally effective function key.

Call help text

Help texts can be configured in ProTool/Pro CS for messages, screens and
operable screen objects. Help texts provide additional information and operating
notes on the operating units. Help text can involve information on permissible value
ranges regarding an input field or the cause and elimination of a fault related to an
error message.
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Keyboard units :
When using units equipped with a keyboard, proceed as follows to call in the
configured help text, e.g. for an input field:

Step ActionStep
SIMATIC Panel PC PC

1 Select the required input field, e.g.
using the Tabulator key.

Click on the input field.

2 The LED in the HELP key lights up,
indicating that a help text is available.

Press the operating element, e.g.
function key F1, with which the
Display_Help_Text function is linked.

2

Press the HELP key

Press the operating element, e.g.
function key F1, with which the
Display_Help_Text function is linked.

3 The help text configured for the input field is displayed on the operating unit in
the language set. If a help text has also been configured for the current
screen, it is displayed too.

Touch panels:
Help texts for messages, screens and input fields are available, if configured, when
using touch panels. Proceed as follows in order to call in the configured help text:

� Help on messages 
Touch the following button in the message window, on the message page, in
the message buffer or the message display 

� Help on input fields
Touch the Help key on the screen keyboard. This key only appears if a
configured help text exists.

� Help on current screen
If the function Display_Help_Text has been assigned to a button, for example,
touch that button to call in the help text configured for the current screen. 

� Help on focussed screen object 
Press the key combination ALT + H either on the screen keyboard or the USB
keyboard connected to call in the configured help text to the trend view which
has been focussed, for example.

Icons

Icons can be configured at the bottom and side edges of the screen for SIMATIC
HMI operating units with integrated keyboard (e.g. Panel PC670, FI25 and FI45).
Icons emphasize the screen-specific functions of the softkeys.

On pressing a softkey, the function assigned to the respective icon is triggered.
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Language change 

The ProTool/Pro CS configuration software enables a project to be stored in
numerous languages. Up to 5 of these editing languages can be loaded on the
operating unit at any one time. The ASIA language variants are also supported. It is
possible to switch between the languages, online, at any time and display
language-dependent objects (texts and formats) in the runtime in other languages. 

Language-dependent texts involve, e.g.:

� Messages

� Screens

� Text lists

� Help texts

� Recipes

� Date/Time

� Decimal separating character

� Static texts

Conditions for changing languages
In order to change languages on the operating unit during runtime, the following
conditions must be fulfilled:

� The selected language must have been loaded on the operating unit. The
languages available during runtime are defined during configuration in
ProTool/Pro CS under System → Language Assignment → Online Languages.

� The Switch_Language function must be linked to an operating element, e.g. to a
button or a selection field. 
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6.2 Settings for the Runtime Software

Displaying the configuration on the target system

The ProTool/Pro CS configuration software can be used to define how the
compiled project is represented during runtime. The project can be displayed in full
screen mode or in a window which is smaller than the screen. In full screen mode,
the project takes up the entire screen. The screen no longer contains a window and
control elements (e.g. buttons). 

In order to use the Full Screen view, select the menu option System → Settings in
ProTool/Pro CS. Select Display and mark the option Full Screen. If the taskbar no
longer needs to be displayed, deactivate it under Windows. Activate the Start
menu, select Settings → Taskbar and use the Taskbar Properties dialog to
deactivate the options Always on Top and Auto hide.

The full screen view provides more space during configuration as well, since there
is no window frame. Therefore, select the full screen setting before beginning with
the configuration.

Disable task switching 

To prevent the user from calling up other applications during runtime, it is possible
to disable the task switching function in ProTool/Pro CS. Select the menu option
System → Settings and activate the items Lock Task Switching and Full Screen. In
addition, deactivate the Taskbar under Windows. Activate the Start menu, select
Settings → Taskbar and use the Taskbar Properties dialog to deactivate the items
Always on Top and Auto hide.

Note

If Lock Task Switching is selected, it is essential to assign the function
Exit_runtime to a key or button in the project. Otherwise, it is impossible to exit
from ProTool/Pro RT and Windows. The key combination CTRL + ALT+ DEL is
also no longer effective. Thus, when using Windows�NT and Windows�2000, it is
not possible to log on to your unit again, e.g. after activating the screen saver.

When using Windows�2000, the key combination necessary to log on, CTRL +
ALT + DEL, can be deactivated. To do this, select Control Panel → User →
Passwords, then tab control Extended and deactivate the option “Press CTRL +
ALT + DEL before logon”.
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Cursor control compatibility (not PC) 

The type of cursor control, e.g. within tabular structured screen objects (message
view, recipe view and status/force), can be configured. In this case, select menu
option System → Settings in the ProTool/Pro CS configuration software and use
the Settings dialog to activate or deactivate the option Cursor Control as with
V 5.10.

Using the new cursor control (check box deactivated), it is possible to navigate
within tables and list boxes simply by pressing the cursor keys without having to
implement the SHIFT key simultaneously.

Screen saver

� OP37/Pro
A specific screen saver is available for the OP37/Pro which automatically
switches off the screen if no entry is made on the OP37/Pro within a defined
period. This screen saver is used in order to extend the service life of the
back-lighting. The screen saver is active by default.

Select the screen saver via Control Panel → Display → Screen Saver. Select
the screen saver called ProTool.

� PC and SIMATIC Panel PC
The majority of modern monitors no longer need a screen saver, indeed a
screen saver can actually be harmful to the CRT. These monitors have a power
management function which means they switch themselves off as soon as the
video signal has not been changed for a specific period of time, which the user
can define. A conventional screen saver prevents, or at least delays, activation
of this switch-off function which can lengthen the service life of the screen.
However, if a screen saver is required, only the standard screen savers
incorporated into Windows are approved for use with ProTool/Pro RT.

Setting the time zone 

Ensure that the correct time zone is set for the operating unit. The time zone is set
in Windows by calling the Start menu and selecting Settings → Control Panel →
Date/Time → Time Zone.
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6.3 Operating Screen Objects 

Screen objects

This section provides information on operating the following screen objects:

� Buttons/Switches:

– Button  [Page 6-11]

– Status button [Page  [6-13)]

– State view  [Page 6-13]

– Switches [Page  [6-15)]

� Input field [Page 6-16]

� List boxes [Page 6-18]

� Messages

– Message line [Page 6-19]

– Message window [Page 6-19]

– Message indicator [Page 6-21]

– Message page  [Page 6-22]

– Message buffer [Page 6-23]

– Message view [Page 6-24]

– Single message display [Page 6-26]

� Bar graph  [Page 6-27]

� Trend view  [Page 6-28]

� Slider control  [Page 6-31]

� Analog display [Page 6-33]

� Calendar date/time, display and set:

– Date/Time  [Page 6-34]

– Digital/Analog clock  [Page 6-35]

� Passwort list  [Page 6-36]

� Status/Force  [Page 6-39]

� SIMATIC HMI Symbol Library [Page 6-41]
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Further screen objects are available, e.g. 

� Graphic list

A graphic list displays current values from the PLC in the form of a graphic. It
assigns a graphic to each tag value. The value of the tag during runtime
determines which graphic is selected from the list and displayed on the
operating unit.

� Graphic display

The graphic display enables the dynamic positioning of graphics from external
graphic programs in the project.

� Graphic box

A graphic box enables the selection of a graphic by selecting an entry from a
graphic list.

Information concerning the Recipe View is provided in Chapter 7.4.1.
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6.3.1 Buttons

Purpose

A button is a virtual key on the operating unit screen that can be operated by the
mouse or via the touch screen, according to the system. 

Functions which have been assigned to buttons can be triggered, for example, by
the following, configurable events:

� Clicking

� Printing

� Releasing

Display

� Labeling 
Buttons can be labeled statically or dynamically. In the case of dynamic
labeling, the text or graphic on the button changes during runtime according to
the value of a configured tag. 

� Operation acknowledgement 
As soon as the operating element detects a valid operation, it responds with a
visual acknowledgement. The acknowledgement, however, does not infer that
the required action is actually being executed.

Figure 6-2 illustrates examples of buttons which are pressed (right) and not
pressed (left).

Figure 6-2 Example of a button

Hidden buttons

Hidden buttons are transparent buttons which may lie over graphics, for example.
This enables plant parts which are graphically displayed on the operating unit to be
operated easily (e.g. a motor or valve). If a hidden button is selected, its contour
can become visible as long as the button remains selected. The contour enables
the user to detect the operable area of the button. 

Operation 

� Mouse and touch screen
Click the mouse pointer on the button or press it on the operating unit touch
screen.

� Keyboard
Select the button, e.g. using the cursor keys, and press either the Enter key or
Spacebar.
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Note

Click

In the case of a button, a function is triggered when the pressed button is released
within the contours of the button.

If the button is pressed but the mouse button or finger (when using touch panels)
moves outside the contour before releasing, the operating unit does not interpret
the action as a click event. The action is not executed.

Release

In the case of a button, a function is triggered when the pressed button is released.

If the button is pressed using the mouse button or finger (when using touch panels)
but moved outside, the function is triggered when the function is released.

Press

In the case of a button, a function is triggered as soon as the button is pressed.
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6.3.2 Status button

Purpose

The Status button is an operating and display element with the two states Pressed
and Released. Status buttons can indicate the status of units which cannot be seen
by the operator (e.g. a motor). At the same time, it is also possible to change the
status of the device concerned on the operating unit.

Behavior

The behavior of the Status button can be configured:

� Switch: 
The switch has two stable states. It toggles from one state to the other each
time it is operated, and remains in the respective state until it is operated again.

� Key: 
The button has a fixed, stable home position. When operated, it switches to the
status pressed and remains in this state as long as it is kept pressed. When
released, it automatically switches back to its released  position.

Functions which have been assigned to the Status button can be triggered, for
example, by the following configurable events:

� Status change 

� Printing

� Releasing

If the status of a switch type Status button changes as a result of a modification of
configured tags, not through operation, the corresponding function is not executed.

Display

The two indicator statuses of the types Switch and Button with acknowledgement
can be assigned different texts or graphics in ProTool/Pro CS which are displayed
on the Status button during runtime.

Figure 6-3 illustrates an example of a switch type Status button when pressed (left)
and not pressed (right).

Figure 6-3 The two statuses relate to the Status button when the Switch option is set

Operation

The Status button is operated as a normal button (refer to Page 6-11).
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Note

Click

In the case of a button, a function is triggered when the pressed button is released
within the contours of the button.

If the button is pressed but the mouse button or finger (when using touch panels)
moves outside the contour before releasing, the operating unit does not interpret
the action as a click event. The action is not executed.

Release

In the case of a button, a function is triggered when the pressed button is released.

If the button is pressed using the mouse button or finger (when using touch panels)
but moved outside, the function is triggered when the function is released.

Press

In the case of a button, a function is triggered as soon as the button is pressed.
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6.3.3 Switch

Purpose

A switch serves for the input and output of a binary status. It can only be switched
on or off. It is linked to a tag to do this. The status OFF corresponds to the value 0
(a logical FALSE) of the tag linked to the switch. All tag values other than zero (a
logical TRUE) are interpreted as the status ON.

Behavior

Functions which have been assigned to the switch, can be triggered, for example,
by the following, configurable events:

� Status change 

� Activate 

� Deactivate

If the switch status changes due to a change of the configured tag, none of the
events described is triggered.

Display

Figure 6-4 illustrates an example of two switches with different orientation.

Figure 6-4 Switches with different orientation

Operation

� Mouse and touch screen
Point to the moveable switch lever and move it to the opposite position.

� Mouse
Double-click on the mouse in the sliding slot between the two switch statuses.

� Keyboard
Select the switch, e.g. using the cursor keys, and press either the Enter key or
Spacebar.
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6.3.4 Input field

Purpose

Numeric or alphanumeric values are entered character by character in an input
field. A numeric value is a number, e.g. 80 as a setpoint value for a temperature.
An alphanumeric value can contain text and digits e.g. Valve_12.

Limit value check

If limit values are configured for the input field tags, the values entered are only
accepted when they are within the configured limits. If an attempt is made to enter
a value which is outside the configured limits, it is rejected and the original value
automatically reinserted. In this case, the operating unit issues a system message.

Note

On entering the first character, a tooltip appears with the lower and upper limit
values related to the input window.

Display

Input fields can be configured differently according to their purpose, e.g.:

� Numeric input field
to enter numeric values in decimal, hexadecimal or binary format.

� Alphanumeric input field
to enter character strings.

� Input field for date and time
to enter calendar dates and the time. The format is dependent on the language
currently set on the operating unit. The figure below illustrates examples of input
fields for date and time in US English language format. 

� Input field for confidential password entry 
to enter passwords confidentially. The character string entered is represented
by placeholders (*). The figure below illustrates an example. 
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Operation

� Mouse
Click the mouse button when the mouse pointer is in the input field and enter
the required value using the keyboard.

Confirm the entry by pressing

or discard it by pressing

� Keyboard
Select the required input field, e.g. using the Tabulator key. The field content
changes color when the field is accessed. Use the cursor keys to position the
cursor and then enter the required value.

Confirm or discard the input as described for mouse operation.

� Touch screen
Touch the relevant input field on the operating unit touch screen. The screen
keyboard automatically appears on the screen (refer to the figure on 
Page 6-4). Carry out the input as described for keyboard operation. After
completing the input, the screen keyboard is automatically hidden.
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6.3.5 Selection field

Purpose

In the case of selection fields, values are not entered character by character but
are selected from a list (Figure 6-5). 

Figure 6-5 Selection field in opened state (example)

Operation

� Mouse and touch screen
Click the mouse pointer in the list box or touch it on the operating unit touch
screen. In this case, the selection list opens up immediately. After selecting an
element from the list, the selection list is closed and the selected text appears in
the list box.

� Keyboard
Select the required list box, e.g. using a cursor key. The field content changes
color when the field is accessed. 

The following keys on the SIMATIC operating unit can be used to navigate in
the selection list:

Keys Function

� Open selection list

� Confirm entry
The selection list is closed, the list box remains
active

or
Mark the next entry

or
Mark the previous entry

or
Terminate editing
The selection list is closed and the original content is
reset in the list box. The list box remains active.
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6.3.6 Message line

Purpose

When a message line has been configured it is always displayed, regardless of the
screen selected. The message line displays the last alarm or event message
received. The message line is a permanent feature on the operating unit and
always displays the current message. If a separate window has been configured for
alarm messages, the message line only receives the current event message.

Display priorities

Alarm messages always have priority over event messages. If no alarm messages
are present or they have all been acknowledged, event messages are displayed.

Alarm messages flash to distinguish them from event messages. 

6.3.7 Message window

Purpose

The message window displays all messages in the respective message categories
which are queued or need to be acknowledged. 
It is possible to configure how the alarm messages are sorted. It is also possible to
select whether the latest or oldest message is displayed first.

The precise fault location can be displayed with date/time of the message event in
the message window.

Alarm messages

If one of the display modes Window/Window, Window/Line or Window/Off is
configured, the message window for alarm messages opens automatically as soon
as an alarm message arrives. Figure 6-6 illustrates an example.

Figure 6-6 Alarm window (example)
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Significance of the buttons 

Call Help text 
Use this button to call in the help text configured for the
selected message.

Edit Message 
Use this button to trigger the function assigned to the
Edit Message event for the selected message.

Acknowledge alarm messages 
Use this button to acknowledge an alarm message that
has not yet been acknowledged.

Event messages

In order to be able to open the event message window by means of the mouse or
keyboard the function Display_event_message_window, for example, must be
linked to a function key or button in the project. 

System messages

The message window for system messages opens automatically as soon as a
system message arrives. The window is closed automatically after the configured

duration of display has expired or by pressing ESC or  .
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6.3.8 Message indicator

Purpose

The message indicator is a configurable graphical symbol which is
displayed on the screen when at least one alarm message is queued at
the operating unit.

The indicator continues to blink as long as unacknowledged messages
are present.
The number (in this case 3) represents the number of alarm messages
present.

The message indicator can be operated by the touch screen or mouse.

Mouse operation

Click the mouse button when the mouse pointer is positioned on the message
indicator in order to open the alarm message page (Page 6-22).

Touch operation on SIMATIC operating units

The response of the message indicator is dependent on whether or not alarm
messages are present on the operating unit which still have to be acknowledged at
the moment the indicator is touched (e.g. Panel PC670 Touch).

� No alarm messages to be acknowledged:
The alarm message page is opened after operating the message indicator
(Page  6-22).

� Alarm messages to be acknowledged:
The alarm message window is opened after operating the message indicator
(Page  6-19).

Use the button illustrated to close the alarm window in order to operate
screens. The alarm message window can be opened again by touching the
message indicator.
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6.3.9 Message page

Purpose

The message page displays all messages allocated a time stamp. It is also
possible to select whether the latest or oldest message is displayed first. Open
message pages are constantly updated. 

Structure

In order to be able to access the message page for event messages and/or alarm
messages from the operating unit, the following functions must be configured:

� for event messages: Display_event_message_page 

� for alarm messages: Display_alarm_message_page 

Figure  6-7 illustrates an example of the message page for alarm messages. 

Figure 6-7 Alarm message page (example)

Information on the significance of the buttons is provided on Page 6-19.

It is possible to configure how the alarm messages are sorted.
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6.3.10 Message buffer

Purpose

The message buffer displays all message events allocated a time stamp. It is also
possible to select whether the latest or oldest message is displayed first. An open
message buffer is constantly updated. 

Structure

In order to be able to access the message buffer for event messages and/or alarm
messages from the operating unit, the following functions must be configured:

� for event messages: Display_event_message_buffer 

� for alarm messages: Display_alarm_message_buffer 

Figure 6-8 illustrates an example alarm message buffer. 

Figure 6-8 Alarm buffer (example)

Information on the significance of the buttons is provided on Page 6-19.

The message buffer is organized so that in the case of a buffer overflow the oldest
message events are overwritten (”FIFO buffer”). It is also possible to delete the
entire buffer or specific message categories from time to time
(Delete_message_buffer) function. This relieves the system load and provides a
clearer overview of the message buffer.

It is possible to configure how the alarm messages are sorted.
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6.3.11 Message view

Purpose

Certain views are defined for messages which are queued or still to be
acknowledged or for message events in the message buffer (volatile or archive) in
the message indicator. Various filter criteria are available in ProTool CS for this
purpose. 

Filter criteria include:

� Message number

� Time

� Message states

� Message text

� Date

� Category name

� Acknowledgment group

� Diagnostics capability

� PLC

The attribute PLC is only useful when more than one PLC is configured as source
of the message. In this way, the precise fault location can be displayed with
date/time of the message event.

Structure

The message view (Figure 6-9) displays messages that are queued on the
operating unit or still have to be acknowledged. The message view also enables
acknowledgement of these messages.

Alternatively, the message view can also display a history of message events. In
this case, messages cannot be acknowledged.

Figure 6-9 Example of a message view
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Significance of the buttons 

Call Help text 

Use this button to call in the help text configured for the
selected message.

Edit Message 

Use this button to trigger the function assigned to the
Edit Message event for the selected message.

Acknowledge alarm messages 

Use this button to acknowledge an alarm message that
has not yet been acknowledged.

Message categories

In order to be able to distinguish between the different message categories, they
are marked in the first column of the message display:

! Alarm messages

Empty Event messages

$ HMI system messages

S7 SIMATIC diagnostic events

Alarm-S messages are displayed either as alarm messages or event messages.
SFM messages (System Fault Messages) are displayed as alarm messages.

Column properties 

When correspondingly configured, the column sequence and sorting within each
column can be modified during runtime.

� Change column sequence 
In order, for instance, to swap the columns Time and Date, position the mouse
on the column heading Date, press and hold the mouse button and move the
heading to the column heading Time.

� Change sorting 
In order to change the chronological sorting of the messages, double click in on
the column heading of one of the two columns Time or Date.
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6.3.12 Single message view 

Purpose

A single message display provides a subset of the functionality of a message
display (Page 6-24). This provides a simple method with which, for example, to
create a message line to display event and system messages in a screen.

Structure

The single message view cannot be operated. The figure below provides an
example of a single message display with the following columns configured:

� Date

� Time

� Message number

� Message states

� Message text

12.12.99 14:27:06 110001 K 
Change to operating status ‘online’

12.12.99 14:27:07 140001 K 
Connection discontinued: Station 2, Rack 0, Slot 0
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6.3.13 Bar 

Purpose

Bar graphs present a value in the form of a rectangular area. The operating unit
thus provides a clear indication of how far the current value is from the limit values,
or if a setpoint value has been reached, at a glance. Bar graphs can be used to
display fill levels or quantities, for example. 

Display

It is possible to configure minimum and maximum values and the direction bar
graph moves by increasing the tag value: 

Figure 6-10 depicts three states of a horizontal bar graph:

1. Value drops below the minimum value configured

2. Value lies within the configured display range

3. Value exceeds the maximum value configured

4. Value lies within the configured limit range

Figure 6-10 Different bar states
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6.3.14 Trend view

Purpose

The trend view is a particularly clear form of displaying process data in a
continuous manner. In the case of processes that only change slowly, the trend
view can visualize events that have already occurred and provides access to, and
estimate of trends in the process sequence. On the other hand, data issued
concerning processes which run quickly can be easily evaluated using this form of
trend view.

Configurable properties

A number of different trends can be displayed simultaneously in the trend view.
The following properties of a trend can be configured:

� Trend type: Realtime trend or History trend 

� Triggering: Cycle triggering or Bit triggering 

� Limit values: Upper and lower limits
The operating unit displays the points at which configured limit values are
reached or exceeded by changing the color of the trend view. 

� Color: Uncertain status 

The uncertain status function highlights areas of the trend view in which
communication to the unit was interrupted and, as a result, no values could be
recorded.

Read line

The read line function is used in a trend graphic to display or hide a read line which
displays Y-values associated to an X-value. 

The read line can be activated by means of the Trend_view_read_mark_on_off
function or the X-axis tab control of the trend view Properties dialog (default: Off).
When the function is activated, a button is provided in the trend view with which to
activate and deactivate the read line. The color of the read line can be configured
in the Color tab control. 

If the Display Values Table function is activated in the Value Table tab control, a
table appears in the trend view containing the values of the trend curve displayed.

The read line can be operated in the trend view by means of touch, mouse
(cursor), keyboard (Ctrl + Alt + cursor right/left) or button. It is also possible to
configure buttons for the functions Trend_view_read_mark_forward and
Trend_view_read_mark_backward. When the read line is moved, the values in the
value table (when activated) are automatically updated accordingly. 
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Structure

Figure 6-11 illustrates an example of a trend view with buttons configured for
navigating within the trend.

Figure 6-11 Operable trend view with read line (example)

Navigation using buttons

It is possible to navigate through the trend using the configured buttons. The
individual buttons have the following significance:

Button Function

Start/Stop update
Interrupts the current updating process for the trend until
the button is pressed again.

Back to start Scrolls back to the start of the trend recording.

Scroll
Shifts the trend section half a window width to the
left/right.

Zoom in/out
section

Expands/compresses the trend view horizontally. 

Read line on/off Switches the read line on or off.
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FunctionButton

Read line 
forwards

Moves the read line to the right. 

Read line 
backwards

Moves the read line to the left.

Navigation using the keyboard

If no buttons have been configured in the trend view, use the operating unit
keyboard to navigate in the trend view. A condition for this is that the configuration
supports navigation using the keyboard.

Function Function PC Panel PC

Back to start Scrolls back to the start of the trend
recording.

Scroll back Scroll one screen width back. 

Scroll forward Scroll one screen width forward.

Zoom section Expands the trend horizontally. 

Reduce section Compresses the size of the trend
horizontally. 

Read line
forwards

Moves the read line to the right in
the trend curve.

Read line
backwards

Moves the read line to the left in the
trend curve.

Note

It is not possible to interrupt the updating of the trend using the keyboard. 

Display archive data as a trend

If data stored in an archive is displayed in the trend view, it is represented as
history trends, i.e. the trend data is read out of the archive and displayed according
to events. Application for trends of this kind are power-on processes or
temperature patterns on heating up an oven.

The trend view is not updated when the archive data changes.
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6.3.15 Slider control

Purpose

Use a slider control to enter and display numeric values in analog form. To enter
values, move the slider to the required position. When used as a display element,
the value is represented by the position of the slider. 

Function

The slider control is linked to a tag. On moving the user-controlled slider, the
corresponding value is written to the tag. Conversely, when the tag value is
changed, the position of the moving slider is changed correspondingly, unless it
being moved by the operator at that moment.

Display

The figure on the right illustrates an example of a slider for
setting and displaying temperature values. The current value
(in this case: 50) appears as plain text and as a bar graph.

Operation

� Mouse and touch screen
Point to the moveable slider and move it to the desired
value.

� Keyboard
In order to operate the slider, select it using a cursor key,
for example. Use the following keys to actually move the
slider:

Function PC Panel PC

Increase value continually

Decrease value continually

Increase/Decrease value in steps
of 5% –

Move to maximum
value/minimum value –
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!
Caution

In the following cases, it is possible that the value indicated by the slider control
differs from the real value of the related tag:

� The value range configured for the slider control (minimum and maximum
values) does not correspond with the limit values configured for the slider
control tag.

� An invalid password is entered for a slider control protected by a password.
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6.3.16 Analog display

Purpose

An analog display indicates numeric values as a pointer instrument.

Function

The analog display is linked to a tag. When the tag value changes, the pointer
position changes correspondingly. The display can be configured to include a
non-return pointer. At runtime, the non-return pointer indicates the maximum value
reached so far by the value being displayed. It is reset when the current window is
opened. 

The analog display is purely a display element. Therefore, it is not possible to enter
values.

Display

Figure 6-12 illustrates an example of an analog display indicating temperatures. 

Figure 6-12 Example of a typical analog display
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6.3.17 Date/Time

Purpose

The screen object Date/Time displays the current values for the time and/or date.
The time can be modified online if the corresponding feature is configured. 

The calendar data and time values are synchronized with the operating system
values or are read from the PLC. The operating unit accesses these values, for
example, to assign time stamps to message events. 

Format

The format of the date and time depends on the language currently set. It
corresponds to the standard international conventions: 

Table 6-3 Examples of language-dependent formats for Date/Time 

Language ExampleLanguage

Date Time

Language

long short
Time

German Samstag, 6. November 1999 06.11.99 12:59:32

English (USA) Saturday, November 06, 1999 11/6/99 12:59:32 PM

French samedi 6 novembre 1999 06/11/99 12:59:32

Italian sabato 6 novembre 1999 06/11/99 12.59.32

Spanish
(traditional)

sábado 6 de novembre de 1999 6/11/99 12:59:32

The format set for Date and Time can be modified using the Language
option in the Windows Control Panel. To do so, select the icon depicted on
the right.

Note

When entering the date and time, ensure that the two values are separated by a
space.
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6.3.18 Digital/Analog clock 

Purpose

The digital/analog clock provides the option of displaying the system time in
numbers (digital) or as a clock with hands (analog). The digital display also
includes the current date. The display format is language dependent. It is based on
the format defined by the operating unit operating system. 

Display

The digital/analog clock is purely a display element. This means that the date and
time cannot be set using the operating unit. In order to set the date and time, use
the Date/Time screen object (refer to Page 6-34).

Figure 6-13 illustrates an example of a configured analog clock.

Figure 6-13 Example of a typical analog clock
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6.3.19 Password list

Purpose

While the system is being configured using ProTool CS, additional operating
elements can be protected against unauthorized use by means of passwords.
Important parameters and settings can then only be modified by authorized
personnel. The password level and user name are stored with the password. 

The Report_password_change function causes a system message to be issued
when a different password is entered on the operating unit, i.e. a new user logs on.
If the system messages are archived, all login and logout procedures can be
established.

The Write_user_name_to_tag function is used to write the name of the user
currently logged on into a tag of type “STRING”. If the tag is one with a PLC link,
the user name also exists in the PLC and can be used for the user-dependent
enabling of certain functions. User names must always be unique for the
assignment. They are stored in a password file.

Password hierarchy

Hierarchically defined password levels from 0 to 9 exist for password protection
purposes. At the same time a password is assigned for a user or for an entire user
group, authorization is given to execute functions belonging to a specific password
level. If, for example, a user is assigned to password level 4, he or she is
authorized to execute functions of password levels 0 to 4. 

Password level

Password level 0:
This minimum password level is assigned to functions that have no, or only a
minimal effect on the course of the process. In order to trigger functions assigned
to password level 0, no password needs to be entered on the operating unit.

Password levels 1 to 8:
Functions are assigned to levels  1 to 8 according to their increasing importance.
Before triggering a function with a password level greater than 0, the operating unit
requests the corresponding password to be entered. 

Password level 9
Only the supervisor (system support specialist or service technician) is granted
authorization to execute functions assigned to password level 9. The supervisor is
authorized to access all the functions on the operating unit. 

Logging in on the operating unit (Login)

After calling a function protected by a password, the operating unit automatically
requests the entry of a password. Once entered, the password need not be entered
again in order to call in other functions of this password level or lower.
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When correspondingly configured, it is also possible to log in on the operating unit
via an input field for confidential password entry (Page 6-16). The character string
entered is represented by placeholders (*).

A system message may be issued after logging in. More information on this is
provided on Page 6-36.

Logging off from the operating unit (logoff)

In order to rule out operation by unauthorized personnel, a password level greater
than 0 should not remain active on the operating unit over too long a period of time.
The following options are available to explicitly reset passwords levels: 

� Configured logout time elapsed
If the operating unit is not operated within the period of time configured (logout
time), the current password level is automatically reset to 0.

� Manual logout
If the function Logoff_user is linked to an operating element in the project, it can
be used to reset the current password level to 0. 

Note
It is also possible to reset the current password level to 0 by entering an
incorrect password.

Password management 

Individual users can be entered in a password list on the operating unit and
assigned a password level according to their specific responsibilities. When
processing the list, conclude each field entry by pressing the Enter key. The
password list contains all the passwords configured on the operating unit. The list
is coded and stored on the operating unit, protected against a power failure. 

Figure 6-14 illustrates an example of a password list with six entries.

User Password Level

Figure 6-14 Example of a password list

View password list 

Only those passwords with user names are displayed which have a password level
equal to or lower than that with which the user is currently logged in. The operating
unit displays the password list entries in alphabetic order.
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Creating a password 

The user can only edit the password list up to the level with which he is currently
logged in. All passwords used in the system must be unique. It is not possible to
assign the same password to different password levels. It is possible, however, to
assign the same password level to different users without any restrictions.

Deleting a password 

To delete a password from the password list, overwrite the password level
assigned to it with 0.

Export/Import password list

Purpose

If a system includes several operating units which are accessed by the same
users, the same passwords must be installed on each operating unit. In order that
the password lists need not be re-entered on each unit, it can be created on one
unit and then exported and imported on other units.

Note

During an import, all currently valid passwords are overwritten. The imported
passwords become valid immediately.

If an existing user name or password is entered, the corresponding system
message is issued.

Condition

In order to be able to export/import password lists on the operating unit, the
Export_Import_Passwords function must be linked to a button or function key, for
example. The file name of the password list to be exported/imported must be
specified as the function parameter during configuration. 

Notice

� The password list is coded. It cannot be edited with external tools.

� Do not export a password list directly after it has been modified. Exit the screen
object Password List after changing it and wait with the export function until
modifications have been written on the data medium.
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6.3.20 Status/Force

Purpose

The operating unit access the connected PLC and periphery to read and write
values. PLC program operands can be monitored and modified easily without
having to connect an additional programming unit or PC to the PLC. 

This option is particularly useful during the testing and commissioning phase of the
project.

Condition

In order to be able to access values in the PLC directly from the operating unit, the
following preconditions must be fulfilled:

� The connected PLC is a SIMATIC S5 or SIMATIC S7

� The project must contain the screen object Status/Force (Figure6-15)

Structure

Figure 6-15 illustrates the basic structure of the screen object Status/Force. Each
line represents an operand.

Figure 6-15 Status/Force: Example for SIMATIC S7

If the operating unit is equipped with a mouse or touch screen, the column
sequence on the operating unit can be changed. In order, for instance, to swap
the Format and Force Value columns, move the column heading Force Value onto
the column heading Format.

Table 6-4 explains the meaning of the individual columns and buttons. 

Table 6-4 Status/Force: Significance of the columns and buttons

Column/Button Function

Connection Select the PLC whose address area is to be displayed
and/or modified.

Type, DB number, Offset, Bit Specify the address in this column.

Data type, Format This column is used to change the format of the output.
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Table 6-4 Status/Force: Significance of the columns and buttons

FunctionColumn/Button

Status value This column displays the values of the operands read
from the PLC.

Force value Use this column to enter the values to be written to the
operands.

This button is used to update the display in the column
Status value.

The button is locked after being pressed. None of the
input fields can then be used until the button is pressed
again, thus stopping the update.

This button is used to apply the new value specified in the
column Force value. The value is then written to the PLC.

Operation

The table depicts the key combinations for various operating units.

Function PC Panel PC

Operate button Write.

Operate button Read.

Select first field in current line.

Select last field in current line.

Select first field in current column.

Select last field in current column.

Delete current line.Delete current line.

or use the Connection column
and select No PLC

Open selection field.
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6.3.21 SIMATIC HMI symbol library 

Purpose

The SIMATIC HMI Symbol Library is a comprehensive library containing graphics
from the areas of techniques and production. The library extends the possibilities of
producing screens for the project in large numbers and representing aspects
realistically. The following screen objects (graphics) are included, for example, in a
wide range of categories:

� valves, motors, tank containers,

� conveyor belts,

� factory buildings,

� 3D ISA symbols,

� cooling and heating systems.

Settings

Using the screen editor, any object in the SIMATIC HMI Symbol Library can be
inserted in the current screen and edited as required. In addition to the standard
tab controls for all the screen objects (Functions, Position, Color, Attributes, Name
and Enable, the SIMATIC HMI Symbol Library provides two further tab controls:

� Symbol:

Selection of the required symbol.

� Style:

Settings for color filling, transparency and orientation of the screen object and
configuration of a tag:

– It is possible to modify the appearance and representation of symbols and
background.

– Symbols can be mirrored and/or turned in steps of 90�.

– The cursor can assigned an additional lightning symbol when moving over
the screen in order to emphasize to a user the configuration of a function, for
example (only possible with touch panels).

– It is possible to configure a tag for the symbol and, thus, control its color
representation in accordance with falling below or exceeding limit value
ranges.
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Behavior

Functions which have been assigned to symbols can be triggered, for example, by
the following, configurable events:

� Clicking

� Double-click 

� Printing

� Releasing

Operation

Symbols on the SIMATIC HMI Symbol Library can be operated via the mouse or
touch screen:

� Mouse
Click the mouse button when positioned on the symbol. The possibility of
operating the symbol via the mouse, when configured, is indicated by the cursor
symbol changing.

� Touch screen
Touch the relevant symbol on the operating panel touch screen.

There is no operation acknowledgement, e.g. color change.

Figure 6-16 illustrates examples of four icons from different categories.

1 2 3 4

Figure 6-16 Examples of symbols from different categories

No. Symbol Category

1 Pumps Pumps

2 Filter system 1 Chemical

   3 Furnace HVAC

4 Band dryer ISA Symbols
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Note

Click

In the case of a button, a function is triggered when the pressed button is released
within the contours of the button.

If the button is pressed but the mouse button or finger (when using touch panels)
moves outside the contour before releasing, the operating unit does not interpret
the action as a click event. The action is not executed.

Release

In the case of a button, a function is triggered when the pressed button is released.

If the button is pressed using the mouse button or finger (when using touch panels)
but moved outside, the function is triggered when the function is released.

Press

In the case of a button, a function is triggered as soon as the button is pressed.
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Recipes

7.1 Overview

Purpose

The purpose of recipes is to transfer of quantities of related data together and
synchronously from the operating unit to the PLC and back again.

Principles of operation

Using the example of the filing cabinet (Figure 7-1), the two terms Recipe and Data
Record should be defined because they are important for subsequent
understanding of the process.

Fruit juice plant

Grapefruit

Lemon

Orange

Drink

Nectar
Juice

Apple

Figure 7-1 Recipe and data record, using a filing cabinet as an analogy

7
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� Recipe
Recipes correspond to the individual drawers of the filing cabinet illustrated (e.g.
grapefruit or lemon). The reference value fields (tags) belonging to the particular
recipe are defined in each drawer. The recipe defines the data structure in
ProTool/Pro CS. This structure cannot be modified later on the operating unit. 

� Data record
Data records correspond to the filing cards in the individual drawers of the
cabinet (e.g. Drink, Juice and Nectar). A data record contains the values for a
recipe. Data records are created, modified and deleted on the operating unit.
The data records are also stored on the operating unit. This saves storage
space on the PLC.

The Import/Export function provides the additional option of using external tools
to edit exported data records, e.g. Excel, and then reimporting them on the
operating unit. 

Example of a recipe

An example for use of a recipe is its application on a filling station of a fruit juice
system. The same filling station is used to produce orange drink, orange juice and
orange nectar. The mixing ratios are different for each product. The ingredients are
always the same.

Assume that a recipe called Mixture is created, which has the following data
structure:

Tag Name

Var_2 l orange

Var_3 l water

Var_4 kg sugar

Var_5 g flavor

The designations l Orange, g Aroma etc. of the tags are the so called entry
names. The entry names are also displayed on the operating unit. In this way, for
example, the tag Var_2 can be identified as the tag designating the mixture
component Orange. 

The data records contain the values for the different drink types. The data records

may appear as follows, for instance: 

Orange drink Orange juice Orange nectar

l orange 90 l orange 95 l orange 70

l water 10 l water 5 l water 30

kg sugar 1.5 kg sugar 0.5 kg sugar 1.5

g flavor 200 g flavor 100 g flavor 400
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7.2 Use of Recipes

The following section contains a description of the data flow for recipes and three
application scenarios illustrating the use of recipes in the form of short, practical
examples. They should provide a top level overview of the possibilities for using
recipes:

� The first scenario illustrates a recipe configuration in which the data entered is
not immediately transferred to the PLC. This configuration is used, for example,
when it is necessary to enter data on the operating unit without interfering with
an active process.

� In the second scenario, data is immediately transferred to the PLC. This
configuration can be used, for example, to start up a machine and correct the
positioning data online.

� The third scenario implements data record functions in order to control
production automatically via a job list.

7.2.1 Data Flow for Recipes

The diagram illustrates various possibilities concerning data flow when using
recipes. The data flow between the active components operating unit (A), PLC (B)
and external data medium (C) is dependent on the configuration of the recipe and
the functions used.

External 
data medium

Storage medium Display

PLC

Recipe_1

Recipe_2

Recipe_n

Figure 7-2 Data flow for recipes
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The operating unit (A) stores the recipe data records on a storage medium, e.g.
Flash or hard disk. The recipe data record can be edited in a recipe view or recipe
screen on the operating unit display:

� A new data record can be entered and can then, for example, be stored (2) on
the storage medium and transferred (3) to the PLC (B).

� The data record can be exported to an external data medium (C), e.g. a PC.
The data record is saved in CSV format, regardless of the recipe. This file can
then be loaded and edited in MS Excel, for example.

� A data record can be loaded (2) from the operating unit storage medium or
import (1) it as a *.CSV file from an external data medium.

A recipe data record can also be transferred (4) directly from the storage medium
to the PLC or loaded from the PLC to the storage medium. In the same way, a
recipe in the display can be transferred (3) to the PLC or loaded from it.

7.2.2 Application examples 

Scenario 1: Enter data record

Production data must be entered on operating unit (A) without interfering in the
active process. The production data should not be transferred to the PLC (B).

External 
data medium

Recipe_1
Recipe_2

Recipe_n

Storage medium Display

PLC

Figure 7-3 Process

Enter the production data in the recipe view or recipe screen, assign a data record
name and save the new data record on the operating unit storage medium.
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Scenario 2: Manual production process

The production data should be read from the PLC (B) according the workpiece to
be processed and displayed on the operating unit screen (A) to be checked. It
should be possible to correct the production data transferred online, if necessary.

Notice

This is a special application scenario because it cannot be realized on all HMI
devices.

External 
data medium

Recipe_1
Recipe_2

Recipe_n

Storage medium Display

PLC

Figure 7-4 Process

A reading device, e.g. connected to the PLC, reads out a bar-code from the
workpiece to be edited. The data record name corresponds to the respective
bar-code designation. As a result, the PLC can load the required data record from
the operating unit’s storage medium. The data record appears in the display for
control purposes. Modifications are immediately transferred to the PLC.
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Scenario 3: Automatic production process

Production should be automated by means of a job list. The production data should
be transferred directly to the PLC (B) either from the data medium in the operating
unit (A) or from an external data medium (C). It is not necessary to show it in the
display.

External 
data medium

Recipe_1
Recipe_2

Recipe_n

Storage medium Display

PLC

Figure 7-5 Process

Production can be controlled via one or more VB scripts which automatically
transfer the production data records to the PLC. The process can be controlled by
means of return values of the functions used

The automatic production process can be realized using the data record functions
provided: The Import_Data_Records function loads data records from a *.CSV file
to the data medium. The Data_Record_DAT_to_PLC function transfers a data
record from the data medium to the PLC.
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7.3 Recipe Configuration

Basic procedure

The basic steps to configuring a recipe are listed below:

1. Define the structure of the recipe:
Assign tags to the recipe structure. These tags are provided with entries from
the data records.

Define a name for the recipe. This name is used to select the recipe in the
project and on the operating unit. 

2. Set recipe tag properties
The following options can be configured in ProTool/Pro CS:

– Synchronize tags 
This option defines that the data from a data record has been read from the
PLC or data medium and written in the tag or read from the tags configured
for the recipe. This establishes a connection between the tags configured in
the recipe and the tags in the screens. When a data record is loaded, the
values are written to the tags used in the screens.

– Tags offline 
If this option is also activated, the values entered are only stored in the tags,
and not transferred to the PLC. Otherwise, values entered are transferred
directly to the PLC.

3. Defining the storage location for the data records on the operating unit 
The storage location for data records can be configured to any path or any
drive. 

4. Set download synchronization 

It is possible to configure whether the data records are downloaded to the PLC
with or without synchronization.

5. Creating a recipe screen
Configure one or more screens in order to create, store, and download data
records on the operating unit. Depending on the application, use either the
recipe view or create a copy of the system, e.g. using input/output fields in
recipe screens.

– Recipe view: 
The recipe view enables an uncomplicated, quick method of handling
recipes and data records with a minimum of configuration work. Normally,
they are used to process data records with smaller recipes in table form.

– Recipe screen: 
The operator can use recipe screens to customize the user interface for
editing data records and, for example, simulating the system visually,
providing graphics and individual masks for entering data records. Recipe
screens are particularly recommended for data records with a relatively large
number of entries.



Recipes Release 12/01

7-8
User’s Guide ProTool/Pro Runtime 

6AV6594-1CA06-0AB0

Further information

Detailed information on how to create projects is provided in the online help to the
ProTool/Pro CS configuration software and in the ProTool Configuring
Windows-based Systems User’s Guide.

System limits 

The table provides an overview of the system limits for recipes according to the
units. 

Elements Target deviceElements

PC, Panel PC

Number of recipes 1000

User data length 8,000 bytes per data record

Total entries 20,000

Entries per recipe 2,000
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7.4 Editing Data Records

In this chapter

This chapter provides information on how to edit data records on operating unit.
The following information is also included:

� Layout of the recipe view (Page 7-10)

� Displaying data records (Page 7-14)

� Creating new data records (Page 7-14)

� Copying data records (Page 7-15)

� Modifying data records (Page 7-16)

� Copying data records by selecting a data record name (Page 7-16)

� Renaming data records (Page 7-17)

� Deleting data records (Page 7-17)

� Reading data records from the PLC (Page 7-18)

� Downloading data records to the PLC (Page 7-18)

� Synchronizing a data record (Page 7-18)

� Editing data records in recipe screens (Page 7-19)

� Functions and PLC jobs (Page 7-22)

� Exporting/Importing data records (Page 7-23)

� Exporting, editing and importing data records (Page 7-26)

� Reaction to changing the recipe structure (Page 7-27)

Methods

Data records can be edited on the operating unit in tables or screens:

� Tabular editing
The recipe view is available for the tabular editing of data records (Page 7-10).
The recipe view enables recipes and data records to be handled in an
uncomplicated, quick way.

It is typically used to edit data records of smaller recipes. Values entered on the
operating unit are not directly transferred to the PLC when entered.

� Editing in recipe screens
The project engineer can use recipe screens (Page 7-19) to customize the user
interface for editing data records and, for example, simulating the system
visually, providing graphics and individual masks for entering data records.

This method is typically used for processing medium and large data records
offline in the recipe view. The values entered on the operating unit are only
saved in the tags, not transferred to the PLC directly on input.
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7.4.1 Recipe view 

Purpose

The recipe view is typically used to edit recipe data records in tabular form. This
provides an uncomplicated method of displaying, creating, copying, modifying,
deleting and downloading data records on the operating unit.

All descriptions on editing data records provided in this Chapter 7.4.1 relates purely
to the use of the recipe view. Information on editing data records in recipe screens
is provided in Chapter 7.4.2.

Display 

Figure 7-6  illustrates an example of the layout of the recipe view. Some of the
operating and display elements can be configured so that they are faded out on the
operating unit.

Figure 7-6 Layout of the recipe view (example)
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Significance of the operating and display elements 

No. Function

Select recipe
If the corresponding function is enabled in ProTool/Pro CS, it is possible
to select a configured recipe in this selection field. The number of the
selected recipe is displayed to the right of the selection field. This
number is only relevant during the configuration. It cannot be modified
on the operating unit.

Select data record
As soon as a recipe has been selected, the data records available are
displayed in this field. In addition, the data record number is displayed to
the right. The number field only becomes active when the input of a data
record number is permitted, e.g. after changing the data record number
or creating a new data record.

View/Edit entries
This table contains all the entries which are  configured in the selected
data record. Sorting complies to the configured sequence. The
right-hand column displays the associated values.

The entry names cannot be edited on the operating unit.

Create new data record
This button initiates the creation of a new data record. The
setpoint values are predefined with default values configured
as start values for the respective tags.

Key combinations:

Save data record
This button is used to save the current values of the date
record displayed on the operating unit data medium. The
memory location is specified in ProTool/Pro CS.

The data record is stored under the currently defined name
and number.

Key combinations:

Delete data record

This button is used to delete the data record currently
displayed for the defined recipe from the operating unit data
medium.

Key combinations:

Read data record from the PLC
This button is used to read the data record related to the
currently set recipe from the PLC and display the values on
the operating unit.

Key combinations:
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FunctionNo.

Write data record in the PLC

This button is used to write the current data record values in
the PLC.

Key combinations:

Status bar

The operating unit displays the status of the current operation in this
line, e.g. Downloading.

Other buttons

The following buttons are only visible when they have been correspondingly
configured by means of an attribute in the recipe view:

Synchronize

This button is used to synchronize the data in a recipe view with the
associated tag. Modified values are written in the corresponding tags in
the table of a recipe view. Finally, all the values are read from the tags
to table, which is updated accordingly. This ensures consistency
between the recipe view and tags.

The button is only enabled for use in the case or recipes with
synchronized tags.

Key combinations: =

Save data record as 

After pressing this button, a dialog appears in which to select an existing
data record name and modify it. After confirming the dialog, the current
values are stored under the new name.

Key combinations:
*

Note

� If the two options Synchronize Tags and Tags Offline are activated in the
configuration, the values from the table are applied when values in the tables
and screens are changed simultaneously.

� If the data record currently being edited in the recipe view is changed in the
background (e.g. by means of a PLC job), the recipe view is not automatically
updated.
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Notes on operating the recipe view

� Quick selection of recipes and data records 

When the selection field is opened up, enter the first letter of the recipe or data
record to be selected to access the relevant area of long lists, thus speeding up
the selection procedure.

� Edit entries
If the value marked in the recipe view is to be modified, it is initially deleted by
pressing one of the alphanumeric keys. This occurs with regard to all list
elements in Windows. In order to prevent this, proceed as follows:

– After selecting the value to be changed, press the Enter key. This clears the
marking.

– Move the text cursor to the relevant position by pressing the cursor key or
SHIFT and cursor key.

– Insert the modifications.

– Confirm the changes, e.g. by pressing the Enter key.

Parameters which can be changed for recipe functions

� Return values

It is possible to configure the optional Return values parameter for various
recipe functions. This parameter enables a message to be issued concerning
the status of a function. Functions can be processed in succession using
Change value.

Values

2: Function in progress
4: Function completed without errors
12: Function completed with errors

� Status message

It is possible to configure the Status message parameter for various recipe
functions. This parameter defines whether a corresponding system message
should appear when a function has been completed.

Values

1: After importing the data records, a status message is issued.
0: No status message
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Displaying data records 

Proceed as follows to display data records on the operating unit data medium:

Step Action

1 Select recipe Step 1 is only possible when recipe selection has been
configured.

� Select the selection field for the configured recipes 
(Position 1 in the figure on Page 7-10).

� Open the selection field and mark the required recipe in the
opened selection list.

� Confirm the selection.

2 Select data record � Select the selection field for the existing data records
(Position 2 in the figure on Page 7-10).

� Open the selection field and mark the required data record in
the opened selection list.

� Confirm the selection.
The selected data record is loaded. The configured entries
are displayed in table form with name and setpoint value.

Creating new data records 

Proceed as follows to create new data records on the operating unit:

Step Action

1 Select recipe � Select the required recipe as described in Displaying data
records Step 1 on Page 7-14.

2 Create data record � Press the key depicted on the left.

The name and number of the data record displayed are
deleted. The entries in the table are assigned the configured
start values.

2 � Press the key depicted on the left.

The name and number of the data record displayed are
deleted. The entries in the table are assigned the configured
start values.

3 Enter data record
name

� Enter a new data record name in the selection field for data
records (Position 2 in the figure on Page 7-10).

� After entering the data record name, the next free data
record number is  automatically entered on the right. This
number can be changed, if necessary.

4 Change values � Enter a setpoint value for each entry configured in the table
(Position 3 in the figure on Page 7-10).

5 Save data record � Press the key depicted on the left.

The new data record is written on the data medium.

The operating unit responds with a system message if the
name or number entered already exist.

5 � Press the key depicted on the left.

The new data record is written on the data medium.

The operating unit responds with a system message if the
name or number entered already exist.

Storage location for new data records

The storage location for the new data records can be configured to any path in the
network.  
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Copying data records

In order to copy data records, save them under new names. Proceed as follows:

Step Action

1 Select recipe and
data record

� Select the required recipe and the data record to be copied
as described in Displaying data records, Steps 1 and 2 on
Page 7-14.

2 Enter data record
name

� Enter a new data record name in the selection field for data
records (Position 2 in the figure on Page 7-10).

� After entering the data record name, the next free data
record number is  automatically entered on the right. This
number can be changed, if necessary.

3 Save data record � Press the key depicted on the left.

The new data record is written on the data medium.

The operating unit responds with a system message if the
name or number entered already exist.

3 � Press the key depicted on the left.

The new data record is written on the data medium.

The operating unit responds with a system message if the
name or number entered already exist.

Copying data records after selecting a data record name

Proceed as follows to copy an existing data record after selecting the data record
name:

Step Action

1 Select recipe and
data record

� Select the required recipe and the data record to be copied
as described in Displaying data records, Steps 1 and 2 on
Page 7-14.aus

2 Change values � Modify the values necessary.

3 Save data record
as

� Press the key depicted on the left.

A dialog opens containing a data record name selection field
which can be edited. The selection field contains the name of
the data record selected.

Select the required data record name and edit it. After
confirming with OK, a new data record is created under the
name specified with the current values based on the
previously selected data record.

The newly created data record is displayed in the recipe
view.

3 � Press the key depicted on the left.

A dialog opens containing a data record name selection field
which can be edited. The selection field contains the name of
the data record selected.

Select the required data record name and edit it. After
confirming with OK, a new data record is created under the
name specified with the current values based on the
previously selected data record.

The newly created data record is displayed in the recipe
view.
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Changing data records 

Proceed as follows to change existing data records:

Step Action

1 Select recipe and
data record

� Select the required recipe and the data record to be copied
as described in Displaying data records, Steps 1 and 2 on
Page 7-14.

2 Change values � Change the setpoint value in the table 
(Position 3 in the figure on Page 7-10).

The entry names cannot be edited on the operating unit.

3 Save data record � Press the key depicted on the left.

The modified data record overwrites the original data record
on the data medium.

3 � Press the key depicted on the left.

The modified data record overwrites the original data record
on the data medium.

Notice

If large-scale modifications have been carried out in recipes in ProTool CS and,
after downloading the modified project, the data records on the operating unit data
medium deviate a great deal from the original recipe structure, it is recommended
to reorganize the data medium:

� Export the data records of all the recipes (refer to Page 7-23).

� Delete the data records with the prefix PTRCP_ by deleting the path for the
downloaded recipes using the Explorer.
(Note: After the data records have been deleted, the relevant data must be
re-entered).

� Import the data records using the function Import_Data_Records.

In this way, all the tags no longer used are deleted.
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Renaming data records 

Proceed as follows to rename existing data records:

Step Action

1 Select recipe and
data record

� Select the required recipe and the data record to be copied
as described in Displaying data records, Steps 1 and 2 on
Page 7-14.

2 Enter data record
name

� Enter a new data record name in the selection field for data
records (Position 2 in the figure on Page 7-10).

� After entering the data record name, the next free data
record number is automatically entered on the right. Reset
this number to its original value.

3 Save data record � Press the key depicted on the left.

The modified data record is written on the data medium.

The operating unit responds with a system message if the
name or number entered already exist.

3 � Press the key depicted on the left.

The modified data record is written on the data medium.

The operating unit responds with a system message if the
name or number entered already exist.

Deleting data records 

Proceed as follows to delete data records on the operating unit data medium:

Step Action

1 Select recipe and
data record

� Select the required recipe and the data record to be modified
as described in Displaying data records, Steps 1 and  on
Page 7-14.

2 Delete data record � Press the key depicted on the left.

The data record is deleted from the data medium after
confirming a confirmation request.

2 � Press the key depicted on the left.

The data record is deleted from the data medium after
confirming a confirmation request.

Note

It is possible to configure the Delete_Data_Records function to directly delete
individual recipes, all data records in a recipe or all recipes. To delete data records
using this function, it is not necessary to configure a recipe view.

It is still possible to configure the Delete_Data_Record_From_Display function with
which the currently displayed data record will be deleted.
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Reading data records from the PLC

Proceed as follows to update data records in the operating unit working memory
with values from the PLC:

Step Action

1 Select recipe � Select the required recipe as described in Displaying data
records, Step 1 on Page 7-14.

2 Read values � Press the key depicted on the left.

� The current values are read from the PLC and displayed.

2 � Press the key depicted on the left.

� The current values are read from the PLC and displayed.

3 Edit data records � The data can then be edited, e.g. values modified, saved,
downloaded to PLC, etc.

The operating unit responds with a system message if
downloading from the PLC is not possible because, in cases
where synchronization with the PLC is configured, for
example, the data mailbox is currently locked.

Downloading data records to the PLC 

In order that a modified or new data record can take effect in the PLC, it must be
downloaded to the PLC.

Proceed as follows to download data records to the PLC:

Step Action

1 Select recipe and
data record

� Select the required recipe and the data record to be
downloaded as described in Displaying data records, Steps 1
and 2 on Page 7-14.

2 Write values � Press the key depicted on the left.

The values are written in the PLC.

The operating unit responds with a system message if
downloading from the PLC is not possible because, in cases
where synchronization with the PLC is configured, for
example, the data mailbox is currently locked.

2 � Press the key depicted on the left.

The values are written in the PLC.

The operating unit responds with a system message if
downloading from the PLC is not possible because, in cases
where synchronization with the PLC is configured, for
example, the data mailbox is currently locked.

Note

If an attempt is made to download a data record from the operating unit to the PLC
and the system messages 290040 (error code 1066) and 290027 are received in
succession, it is possible that the data mailbox has not been set up correctly in the
PLC.
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Synchronizing a data record

Proceed as follows to synchronize the data in a recipe view with the associated
tag:

Step Action

1 Select recipe and
data record

� Select the required recipe and the data record to be copied
as described in Displaying data records, Steps 1 and 2 on
Page 7-14.

2 Synchronize data
record

� Press the key depicted on the left.

Modified values in the recipe view are written in the
corresponding tags. Finally, all the values are read from the
tags to table, which is updated accordingly. This ensures
consistency between the recipe view and tags.

2 � Press the key depicted on the left.

Modified values in the recipe view are written in the
corresponding tags. Finally, all the values are read from the
tags to table, which is updated accordingly. This ensures
consistency between the recipe view and tags.

7.4.2 Recipe screens 

Purpose

Recipe screens are typically representations of the system. The screens provide
display and operating elements with which to create, save, modify, delete and
download data records. Large recipes can be split into several topic-specific
screens and clearly displayed, e.g. with graphic elements.

Components for editing data records

In order to be able to edit data records in recipe screens on the operating unit, the
corresponding components, e.g. input/output fields and functions, must
be configured:

� Recipe view: 
Recipe screens can contain a recipe view (Page 7-10) not only to enable the
easy selection of recipes and data records but also for editing data records. The
configured functional scope of the recipe view can vary, according to the
intended purpose.

Information on editing data records with the recipe view is provided in 
Chapter 7.4.1. The instructions stipulated there generally also apply for editing
data records in recipe screens. However, in this case, input is performed in the
screens.
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� Functions: 
Depending on whether a recipe view is configured in the project or not, and on
the properties assigned to it, there are various functions available to transfer
data records between operating unit and PLC, e.g.:

for recipe views

– Load_Data_Record

– Save_Data_Record_from_Display_as

– Save_Data_Record_from_Display

– Delete_Data_Record_from Display

– Synchronize_Data_Record_in_Display

– Data_Record_Display_to_PLC

– Data_Record_PLC_to_Display

for recipe screens

– Load_Data_Record 

– Save_Date_Record 

– Delete_Data_Record 

– Data_Record_PLC_to_Tags 

– Data_Record_Tags_to_PLC 

– Recipe_Tags_Online_Offline

for downloading data records between data medium and PLC

– Data_Record_DAT_to_PLC

– Data_Record_PLC_to_DAT

for exporting and importing data records

– Export_Data_Records

– Import_Data_Records

Further functions for recipes:

– Delete_Data_Record_Memory

– Convert_Data_Record_Number_to_Name

More functions and PLC jobs, which are linked to the downloading of data records,
are described on Page 7-22.

Note

It is possible to read in data or data records from the PLC. To do this, functions
such as Data_Records_PLC_to_Tags or Data_Records_Tags_to_PLC and
parameters such as Recipe number/name and Data record number/name are
available in which to assign specific names.
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Editing data records offline

The way in which data records are edited on the operating unit is defined during
configuration. It is typically used for the offline editing of data records in recipe
screens. Values entered on the operating unit are not directly transferred to the
PLC when entered.

Proceed as follows to edit data screens in recipe screens offline:

Step Action

1 Trigger reading of the selected data record from the storage medium:

� With recipe view
It is automatically loaded on selecting the data record. Select the required
data record as described in Displaying data records in Steps 1 and 2 on
Page 7-14.

� Without recipe view
Activate the operating element linked with the Load_Data_Record function.
The function parameters must have been set accordingly beforehand.

2 The data of the data record is written to the tags.

3 Edit the tags using the configured input/output fields.

4 Save the modified tags.

� With recipe view
Click the Save button. If necessary, you must first specify a new name.

� Without recipe view
Activate the operating element linked with the Save_Date_Record. The
function parameters must have been set accordingly beforehand.

Editing data records online 

In order to edit data records online, the option must either be defined during
configuration or the Recipe_Tags_Online_Offline function configured in the project.
In the case of online editing, the values entered are transferred directly to the PLC.
This method is normally used when commissioning the machine/system in order to
test, run-up and position. 

Proceed as follows to edit data records on the operating unit online:

Step Action

1 If data records are edited offline in the configuration, switch to offline mode at
this point by using the Recipe_Tags_Online_Offline function.

2 Trigger reading of the selected data record from the storage medium:

� With recipe view
It is automatically loaded on selecting the data record. Select the required
data record as described in Displaying data records in Steps 1 and 2 on
Page 7-14.

� Without recipe view
Activate the operating element linked with the Load_Data_Record function.
The function parameters must have been set accordingly beforehand.

3 The data of the data record is written to the tags and thus also to the PLC.
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ActionStep

4 Edit the tags using the configured input/output fields. This will simultaneously
change the values in the PLC as well.

5 Save the modified tags.

� With recipe view
Click the Save button. If necessary, you must first specify a new name.

� Without recipe view
Activate the operating element linked with the Save_Data_Record. The
function parameters must have been set accordingly beforehand.

Note

When editing data records online, the entered values are transferred to the PLC
without synchronization. Therefore, when changing individual values, ensure that
no impermissible operating statuses occur in the machine/system.

7.4.3 Functions and PLC jobs

Functions

The following functions can be used to import and export recipe data records for
editing with external tools:

� Export_Data_Records 

� Import_Data_Records 

They can be used to either import and export either individual data records or all
data records in a recipe, according to the configured parameters.

The following functions can be used to transfer data records between the PLC and
operating unit data medium.

� Data_Record_DAT_to_PLC 

� Data_Record_PLC_to_DAT 

The data medium is the internal Flash memory, the memory card or any network
path. Both the recipe and data record must be specified as parameters in which the
values should be written.

The following functions enable data records to be transferred to the PLC which are
currently being displayed in the recipe view on the operating unit.

� Data_Record_PLC_to_Display 

� Data_Record_Display_to_PLC 

The values from the data record tags are written directly to the addresses in the
PLC
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Parameters which can be changed for recipe functions

� Return values

It is possible to configure the optional Return values parameter for various
recipe functions. This parameter enables a message to be issued concerning
the status of a function. Functions can be processed in succession using
Change value.

Values

2: Function in progress
4: Function completed without errors
12: Function completed with errors

� Status message

It is possible to configure the Status message parameter for various recipe
functions. This parameter defines whether a corresponding system message
should appear when a function has been completed.

Values

1: After importing the data records, a status message is issued.
0: No status message

PLC jobs

The following two PLC jobs can be used to transfer data records between the PLC
and operating unit automatically:

� No. 69: “PLC → DAT” (read data record from PLC)

� No. 70: “DAT → PLC” (write data record in PLC)

Information on PLC jobs is provided in the Communication for Windows-based
Systems User’s Guide.

7.4.4 Import/Export data records

Purpose

When the appropriate features have been configured, data records on the
operating unit can be exported as CSV files to the data medium. This feature can
be used to edit data records with external tools, e.g. with a spreadsheet program or
text editor and import them on the operating unit again. 
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Condition

In order to export and import data records during runtime, the project must contain
the following functions: 

� Export_Data_Records

� Import_Data_Records

These functions must be linked in the ProTool/Pro CS configuration software, e.g.
to a function key or button.

File format CSV 

With file format CSV, the table columns (entry name and value) are separated by a
separator (e.g. semicolon). Each table row (entry) is terminated by a line feed. 

The example in Figure 7-6 (Page 7-10) appears as follows in CSV format for the
individually exported data record Juice:

Orange;Juice

3;2

Var_2;95

Var_3;5

Var_4;0.5

Var_5;100

Additional information is stored in the first two lines:

� Line 1: 
Name of the recipe and data record

� Line 2: 
Number of the recipe and data record

The operating unit interprets the information on importing the file.

Note

When the CSV files are edited with an external text editor, the modifications are
saved in text format (without control codes).
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Export/Import all data records of a recipe or all recipes

When appropriately configured, all the data records in a recipe or all recipes can be
imported/exported together. The CSV file for the example on Page  7-2 then
appears as follows:

Orange;Drink;Juice;Nectar

3;1;2;3

Var_2;90;95;70

Var_3;10;5;30

Var_4;1.5;0.5;1.5

Var_5;200;100;400

Additional information is stored in the first two lines:

� Line 1: 
Name of the recipe and all the configured data records

� Line 2: 
Number of the recipe and all the configured data records

The operating unit interprets the information on importing the file. 

In this way, the CSV file can be used, for example, to create new data records by
means of a spreadsheet program (Figure 7-7). After importing the modified file, the
new data records can be used on the operating unit.

Figure 7-7 Create data records externally (example: Microsoft� Excel)

If all the recipes are exported, a CSV file is created for each recipe.
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Exporting, editing and importing data records 

Proceed as follows in order to export data records on the operating unit in a CSV
file, edit it using with an external tool (e.g. spreadsheet program or text editor) and
import it back on the operating unit: 

Step Action

1 Export data record � Press the operating element linked with the
Export_Data_Records function (e.g. function key or button). 

Either all the data records, only the data record of a recipe
defined in the configuration or all the recipes on the data
medium are exported, according to the configuration.

The data records are exported in the file which was
configured in the parameter File Name in the function
Export_Data_Records.

� Copy the CSV file onto a transferable data medium or in a
directory which can be accessed by the external tool.

2 Edit CSV file � Carry out the modifications in the CSV file with an external
tool, e.g. Microsoft� Excel or a text editor.

� Save the modifications on the data medium.

� Copy the CSV file back to the original directory.

3 Import data
records

� Activate the operating element linked with the
Import_Data_Records function. 

The data records are copied in the data storage area
configured for the recipe.

Notice

If data records should be exported and the CSV files edited on a different Windows
system using a spreadsheet program (e.g. Microsoft Excel), ensure that the
decimal separator and list separator are identical on the two different systems.

These settings can be modified from the Windows Start menu using: Settings →
Control Panel → Regional Settings on the Numbers tab control.

The operating unit is supplied with the German language options set.
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7.4.5 Reaction on changing the recipe structure 

Standard behavior

The following section describes the standard behavior of the operating unit when it
detects differences between the data record structure stored on the data medium
and the recipe structure currently loaded on the operating unit.

Load and export data records, and write in the PLC

� The data record on the data medium contains additional tags:

The values are rejected.

� The data record on the data medium contains values which cannot be
converted to the assigned tag type:

The configured start value for the tag is used.

� Tags are missing in the data record on the data medium:

The configured start value for the tag is used.

Note

The assignment is lost on changing the tag name.

Import data records 

� The imported data record contains additional tags:

The values are rejected.

� The imported data record contains values which cannot be converted to the
assigned tag type:

The configured start value for the tag is used. This occurs, for example, when
the tag type in the project has been changed. 

� Tags are missing in the imported data record:

The configured start value for the tag is used.

Note

Export the data record after changing the recipe structure and check the exported
values. In this case, observe the note on Page 7-16.
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HMI System Messages

In this chapter

This chapter contains a selection of important HMI system messages for
Windows-based systems. The table indicates when the messages occur and how
they, or their cause, can be cleared. Not every message is relevant for each
operating unit.

HMI system message parameters

The HMI system messages may contain parameters which are not decoded for the
user but which are relevant in respect of the cause of an error since they provide a
reference to the source code of the runtime software. These parameters are
issued according to the text “Error code:”.

Notice

HMI system messages are issued in the language currently set on the operating
unit. 

Number Effect/Cause Remedy

10000 The print job could not be started or was
terminated for an unknown reason.

The printer is incorrectly configured.
Or: There are no rights for a network printer
available.

Check the printer settings and cable
connections.

If a fault occurs repeatedly, contact the
hotline.

10001 No printer has been installed or no standard
printer configured.

Install a printer and/or mark one as standard
printer.

10002 The intermediate buffer for printing graphics
is full. Up to two graphics can be buffered.

Do not issue print jobs so quickly in
succession.

10003 Graphics can be buffered again. –

10004 The intermediate buffer for printing lines in
text mode (e.g. messages) is full. Up to 1000
lines can be buffered.

Do not issue print jobs so quickly in
succession.

10005 Lines of text can be buffered again. –

10006 The Windows print system reports an error.
For information on the cause, refer to the text
printed and, if available, the error number.

Printing is not performed or it is incorrect.

Repeat the action, if necessary.

A
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RemedyEffect/CauseNumber

20010 A fault has occurred in the script line called
in from the specified script. Execution of the
script function was, therefore, terminated.

In this case, it is advisable to check any
previous system messages too.

Select the specified script line in the
configuration.

Check tags, whether the types used are
permissible.

Check Functions, whether the number and
types of parameter are correct.

20011 An error has occurred in a script called in by
the script specified. Execution of the script
function- has, therefore, been terminated in
the subscript.

In this case, it is advisable to check any
previous system messages too.

Select the scripts from the configuration
which are called in directly or indirectly via
the specified script.

Check tags, whether the types used are
permissible.

Check Functions, whether the number and
types of parameter are correct.

20012 Inconsistent configuration data is present.
Therefore, the script could not be created.

Compile the configuration again.

20013 VBScript.dll is not correctly installed.
Therefore, no scripts can be executed.

Re-install ProTool/Pro RT.

20014 A value is returned by the script function
which is not written in any configured return
tag.

Select the specified script in the
configuration.

Check whether the script name has been
assigned a value.

20015 Too many scripts have been triggered in
quick succession.
If more than 20 scripts are queued to be
processed, any subsequent scripts are
rejected.
In this case, the script indicated in the
message is not executed.

Check where the scripts are being triggered
from.

Extend the times, e.g. the polling time of the
tags, which trigger the scripts.

30010 The tag could not accept the function result,
e.g. in the case of exceeding the value
range.

Check the tag type of the function
parameter.

30011 A function could not be executed because
the function was assigned an invalid value or
type in the parameter.

Check the parameter value and tag type of
the invalid parameter.

If a tag is used as a parameter, check its
value.

40010 The function could not be executed since the
parameters could not be converted to a
common tag type.

Check the parameter types in the
configuration.

40011 The function could not be executed since the
parameters could not be converted to a
common tag type.

Check the parameter types in the
configuration.

50000 The operating unit receives data faster than
it is capable of processing. Therefore, no
further data is received until the data
currently available has been processed.
Data exchange then resumes.

–

50001 Data exchange has been resumed. –
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60000 This message is generated by the function
“Display system messages”. The text to be
displayed is transferred to the function as a
parameter.

–

60010 The file could not be copied in the direction
defined because one of the two files is
currently open or the source/target path is
not available.

It is possible that the Windows NT user has
no access rights to one of the two files.

Restart the function or check the paths of the
source/target files.

Using Windows NT with NTFS: The user
executing ProTool/Pro RT must be granted
access rights for the files.

60011 An attempt was made to copy a file to itself.

It is possible that the Windows NT user has
no access rights to one of the two files.

Check the path of the source/target file.

Using Windows NT with NTFS: The user
executing ProTool/Pro RT must be granted
access rights for the files.

70010 The application could not be started
because it could not be found in the path
specified or insufficient memory space was
available.

Check whether the application exists in the
specified path or close other applications.

70011 The system time could not be modified. The
error message only appears in connection
with area pointer Date/Time PLC. Possible
causes:

� an impermissible time was transferred in
the PLC job,

� the Windows NT user has no user rights
to modify the system time.

If the first parameter in the system message
is displayed with the value 13, the second
parameter indicates the byte containing the
incorrect value.

Check the time which is to be set.

Under Windows NT: The user executing
ProTool/Pro RT must be assigned the rights
to modify the system time from Windows NT
(administration/user manager, guidelines).

70012 An error occurred when executing the
function Exit Runtime with the option Exit
also Windows.

Windows and ProTool/Pro RT are not
terminated.

A possible cause is that other applications
cannot be terminated.

Terminate all applications currently running.

Then terminate Windows.

70013 The system time could not be modified
because an invalid value was entered.
Incorrect separators may have been used.

Check the time which is to be set.

70014 The system time could not be modified.
Possible causes:

� an impermissible time was transferred

� the Windows NT user has no user rights
to modify the system time,

� Windows rejects the setting request.

Check the time which is to be set.

Under Windows NT: The user executing
ProTool/Pro RT must be assigned the rights
to modify the system time from Windows NT
(administration/user manager, guidelines).

70015 The system time could not be read because
Windows rejects the reading function.

–
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70016 An attempt was made to select a screen by
means of a function or job. This is not
possible because the screen number
specified does not exist.

Or: a screen could not be generated due to
insufficient system memory.

Check the screen number in the function or
job with the screen numbers configured.

Refer the number to a screen, if necessary.

70017 Date/Time is not read from the area pointer
because the address set in the PLC is either
not available or has not been set up.

Change the address or set up the address in
the PLC.

70018 Acknowledgement that the password list has
been successfully imported.

–

70019 Acknowledgement that the password list has
been successfully exported.

–

70020 Acknowledgement for activation of message
recording.

–

70021 Acknowledgement for deactivation of
message recording.

–

70022 Acknowledgement to starting the Import
Password List action.

–

70023 Acknowledgement to starting the Export
Password List action.

–

70027 Backing up the RAM file system has been
started.

–

70028 Backing up  of the RAM file system has been
completed successfully.

The files from the RAM have been copied in
the Flash memory. Following a restart, these
saved files will be copied back in the RAM
file system.

–

70029 Backup of the RAM file system has failed.

No backup copy of the RAM file system has
been made.

Check the settings in the OP Properties
dialog and save the RAM file system using
the Save Files button in the Persistent
Storage tab control.

70030 The parameters configured for the function
are faulty.

The connection to the new PLC was not
established.

Compare the parameters configured for the
function with the parameters configured for
the PLC and correct them as necessary.

70031 The PLC configured in the function is not an
S7 PLC.

The connection to the new PLC was not
established.

Compare the S7 PLC name parameter
configured for the function with the
parameters configured for the PLC and
correct them as necessary.

80001 The archive specified is filled to the size
defined (in percent) and must be stored
elsewhere.

Store the file or table by executing a ‘move’
or ‘copy’ function.

80002 A line is missing in the specified archive. –
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80003 The copying process for archiving was not
successful.

In this case, it is advisable to check any
subsequent system messages, too.

–

80006 Since archiving is not possible, this causes a
permanent loss of the functionality.

In the case of databases, check whether the
corresponding data source exists and start
up the system again.

80009 A copying action has been completed
successfully.

–

80010 Since the path was incorrectly entered in
ProTool, this causes a permanent loss of the
functionality.

Configure the path for the respective archive
again and restart the system when the full
functionality is required.

80012 Archive values are stored in a buffer. If the
values are read to the buffer faster than they
can be physically written (e.g. using a hard
disk), overloading may occur and recording
is then stopped.

Archive less values.

Or increase the recording interval.

80013 The overload status no longer applies.
Archiving resumes the recording of all
values.

–

80014 The same action was triggered twice in quick
succession. Since the process is already in
operation, the action is only carried out once.

–

80016 The archives are separated by the function
Close archive and the incoming entries
exceed the defined buffer size.

All the jobs in the buffer are deleted.

Reconnect the archives.

80017 The incoming entries cause the defined
buffer size to be exceeded. This can be
caused, e.g. by several copying actions
being activated at the same time.

All the copy jobs in the buffer are deleted.

Terminate the copy process.

80018 All the archives are reconnected by means
of the DB layer, e.g. after executing the
function Open_archive.

Values are then written back into the tables.

–

80019 All the archives are separated from the DB
layer and all connections terminated, e.g.
after executing the function Close_archive.

Values are temporarily buffered and written
in the tables when the connection is
re-established.

There is no connection to the storage
medium and a change can take place.

–

80020 The max. number of simultaneously
activated copy actions has been exceeded.

Copying is not executed.

Wait until the current copying actions have
been completed and restart the last copy
action.
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80021 An attempt was made to delete an archive
which is still involved with a copy action.

Deletion has not been executed.

Wait until the current copying action has
been completed and restart the last action.

80022 An attempt was made to start a sequence
archive, which is not a sequence archive,
from an archive using the function
Start_sequence_archive.

No sequence archive is created.

Check the project for the following:

� the function Start_sequence_archive is
correctly configured.

� the variable parameters are being
correctly provided at the operating unit.

80023 An attempt was made to copy an archive to
itself.

The archive is not copied.

Check the project for the following:

� the function Copy_archive is correctly
configured.

� the variable parameters are being
correctly provided at the operating unit.

80024 The function Copy_archive is configured not
to permit copying when the target archive
already contains data (Parameter: Write
mode).

The archive is not copied.

Modify the function Copy_archive in the
project, if necessary.

Before initiating the function, delete the
target archive.

80025 The copy action is interrupted.

Data written up to this point is retained.
Deletion of the target table (if configured) is
not executed.

The cancellation is documented by an error
entry $RT_ERR$ at the end of the target
table.

–

80026 The message is issued after all the archives
have been successfully initialized. Values
are written in the archives from this moment
on. Prior to this, no values are archived even
though the runtime software is operating.

–

80027 The internal Flash memory has been
specified as the memory location for an
archive. This is not permissible.

No values will be archived for this archive
and the archive will not be created.

Configure ”Storage Card” as the memory
location or a network path.

80028 The message serves as a status
acknowledgment that initialization of the
archives is currently running. No values are
archived until system message 80026 is
issued.

–

80029 The number of archives specified in the
message could not be initialized. Initialization
of the archives has been completed.

The faulty archives are not available for
archiving jobs.

Evaluate the additional system message,
related to this message, which is also
issued.

Check the configuration, the ODBC (Open
Database Connectivity) and the specified
drive.
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80030 The structure of the table(s) available does
not match the archiving structure expected.

The archiving process is stopped for this
archive.

Delete the existing tables manually, in
advance.

80032 Archives can be configured with a function
trigger. This is triggered as son as the
archive is full. If runtime is started and the
archive is already full, the trigger function will
not be initiated.

The archive specified no longer archives
data since it is full.

Stop the runtime, delete the archive and
restart the runtime again.

Or:
Configure a button in the runtime which
contains the same actions as the function
trigger and press it.

110000 The operating mode status has been
changed. The operating mode is now offline.

–

110001 The operating mode status has been
changed. The operating mode is now online.

–

110002 The operating mode status has not been
changed.

Check the connection to the PLCs.

Check whether the address area for the area
pointer “Coordination” in the PLC is
available.

110003 The operating status of the PLC specified is
changed by the function Connect/Disconnect
PLC.

The operating mode is now offline.

–

110004 The operating status of the PLC specified is
changed by the function Connect/Disconnect
PLC.

The operating mode is now online.

–

110005 An attempt was made to use the function
Connect/Disconnect PLC to switch the
specified PLC to operating mode online
although the entire system is in operating
mode Offline. This switch-over is not
permissible.

The PLC remains in operating mode offline.

Switch the complete system to operating
mode online and execute the function again.

110006 The Colorado system has been extended by
the addition of the User Version area pointer.

If the user version is not correct, the runtime
is stopped.

Check the user versions.

Either the wrong version was entered in the
PLC or configuration or the wrong
configuration was started for the PLC user
version.

120000 The trend is not displayed because an
incorrect axis to the trend, or incorrect trend,
has been configured.

Change the configuration.

120001 The trend is not displayed because an
incorrect axis to the trend, or incorrect trend,
has been configured.

Change the configuration.
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120002 The trend is not displayed because the tag
assigned tries to access an invalid PLC
address.

Check whether the data area for the tag
exists in the PLC, the configured address is
correct or the value range for the tag is
correct.

130000 The action was not executed. Close other applications.

Delete files no longer required from the hard
disk.

130001 The action was not executed. Delete files no longer required from the hard
disk.

130002 The action was not executed. Close other applications.

Delete files no longer required from the hard
disk.

130003 No target data carrier is inserted. The
process is stopped.

Check, for example, whether:

� access has been made to the correct
data carrier

� the data carrier has been inserted

130004 The target data carrier is write-protected.
The process is stopped.

Check whether access has been made to
the correct data carrier. Remove the write
protection.

130005 The file is write-protected. The process is
stopped.

Check whether access has been made to
the correct file. Modify the file attributes, if
necessary.

130006 No access to file is possible. The process is
stopped.

Check, for example, whether:

� access has been made to the correct file

� the file exists

� a different action prevents simultaneous
access to the file

140000 Online connection to the PLC has been
successfully established.

–

140001 Online connection to the PLC has been
disconnected.

–

140003 No tag updating or writing is executed. Check the connection and whether the PLC
is switched on.

Check the parameter definitions in the
Control Panel using “Set PU/PC interface”.

Restart the system.

140004 No tag updating or writing is executed
because the access point or the subrack
configuration is incorrect.

Check the connection and whether the PLC
is switched on.

Check the access point or the subrack
configuration (MPI, PPI, PROFIBUS) in the
Control Panel with “Set PU/PC interface”.

Restart the system.
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140005 No tag updating or writing is executed
because the address of the operating unit is
incorrect (possibly too high).

Use a different operating unit address.

Check the connection and whether the PLC
is switched on.

Check the parameter definitions in the
Control Panel using “Set PU/PC interface”.

Restart the system.

140006 No tag updating or writing is executed
because the baud rate is incorrect.

Select a different baud rate in ProTool/Pro
(according to subrack, profile,
communication peer, etc.).

140007 No tag updating or writing is executed
because the bus profile is incorrect
(see %1).

The following parameters could not be
entered in the registry:

1: Tslot
2: Tqui
3: Tset
4: MinTsdr
5: MaxTsdr
6: Trdy
7: Tid1
8: Tid2
9: Gap Factor
10: Retry Limit

Check the user defined bus profile.

Check the connection and whether the PLC
is switched on.

Check the parameter definitions in the
Control Panel using “Set PU/PC interface”.

Restart the system.

140008 No tag updating or writing is executed
because the configuration data is incorrect:

The following parameters could not be
entered in the registry:

0: General errors
1: Incorrect version
2: Profile cannot be entered in the registry.
3: Sub-network type cannot be entered in

the registry.
4: Target rotation time cannot be entered

in the registry.
5: Highest address (HSA) incorrect.

Check the connection and whether the PLC
is switched on.

Check the parameter definitions in the
Control Panel using “Set PU/PC interface”.

Restart the system.

140009 No tag updating or writing is executed
because the module for the S7
communication was not found.

Re-install the module in the Control Panel
using “Set PU/PC interface”.

140010 No S7 communication peer could be found
because the PLC is switched off.

DP/T:
The option “Is not active as the only master”
is set in the Control Panel under “Set PU/PC
interface”.

Switch the PLC on.

DP/T:
If only one master is connected to the
network, deactivate the option “Is not active
as the only master” in “Set PU/PC interface”.

If the network has more than one master,
switch this master on. Do not modify any
settings here, otherwise a bus fault may
occur.

140011 No tag updating or writing is executed
because communication is interrupted.

Check the connection and that the
communication peer is switched on.
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140012 There is an initialization problem (e.g. when
ProTool/Pro RT has been terminated in the
Task Manager).

Or: another application (e.g. STEP7,
WINCC) is active with different bus
parameters and the driver cannot be started
with the new bus parameters  (e.g. baud
rate).

Restart the operating unit.

Or start ProTool/Pro RT first and then the
other applications.

140013 The MPI cable is not plugged in and, thus,
there is no power supply.

Check the connections.

140014 – Modify the operating unit address in the
configuration in PLC.

140015 Incorrect baud rate

Or: incorrect bus parameter (e.g. HSA)

Or: OP address HSA

Or: incorrect interrupt vector (interrupt does
not arrive at the driver)

Correct the incorrect parameters.

140016 – Change the interrupt number.

140017 – Change the interrupt number.

140018 The consistency check was deactivated by
Simotion Scout.

Only one appropriate note appears.

Activate the consistency check with Simotion
Scout again and load the configuration in the
project once more.

140019 Simotion Scout loads a new project in the
PLC.

Connection to the PLC is interrupted.

Wait until the end of the reconfiguration.

140020 The version in the PLC and that in the
configuration (FWD file) do not match.

Connection to the PLC is interrupted.

� Load the current version in the PLC
using Simotion Scout.

� Generate the anew project using
ProTool CS, end ProTool RT and start
with the new configuration.

150000 No more data is read or written.

Possible causes:

� The cable is defective.

� The PLC does not respond, is defective,
etc.

� Connection is established via the wrong
interface.

� The system is overloaded.

Check that the cable is plugged in, the PLC
is operational, the correct interface is used.

Reboot the system if the system message is
displayed continuously.

150001 Connection is re-established because the
cause of the interruption has been
eliminated.

–
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160000 No more data is read or written.

Possible causes:

� The cable is defective.

� The PLC does not respond, is defective,
etc.

� Connection is established via the wrong
interface.

� The system is overloaded.

Check that the cable is plugged in, the PLC
is operational, the correct interface is used.

Reboot the system if the system message is
displayed continuously.

160001 Connection is re-established because the
cause of the interruption has been
eliminated.

–

160010 There is no connection to the server
because the server identification (CLS-ID)
cannot be established.

Values cannot be read or written.

Check the access rights.

160011 There is no connection to the server
because the server identification (CLS-ID)
cannot be established.

Values cannot be read or written.

Check, for example, whether:

� the server name is correct

� the computer name is correct

� the server is registered

160012 There is no connection to the server
because the server identification (CLS-ID)
cannot be established.

Values cannot be read or written.

Check, for example, whether:

� the server name is correct

� the computer name is correct

� the server is registered

Information for experienced users:
Interpret the value from HRESULT.

160013 The specified server was started as InProc
Server. This has not been released and may
possibly lead to incorrect behavior because
the server is running in the same process
area as the ProTool/Pro RT runtime
software.

Configure the server as OutProc Server or
Local Server.

160014 Only one OPC server project can be started
on a PC/MP. An error message appears
when an attempt is made to start a second
project.

The second project has no OPC server
functionality and cannot be located as an
OPC server from external sources.

Do not start a second project with OPC
server functionality on the computer.

170000 1) S7 diagnostics messages are not displayed
because it is not possible to logon to the S7
diagnostics with this unit. The service
program is not supported.

–

170001 1) The S7 diagnostics buffer cannot be
displayed because communication with the
PLC has been switched off.

Switch the PLC  online
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170002 1) The S7 diagnostics buffer cannot be
displayed because reading in the
diagnostics buffer (SZL) was terminated due
to an error.

–

170003 1) The display of an S7 diagnostics message is
not possible. An internal error %2 has been
reported.

–

170004 1) The display of an S7 diagnostics message is
not possible. An internal error with error
class %2, error number %3 has been
reported.

–

170007 1) It is not possible to read in the S7
diagnostics buffer (SZL) because it was
terminated with an internal error with error
class %2 and error code %3.

–

180000 A component/OCX receives configuration
data with a version identification which is not
supported.

Install a newer component.

180001 The system is overloaded because too many
actions have been activated simultaneously.

Not all the actions can be executed, some
are rejected.

� Increase the configured cycle times or
basic clock.

� Generate the messages slower (polling).

� Trigger the scripts and functions at
greater intervals.

� If the message appears more frequently: 
Restart the operating unit.

180002 The screen keyboard could not be activated.

Possible causes:

� The screen keyboard is not generally
supported under Windows 95.

� The file “TouchInputPC.exe” was not
registered due to an incorrectly executed
Setup.

If Windows 95 is not available: 
Install the runtime software again.

190000 It is possible that the tag will not be updated. –

190001 The tag is updated following an error status
after the cause of the last error state has
been eliminated (return to normal operation).

–

190002 The tag is not updated because
communication to the PLC has been
switched off.

Switch on communication via the function
“Set Online”.

190004 The tag is not updated because the
configured address is not available for this
tag.

Check the configuration.

190005 The tag is not updated because the
configured PLC type does not exist for this
tag.

Check the configuration.

190006 The tag is not updated because it is not
possible to map the PLC type in the tag type.

Check the configuration.
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190007 The tag values are not modified because the
connection to the PLC has been terminated
or the tag is offline.

Switch Online or re-establish connection to
the PLC.

190008 The threshold values configured for the tag
have been violated, e.g. by

� an entered value,

� a function,

� a script.

Observe the configured or current threshold
value of the tag.

190009 An attempt has been made to assign a value
to a tag which is outside the value range
permitted for this type.

E.g. a value of 260 entered for a byte tag or
a value of -3 for a signless word tag.

Observe the value range for the tag type.

190010 The tag is described with values too often
(e.g. in a loop triggered by a script).

Values are lost because the maximum of
100 event have been stored in the buffer.

Increase the time interval between the
multi-writing tasks.

190011 Possible causes:

� The value entered could not be written to
the configured PLC tag because it was
either above or below the value range.
The input is rejected and the original
value is reset.

Ensure that the value entered is within the
value range of the PLC tags.

190011

� Connection to the PLC has been
interrupted.

Check the connection to the PLC.

190012 It is not possible to convert a value from a
source format to a target format, e.g.:

� A value should be assigned to a counter
which is outside the valid,
PLC-dependent value range.

� A tag of the type Integer should be
assigned a value of the type String.

Check the value range or type of the
variable.

190100 The area pointer is not updated because the
configured address for this area pointer is
not available.

Type:
1 Event messages
2 Alarm messages
3 PLC acknowledgment
4 Operating unit acknowledgment
5 LED assignment
6 Trend request
7 Trend transfer 1
8 Trend transfer 2

No.:
is the consecutive number displayed in
ProTool/Pro.

Check the configuration.
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190101 The area pointer is not updated because it is
not possible to map the PLC type in the area
pointer type.

Parameter type and no.:
See message 190100

–

190102 The area pointer is updated following an
error status after the cause of the last error
state has been eliminated (return to normal
operation).

Parameter type and no.:
See message 190100

–

200000 Coordination is not executed because the
address configured in the PLC does not
exist/has not been set up.

Change the address or set up the address in
the PLC.

200001 Coordination is not executed because the
address configured in the PLC cannot be
written.

Change the address or set up the address in
the PLC in an area which can be written.

200002 Coordination is not carried out at the
moment because the address format of the
area pointer does not match the internal
storage format.

Internal error

200003 Coordination can be executed again
because the last error status has been
eliminated (return to normal operation).

–

200004 It is possible that coordination is not
executed.

–

200005 No more data is read or written.

Possible causes:

� The cable is defective.

� The PLC does not respond, is defective,
etc.

� The system is overloaded.

Check that the cable is connected and the
PLC is in order.

Reboot the system if the system message is
displayed continuously.

210000 Jobs are not processed because the
address configured in the PLC does not
exist/has not been set up.

Change the address or set up the address in
the PLC.

210001 Jobs are not processed because the
address configured in the PLC cannot be
written to/read from.

Change the address or set up the address in
the PLC in an area which can be written
to/read from.

210002 Commands are not executed because the
address format of the area pointer does not
match the internal storage format.

Internal error

210003 The job mailbox is processed again because
the last error status has been eliminated
(return to normal operation).

–

210004 It is possible that the job mailbox is not
processed.

–

210005 A PLC job was triggered by an impermissible
number.

Check the PLC program.
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210006 A fault occurred while attempting to execute
the PLC job. The PLC job is, therefore, not
executed.

Observe the subsequent/previous system
message, if appropriate.

Check the parameter types in the PLC job.

Compile the configuration again.

220000 2) See footnote See footnote

220001 The tag is not downloaded because the
associated channel/the unit does not support
downloading the data type bool/bit.

Change the configuration.

220002 The tag is not downloaded because the
associated channel/the unit does not support
downloading the data type byte.

Change the configuration.

220003 The associated driver could not be
uploaded. It is possible that the driver is not
installed.

Install the driver by re-installing
ProTool/Pro RT.

220004 Communication is terminated and no update
is executed because the cable is not
connected or is defect etc.

Check the connection.

220005 Communication is running. –

220006 The connection is established to the
specified PLC at the specified interface.

–

220007 The connection to the specified PLC at the
specified interface is disconnected.

Check that:

� the cable is plugged in

� the PLC is OK

� the correct interface is used

� the configuration is OK (interface
parameters, protocol settings, PLC
address).

Reboot the system if the system message is
displayed continuously.

220008 The PLC driver cannot access the specified
interface or open it. It is possible that another
application is using this interface or an
interface is used which is not available on
the target device.

There is no communication with the PLC.

Terminate all the programs which access the
interface and reboot the computer.

Use another interface which is available in
the system.

230000 The value entered could not be accepted.
The entered value is rejected and the
previous value is specified again.

Either the value range has been exceeded
or impermissible characters were entered.

Enter a permissible value.

230002 Since the current password level is
inadequate or the password dialog box was
closed with ESC, the entry is rejected and
the previous value is specified again.

Activate an adequate password level using
Login.
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230003 Changeover to the specified screen is not
executed because the screen is not
available/configured. The current screen
remains selected.

Configure the screen.

Check the selection function.

240000 3) Runtime is operating in Demo mode.

There is either no Stopcopy license or it is
defect.

Load the license.

240001 3) Runtime is operating in Demo mode.

Too many tags are configured for the
installed version.

Load an adequate license / powerpack.

240002 3) Runtime is operating with a time-limited
standby authorization.

Restore the full authorization.

240003 Authorization cannot be executed.

ProTool/Pro RT is running in Demo mode.

Restart ProTool/Pro RT or reinstall it.

240004 Error during reading the standby
authorization.
ProTool/Pro RT is running in Demo mode.

Restart ProTool/Pro RT, install the
authorization or repair the authorization (see
Commissioning Instructions Software
Protection).

250000 The tag in the specified line in Status/Control
is not updated because the address
configured for this tag is not available.

Check the set address and then check that
the address has been set up in the PLC.

250001 The tag in the specified line in Status/Control
is not updated because the PLC type
configured for this tag is not available.

Check the set address.

250002 The tag in the specified line in Status/Control
is not updated because it is not possible to
map the PLC type in the tag type.

Check the set address.

250003 No connection could be established to the
PLC. The tags will not be updated.

Check the connection to the PLC. Check
that the PLC is switched on and online is
activated.

260000 A password has been entered which is
unknown to the system. Therefore, the
lowest password level has been set. This
corresponds to the status following Logout.

Enter a known password in the password
input field (with corresponding level).

260001 A password has been entered whose
assigned level does not permit execution of
the function.

The password level currently set is displayed
for information purposes.

Modify the password level in the password
input field enter a password with a
sufficiently high level.

260003 The user has logged off from the system. If
the password level is 0, no user is logged
on.

–

270000 A tag is not displayed in the message
because it attempts to access an invalid
address in the PLC.

Check whether the data area for the tag
exists in the PLC, the configured address is
correct or the value range for the tag is
correct.
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270001 There is a unit-dependent limit as to how
many messages may be queued
simultaneously in order to be displayed (see
GHB). This limit has been exceeded.

The display no longer contains all the
messages.

However, all the messages are recorded in
the message buffer.

–

270002 Messages are displayed from an archive are
displayed for which there is no data in the
current project.

Placeholders are issued for the messages.

Delete older archive files, if necessary.

270003 The service cannot be set up because too
many devices was to set up this service.

A maximum of four devices can execute this
action.

Connect fewer operating units which want to
use the service.

280000 Connection is re-established because the
cause of the interruption has been
eliminated.

–

280001 No more data is read or written.

Possible causes:

� The cable is defective.

� The PLC does not respond, is defective,
etc.

� Connection is established via the wrong
interface.

� The system is overloaded.

Check that the cable is plugged in, the PLC
is operational, the correct interface is used.

Reboot the system if the system message is
displayed continuously.

280002 A connection is used which requires a
function module in the PLC.

The function block has replied.
Communication can now proceed.

–

280003 A connection is used which requires a
function module in the PLC.

The function block does not reply.

Check that the cable is plugged in, the PLC
is operational, the correct interface is used.

Reboot the system if the system message is
displayed continuously.

The remedy is dependent on the error code:
1: The function block must set the COM

bit in the response container.

2: The function block may not set the
ERROR bit in the response container

3: The function block must respond within
the specified time (timeout)

4: Establish an online connection to the
PLC
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280004 The online connection to the PLC has been
interrupted. There is no data exchange at
present.

Check the PLC parameters in ProTool Pro:
baud rate, block length, station address.

Check that the cable is plugged in, the PLC
is operational, the correct interface is used.

Reboot the system if the system message is
displayed continuously.

290000 The tag could not be read or written. It is
assigned the start value.

The message can be entered in the
message buffer for up to four more failed
tags, if necessary. After that, the message
number 290003 is issued.

Check in the configuration that the address
has been set up in the PLC.

290001 An attempt has been made to assign a value
to a tag which is outside the value range
permitted for this type.

The message can be entered in the
message buffer for up to four more failed
tags, if necessary. After that, the message
number 290004 is issued.

Observe the value range for the tag type.

290002 It is not possible to convert a value from a
source format to a target format.

The message can be entered in the
message buffer for up to four more failed
tags, if necessary. After that, the message
number 290005 is issued.

Check the value range or type of the
variable.

290003 This message is issued when message
number 290000 is triggered more than five
times.

In this case, no further individual messages
are generated.

Check in the configuration that the tag
addresses have been set up in the PLC.

290004 This message is issued when message
number 290001 is triggered more than five
times.

In this case, no further individual messages
are generated.

Observe the value range for the tag type.

290005 This message is issued when message
number 290002 is triggered more than five
times.

In this case, no further individual messages
are generated.

Check the value range or type of the
variable.

290006 The threshold values configured for the tag
have been violated by values entered.

Observe the configured or current threshold
value of the tag.

290007 There is a difference between the source
and target structure of the recipe currently
being processed. The target structure
contains an additional data record tag which
is not available in the source structure.

The data record tag specified is assigned its
start value.

Insert the specified data record tag in the
source structure.
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290008 There is a difference between the source
and target structure of the recipe currently
being processed. The source structure
contains an additional data record tag which
is not available in the target structure and
therefore cannot be assigned.

The value is rejected.

Remove the specified data record tag in the
specified recipe from the project.

290010 The storage location configured for the
recipe is not permitted.

Possible causes: 
Impermissible characters, write protected,
data medium full or does not exist.

Check the path specification configured.

290011 The data record specified by the number
does not exist.

Check the source for the number (constant
or variable value).

290012 The recipe specified by the number does not
exist.

Check the source for the number (constant
or variable value).

290013 An attempt was made to save a data record
under a data record number which already
exists.

The process is not executed.

� Check the source for the number
(constant or variable value).

� Delete the data record beforehand.

� Change the function parameter 
“Overwrite”.

290014 The file specified to be imported could not be
found.

� Check the file name.

� Ensure that the file is in the specified
directory.

290020 Acknowledgement that downloading of data
records from operating unit to PLC has
started.

–

290021 Acknowledgement that downloading of data
records from operating unit to PLC has been
completed without any errors.

–

290022 Acknowledgement that downloading of data
records from operating unit to PLC has been
terminated due to an error.

Check the configuration:

� have the tag addresses been set up in
the PLC?

� does the recipe number exist?

� does the data record number exist?

� has the function parameters ”Overwrite”?

290023 Acknowledgement that downloading of data
records from the PLC to the operating unit
has started.

–

290024 Acknowledgement that downloading data
records from the PLC to the operating unit
has been completed without any errors.

–
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290025 Acknowledgement that downloading of data
records from the PLC to the operating unit
has been terminated due to an error.

Check the configuration:

� have the tag addresses been set up in
the PLC?

� does the recipe number exist?

� does the data record number exist?

� has the function parameters ”Overwrite”?

290026 An attempt has been made to read/write a
data record although the data mailbox is not
free at present.

This error may occur in the case of recipes
for which downloading with synchronization
has been configured.

Set the data mailbox status to zero.

290027 No connection to the PLC can be
established at present. Therefore, the data
record can neither be read nor written.

Possible causes: 
No physical connection to the PLC (no cable
plugged in, cable is defect) or the PLC is
switched off.

Check the connection to the PLC.

290030 This message is issued after reselecting a
screen that contains a recipe display in
which a data record has already been
selected.

Reload the data record from the data
medium or retain the current values.

290031 While saving, it was detected that a data
record with the specified number already
exists.

Overwrite the data record or cancel the
process.

290032 While exporting data records, it was detected
that a file with the specified name already
exists.

Overwrite the file cancel the process.

290033 Confirmation request before deleting data
records.

–

290040 A data record error with error code %1 has
occurred which cannot be described in more
detail.

The action was canceled.

It might be that the data mailbox has not
been installed correctly on the PLC.

Check that the data carrier, the data record,
the data mailbox and, if necessary, the
connection to the PLC.

Trigger the action again after waiting a short
period.

If the error occurs again, please contact the
Customer Support. Specify the error code
displayed.

290041 A data record or file cannot be saved
because the data medium is full.

Delete files no longer required.

290042 An attempt was made to execute several
recipe actions simultaneously.

The last action was not executed.

Trigger the action again after waiting a short
period.

290043 Confirmation request before storing data
records.

–
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290044 The data store for the recipe has been
destroyed and will be deleted.

–

290050 Acknowledgement that the exportation of
data records has started.

–

290051 Acknowledgement that the exportation of
data records has been completed
successfully.

–

290052 Acknowledgement that the exportation of
data records has been terminated due to
errors.

Ensure that the structure of the data records
on the data medium and the current recipe
structure on the operating unit are identical.

290053 Acknowledgement that the importation of
data records has been started.

–

290054 Acknowledgement that the importation of
data records has been completed
successfully.

–

290055 Acknowledgement that the importation of
data records has been terminated due to
errors.

Ensure that the structure of the data records
on the data medium and the current recipe
structure on the operating unit are identical.

290056 The value in the specified line/column could
not be read/written without errors.

The action was canceled.

Check the specified line/column.

290057 The tags of the recipe specified have been
switched from operating mode “offline” to
“online”.

Each modification of a tag in this recipe is
now immediately transferred to the PLC.

–

290058 The tags of the recipe specified were
switched from operating mode “online” to
“offline”.

Modifications to tags in this recipe are no
longer immediately transferred to the PLC
but must be transferred there explicitly by
means of downloading a data record, if
necessary.

–

290059 Acknowledgement that the specified data
record has been stored successfully.

–

290060 Check-back message that the data record
memory has been successfully erased.

–

290061 Check-back message, that erasing the data
record memory was aborted with errors.

–

290068 Request to confirm whether all data records
in the recipe should be deleted.

–

290069 Request to confirm whether all data records
of all recipes should be deleted.

–

290070 The data record specified is not contained in
the import file.

Check the source of the data record number
or data record name
(constant or tag value).
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300000 Process monitoring (e.g. using PDiag or
S7-Graph) has been incorrectly
programmed: More messages are queued
than specified in the technical data of the
CPU. No further ALARM_S messages can
be managed by the CPU and reported to
operating systems.

Change the CPU configuration.

310000 An attempt is being made to print too many
protocols simultaneously.

Since only one protocol can be printed at a
time, the print job is rejected.

Wait until printout of the last active protocol
has been concluded.

Repeat the print job, if necessary.

310001 An error occurred on triggering the printer.
The protocol is either not printed or printed
with errors.

Evaluate the additional system message,
related to this message, which is also
issued.

Repeat the print job, if necessary.

320000 The movements have already been
indicated by another device.

The movements can no longer be served.

Select the movements on the other display
units and select the movement screen on the
required display unit.

320001 The network is too complex.

The defective operands cannot be
displayed.

Display the network in AWL.

320002 No diagnostics-capable alarm messages
have been selected.

The units related to the alarm messages
could not be selected.

Select a diagnostics-capable alarm message
in the message screen ZP_ALARM.

320003 No alarm messages exist in respect of the
selected unit.

No network can be displayed in the detail
display.

Select the defective unit in the general view
screen.

320004 The required signal statuses could not be
read by the PLC.

The defective operands cannot be
established.

Check the consistency between the
configuration on the display unit and the PLC
program loaded.

320005 The project contains ProAgent partitions
which are not installed.

No ProAgent diagnostics can be performed.

In order to run the project, install the
ProAgent option packet.

320014 The selected PLC cannot be evaluated for
ProAgent.

The message display configured with the
Evaluate_message_display_fault function
could not be found.

Check the parameters of the
Evaluate_message_display_fault

 function.

1) The optional parameter %1 at the start of the message may contain an identification for the S7 connection
when several S7s are in parallel operation and are connected to diagnostics equipment.

2) A WinCC channel provides the message texts via an interface. This text is issued via this message.
ProTool/Pro RT has no influence on this texts.

3) The specified text comes from the component resources.
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Procedure in the case of “internal errors”

Please proceed as follows in the case of all system messages related to “internal
errors”:

1. Start up the operating unit again.

2. Download the configuration again.

3. Switch the operating unit off, stop the PLC and then restart both.

4. If the error occurs again, please contact the SIMATIC Customer Support. Make
reference to the specified error number and message tags.
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A

Acknowledgement

Acknowledgement of an alarm message on the operating unit confirms that it has
been noted. After acknowledgement, the message disappears from the operating
unit. Alarm messages can be acknowledged either on the operating unit or PLC.
Alarm messages can be compiled into groups so that several messages can be
acknowledged simultaneously.

Acknowledgement groups

During configuration, several alarm messages can be compiled to form an
acknowledgement group. After acknowledging the first message, all the other
messages belonging to the same group are simultaneously acknowledged. This
enables, for example, acknowledgement of alarm messages for the cause of a
fault and all resulting faults (group acknowledgement).

Alarm message

Provides information on the operating unit concerning operating errors on the
machine or system connected to the PLC. The message text may also contain
current measured values.

Since alarm messages indicate abnormal operating status, they must be
acknowledged.

ALARM_S

Active alarm process through which the CPU transfers alarm messages to all
users logged on in the network. ALARM_S messages are configured in STEP 7.

Alarm time

Time interval between the arrival and departure of an alarm message.

Analog display

An analog display indicates numerical values by means of a pointer instrument.
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Archive

A memory area on a data storage medium in which messages or tags can be
stored. The size of the archive is defined in ProTool/Pro CS.

Area pointer

Defines a memory area in the PLC for data exchange between the PLC and
operating unit.

B

Bar graphs

Represent values from the PLC as rectangular areas. This is a way of displaying
filling levels or workpiece numbers, for example, on the operating unit.

Baud rate

Rate of speed at which data is downloaded. Baud rate is specified in Bit/s.

Blank

Switch off or fade out the screen saver.

Boot

A loading process which downloads the operating system in the working memory
of the operating unit

Button

A virtual button on the operating unit screen. Buttons on operating units with touch
screens are contact sensitive.

C

Clicking

Configurable event which can trigger a function assigned to a button, for example,
when the button is pressed and released (clicked) within the contour of the button.

If the button is pressed using the mouse button or finger (when using touch panels)
but moved outside the contour before releasing, the operating unit does not
interpret the action as a click event.
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Clock

A screen object used to display the system time in numbers (digital) or as a clock
with hands (analog).

Configuration

Definition of system–specific default settings, messages and screens using the
configuration software ProTool.

D

Data record

Is a recipe containing data. A recipe can be comprised of several data records.
When a data record is downloaded, all the assigned data is transferred to the PLC
together and synchronously.

Display period

Defines whether and how long a system message is displayed on the operating
unit.

Download

The transfer of run–capable project data to the operating unit. Connect the
operating unit to the configuration computer with a standard cable beforehand.

Download mode

Operating unit operating mode in which data can be downloaded from the
configuration computer to the operating unit (also refer to Download).

E

Events

Functions are triggered when defined events are received, e.g. pressing or
releasing a key or button. Events can be configured related to objects.

Event message

Provides information on the operating unit concerning the operating statuses of the
machine or system connected to the PLC. The message text may also contain
current measured values.
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F

Fixed window

A fixed window at the top edge of the screen whose content is independent of the
screen currently open. The fixed window can be used to display important process
magnitudes or date and time, for example.

Flash memory

Programmable memory which can be electrically deleted and written to again
segment–by–segment.

Function key

Key on the operating unit to which a configurable function can be assigned. A
function key with a global function assignment always initiates the same function
regardless of the screen currently open. A function key with a local function
assignment (softkey) can have a different function for each screen.

G

Global tag

This is a process tag linked to the PLC. Global tags have a fixed address in the
PLC. The operating unit accessed this address for reading and writing purposes.

Graphic box

A graphic can be selected by selecting an entry in the graphic list.

Graphics list

A list in which each value relates to a tag assigned to a graphic. This enables, for
example, the assigned graphic to be displayed on the operating unit output field
instead of the value.

Group acknowledgement

During the configuration, each alarm message can be assigned to an
acknowledgement group. When the alarm message is acknowledged, all the
other alarm messages in the same group are simultaneously acknowledged.
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H

Hardcopy

Represents a printout of the current screen content. Windows called in on top are
not printed.

Help text

Configurable, additional information on messages, screens and fields. The help
text concerning an alarm message can, for example, contain information on the
cause of the fault and methods of elimination.

Hidden buttons

Buttons which are only visible during configuration, not on the operating unit. If
hidden buttons are superimposed on components in the process screen, the
respective components can be operated by clicking the button with the mouse or
pressing them on the touch screen.

I

Icon

Pixel graphic of a fixed size, e.g. assigned to a softkey, to identify its function.

Input field

Enables the user to enter values which are subsequently downloaded to the PLC.

L

Limit value

Configurable values of a tag defining a value range. Attempts to define values
outside these limits, may cause the following effects on the operating unit:

� Input field
input is rejected

� Output field
values are displayed in the configured color

� Trend/Bar
values are displayed in the configured color
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Local tag

Is a tag which is not linked to the PLC. Local tags are only available on the
operating unit.

Logout time

Configurable interval of time after which the password level is reset to zero when
the operating unit is not used.

M

Message arrival

Time at which a message was triggered by the PLC or operating unit.

Message buffer

Memory area on the operating unit in which message events can be stored in
chronological order as they arrive. Event messages and alarm messages are
stored in separate message buffers.

Message departure

Time at which a message was withdrawn by the PLC.

Message display

A screen object with configurable filter criteria for displaying the volatile message
buffer or message archive.

Message events

These are stored in chronological order in the operating unit message archive.
Message events consist of:

� Message arrival

� Message acknowledgement

� Message departure

Message indicator

A configurable graphical symbol displayed on the operating unit when at least one
alarm message has been queued.

Message logging

Printout of messages parallel to their display on the operating unit display.
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Multi Panel

Multi–functional, configurable operating unit with graphics display and Windows�
CE operating system for operating and monitoring machines and systems.

N

Normal operation

Operating unit operating mode in which messages are displayed and screens can
be operated.

O

Object

Is a component part of a screen or message. Depending on the object type,
objects serve to display or enter texts and values on the operating unit.

Operator Panel

Operating unit which can be configured for operating and monitoring machines and
systems.

Output field

Displays current values from the PLC on the operating unit.

P

Password

A character string which must be entered on the operating unit before a protected
function can be activated. Each password is assigned to a password level.

Password level

The rights to use operating units can be specifically restricted to certain users and
user groups. To do this, the individual functions and operating elements are
assigned to hierarchically defined password levels. The password level linked to
the password allocates the rights to execute functions on the operating unit
belonging to that level or lower.
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Passwort list

A screen object used to enter passwords for different access right levels.

PCL

Hewlett� Packard (Printer Control Language).

PCMCIA

Personal Computer Memory Card International Association

Joint operation of computer companies with the aim of defining one international
standard for memory cards and PC expansion cards. Cooperation with JEIDA.

PLC

General term for units and systems with which the operating unit communicates
(e.g. SIMATIC S7 or PC).

PLC job

PLC jobs can be used by the PLC to trigger functions on the operating unit, e.g.
display a screen.

Power–up test

Checks the status of the CPU and memory each time the power is switched on.

Print screen

Printout of a copy of the screen contents.

Process screen

The display of process values and process progress on the operating unit in the
form of screens, which may contain graphics, texts and values.

Profile trend curve

A type of trend curve whereby, after setting a triggering bit, all the trend values are
read from the PLC and displayed on the operating unit as a curve. Profile trend
curves are excellent for displaying quick changes in cases where the overall view
(profile) of the trend is the feature of interest, not the individual values.

Programmable controller

PLC from the SIMATIC S5 series (e.g. AG S5-115U/135U).
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Programmable system

PLC from the SIMATIC S7 series (SIMATIC S7-200/300/400).

ProSave

A service tool which provides all the functions which are necessary for the transfer
of data between the configuration computer and operating unit.

ProTool/Pro CS

Full graphics based configuration software for the entire SIMATIC HMI unit range
and for Windows–based systems.

ProTool/Pro RT

Process visualization software with which the project created with ProTool/Pro CS
can be run on a Windows–based system.

Q

Queued message

A queued message is a message detected as having been received by the
operating unit (message event Arrived) but for which the message event
departed has still not been received.

R

Recipe

A combination of tags to a fixed data structure. The data structure configured can
be assigned data on the operating unit and is then referred to as a data record.
The use of recipes ensures that when a data record is downloaded, all the
assigned data is transferred to the PLC together and synchronously.

Recipe view

A screen object used to create, edit, save and download data records.

Release

Configurable event, e.g. for a button, which triggers a function as soon as the
pressed button is released.

If the button is pressed using the mouse button or finger (when using touch panels)
but moved outside, the function is triggered when the function is released.
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Remaining buffer

Configurable size of the message buffer. In the case of a buffer overflow, the
operating unit deletes message events until the configured remaining buffer
capacity is reached.

RS232

Standard interface for serial data transfer at a defined voltage level. Transmitter
and receiver are electrically connected.

RS485

Standard interface for serial data transfer at a very high transmission rate.

Runtime software

The program visualization software SIMATIC ProTool/Pro RT with which the
project created using ProTool/Pro CS can be run on your Windows–based system.

S

Screen

A screen displays all the logically related process data on the operating unit,
whereby the individual values can be modified. Screens are composed of static
and dynamic parts. Static parts refer to text and graphics, dynamic parts to input
and output fields.

Screen keyboard

A virtual keyboard displayed on the operating unit screen. This enables values to
be entered via the touch screen, for example, without the necessity of connecting a
keyboard.

Selection field

An input element in which the possible user entries are predefined and displayed in
a list for selection. An entry can be selected from the list using the operating unit.

Slider control

A screen object to enter and issue numeric values in analog form.

Softkey

Function key on the operating unit with a local function assignment. The function
triggered by a softkey varies according to the screen currently open.
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Start screen

The first screen, which automatically appears after the unit has started up.

State view

The State view is a configurable display element. Depending on the configuration,
it can signal a warning or the status of a unit which cannot be viewed from the
operating unit.

Status button

A status button is a display and operating element with two possible states: ON
and OFF, i.e. touched and untouched. Both states can be configured for display
with text or graphics, which then label the status button.

Status/Force tag

Screen object with which individual address areas in the connected SIMATIC S5 or
SIMATIC S7 can be accessed for reading and writing directly from the operating
unit.

Superuser

A user with permissions to trigger functions of the highest password level. The
superuser has access to all the operating unit functions.

Switch

A screen object to enter and issue a binary status. A switch can only be switched
on or off.

System message

Provides information on the operating unit concerning internal statuses of the
operating unit and PLC.

T

Tag

A defined memory location in which values can be read from and written to. This
can be performed from the PLC or via the operating unit. Depending on whether
the tag is linked to the PLC or not, a distinction is made between “global” tags
(process tags) and “local” tags.



Glossary Release 12/01

Glossary-12
User’s Guide ProTool/Pro Runtime 

6AV6594-1CA06-0AB0

Trend curve

Curve type by which just one curve value is read from the PLC per cycle or trigger
resulting in a curve display. If the configured number of measured values is not
achieved, each new value overwrites the oldest value. Trend curves are especially
suited to displaying continual progress.

Trend view

A screen object to clearly display the continuous progression of process data. The
trend view can be used to display several different trends simultaneously.
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Index

A
Acknowledgement, alarm message, 6-20 ,

6-25 
Acknowledgment groups, alarm message, 2-1 
Activate, event, 6-15 
Activate multilanguage support, 5-4 
Alarm message buffer, example, 6-23 
Alarm message page, 6-22 
Alarm messages, 2-1 , 3-8 , 6-19 

acknowledge, 6-20 , 6-25 
ALARM_S, 3-9 
Allen Bradley, 2-4 , 3-18 
Alphanumeric input field , 6-16 
Analog clock, 6-35 
Analog display, 3-7 , 6-33 
Application examples, Recipes, 7-4 
Application scenarios, recipes, 7-3 
Apply, Status/Force, 6-40 
Archive, 2-2 

configuring, 3-13 
Archive storage

CSV file, 3-12 
Database, 3-12 

Archives, 3-12 
Archiving, 3-1 
Area of use, 3-1 
Area pointer, simulation, 5-14 
Authorization, 1-2 , 4-1 

password protection, 6-36 
AUTHORSW.EXE, 5-5 
Autorun function, 5-5 

B
Backing up the configuration, 5-3 
Backup, 5-2 
Backup copy of the configuration, SIMATIC

operating unit, 5-2 
Bar graph, 3-6 , 6-27 
BIOS, OP 37/Pro, 5-10 
Bit triggering, 6-28 
Buffering, Messages, 3-8 

Button, 3-5 , 6-11 
Apply (Status/Force), 6-40 
Message display, 6-25 
Messages, 6-20 
Status/Force, 6-39 
Update (Status/Force), 6-40 

Buttons
hidden, 6-11 
Trends, 6-29 

C
C7 units, 4-2 
Calendar dates, 6-34 
Capacity, message buffer, 2-2 
CD–ROM, 4-4 
Change

data record, 7-16 
language, 6-6 
recipe structure, 7-27 

Change column sequence, Message display,
6-25 

Change structure, recipe, 7-27 
Check, Limit value, 6-16 
Circle, 3-5 
Clicking, event, 6-11 , 6-42 
Client/Server, 2-4 , 3-18 
Clipboard, 3-2 
Clock, 6-35 
Color change

input field, 6-17 
Trend view, 6-28 

Color changes, selection field, 6-18 
Coloration, screen objects, 5-4 
Column properties, Message display, 6-25 
Commissioning, 5-1 

requirements, 4-1 
Communication, 2-4 , 3-1 , 5-6 
Communication processor, 5-9 
Communications processor, 4-6 
Compatibility, cursor control, 6-8 
Components of ProTool/Pro, 4-1 
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Compress
trend view, 6-29 , 6-30 

Configuration, source file, 5-13 
Configuration backup, 5-3 
Configuration backup copy, SIMATIC operating

unit, 5-2 
Configuration software, 1-1 , 1-3 
Configure, database, 3-13 
Configuring, Windows, 5-3 
Connectable PLCs

OP37/Pro, 4-5 
PC, 4-6 

Connection, 1-3 , 5-6 
OP37/Pro to PLC, 4-5 
PC to PLC, 4-6 
Status/Force, 6-39 

Contour, 6-11 
Conventions, Date/Time, 6-34 
Conversion functions, 2-3 
Convert, 3-2 
Convert_Data_Record_Number_to_Name,

Function, 7-20 
Copy, 3-2 

data records, 7-15 
Copy data record, selecting a data record

name, 7-15 
Copy protection, 5-5 
Copying data records after selecting a data

record name, 7-15 
Create, data record, 7-14 
CSV file, 3-12 , 7-24 , 7-25 
Cursor control, compatibility, 6-8 
Cursor movement, 6-2 
Cycle triggering, 6-28 

D
Data format, simulator, 5-16 
Data record

change, 7-16 
copy, 7-15 
create, 7-14 
definition, 7-1 , 7-2 
editing, 7-9 
import, 7-27 
renaming, 7-17 
save, 7-14 
save as, 7-17 
synchronization, 7-19 

Data records
deleting, 7-17 
display, 7-14 
downloading to PLC, 7-18 
editing, 7-26 
export/import, 7-23 
exporting, 7-26 
importing, 7-26 
read from PLC, 7-18 

Data Source Name, 3-12 
Data structure, 7-2 
Data type, Status/Force, 6-39 
Data_Record_DAT_to_PLC, Function, 7-20 ,

7-22 
Data_Record_Display_to_PLC, Function, 7-20,

7-22 
Data_Record_PLC_to_DAT, Function, 7-20 ,

7-22 
Data_Record_PLC_to_Display, 7-22 

Functon, 7-20 
Data_Record_PLC_to_Tags, function, 7-20 
Data_Record_Tags_to_PLC, Function, 7-20 
Database, 3-12 

configuration, 3-13 
Database , 2-2 
Date, 6-16 , 6-34 

simulation, 5-16 
Date/Time, 3-5 
DB number, Status/Force, 6-39 
Deactivate, event, 6-15 
Decrementation, 5-18 
Delete

data records, 7-17 
password, 6-38 

Delete_Data_Record_from_Display, Function,
7-20 

Delete_Data_Record_Memory, Function, 7-20 
Demo mode, 5-5 
Digital clock, 3-7 
Digital/Analog clock, 3-7 , 6-35 
Direct cable connection, 5-21 
Direct key module, 5-10 
Disk transfer, 5-11 
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Display
alarm messages, 2-1 
analog, 6-31 
data records, 7-14 
event messages, 2-1 
messages, 3-8 
numeric values, 6-31 , 6-33 
Settings, 6-7 

Display elements, Recipe display, 7-11 
Display fill level, 6-27 
Display Information Text, function, 6-5 
Display priorities, Messages, 6-19 
Display type, alarm messages, 2-1 
Display_event_message_window, Function,

6-20 
Double–click, event, 6-42 
Download, 3-1 
Downloading

data records to PLC, 7-18 
project, 5-10 

DSN, 3-12 
Duration of display, 6-20 
Dynamic labeling, 6-11 
Dynamic positioning, screen keyboard, 6-4 

E
Edit

data records, 7-9 , 7-26 
messages, 6-20 , 6-25 

Electrical installation, 4-5 
Ellipse, 3-5 
Enlarge, trend view, 6-30 
Enter

numeric values, 6-31 
password, 6-38 

Entering, password, 6-36 
Entries, number, 7-8 
Entry name, 7-2 
Event

print, 3-5 
status change, 6-13 , 6-15 

Event message screen, 6-22 
Event messages, 2-1 , 3-8 , 6-20 

Events, 3-11 
activate, 6-15 
clicking, 6-11 , 6-42 
Deactivate, 6-15 
double–click, 6-42 
printing, 6-11 , 6-13 , 6-42 
release, 3-5 
releasing, 6-11 , 6-13 , 6-42 
Time_expired, 3-15 

Example
recipe, 7-2 
simulation, 5-19 

Expand, trend view, 6-29 
Export

data record, 7-23 
data records, 7-26 
password list, 6-38 

Export_Data_Records, Function, 7-20 , 7-22 
Export_Import_passwords, function, 6-38 
Extend, trend view, 6-30 
External PLC, 2-4 

F
File format, CSV, 7-24 
Filter criteria, Message display, 6-24 
Fixed window, 6-4 
Flashing

LED, 3-16 
messages, 6-19 

Floppy disk drive, 4-4 
Force value, 6-40 
Format

Date/Time, 6-34 
Status/Force, 6-39 

Full screen mode, 6-7 
Function

Convert_Data_Record_Number_to_Name,
7-20 

Data_Record_DAT_to_PLC, 7-20 , 7-22 
Data_Record_Display_to_PLC, 7-20 , 7-22 
Data_Record_PLC_to_DAT, 7-20 , 7-22 
Data_Record_PLC_to_Display, 7-20 , 7-22 
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Function
Data_Record_PLC_to_Tags, 7-20 
Data_Record_Tags_to_PLC, 7-20 
Delete_Data_Record_from_Display, 7-20 
Delete_Data_Record_Memory, 7-20 
Export_Data_Records, 7-20 , 7-22 
Load_Data_Record, 7-20 
New_Data_Record, 7-20 
Recipe_Tags_Online_Offline, 7-20 
Save_Data_Record_from_Display, 7-20 
Save_Data_Record_from_Display_as, 7-20
Save_Date_Record, 7-20 
Synchronize_Data_Record_in_Display,

7-20 
Function extensions, 3-1 
Function keys, 6-2 

LED, 3-16 
Functionality, 1-2 , 2-1 
Functions, 3-11 

Connect_Disconnect_PLC, 3-9 
Display Information Text, 6-5 
Display_event_message_window, 6-20 
downloading data records, 7-20 
Exit_runtime, 6-7 
Export_Data_Records, 7-24 , 7-26 
Export_Import_passwords, 6-38 
Import_Data_Records, 7-20 , 7-22 , 7-24 ,

7-26 
Language, 6-6 
Logoff_user, 6-37 
read line, 6-28 
Show_alarm_message_buffer, 6-23 
Show_alarm_message_page, 6-22 
Show_event_message_buffer, 6-23 
Show_event_message_page, 6-22 
Trend_view_read_mark_backward, 6-28 
Trend_view_read_mark_forward, 6-28 
Trend_view_read_mark_on_off, 6-28 
Use_On_Screen_Keyboard_ON/OFF, 6-4 

G
GE Fanuc, 3-18 
General operation, 6-1 
Global tags, 3-10 
Graphic, 3-4 
Graphic box, 3-5 
Graphic display, 3-5 
Graphic display units, 4-2 
Graphic list, 3-5 
Graphics, 3-1 
Group acknowledgement, 2-1 

H
Hard disk, 4-4 
Hardcopy, 3-16 
Hardware, 4-4 
Help text, 2-3 

Call, 6-4 
messages, 6-20 , 6-25 

Hidden buttons, 6-11 
Hierarchy, Password, 6-36 
HMI System Messages, A-1 
HMI system messages, Language, A-1 
Home position, Status button, 6-13 

I
Icons, 6-5 
Import

data record, 7-23 
data records, 7-26 
password list, 6-38 

Import_Data_Records, function, 7-20 , 7-22 
Incrementation, simulator, 5-18 
Information, Documentation, 1-3 
Initial startup, 5-1 
Initial value, tags, 7-27 
Input field, 3-4 , 6-16 
Installation

electrical, 4-5 
ProTool/Pro RT, 5-4 
Windows, 5-3 

Installation language, 5-5 
Installing printer, 5-3 
Interfaces, OP37/Pro, 4-5 
Interrupt, Trends, 6-29 , 6-30 
Introduction, 1-1 
Invisible buttons, 3-6 

K
Key, Status button, 6-13 
Keyboard action, screens, 6-2 
Keyboard operation

Screens, 6-2 
Windows, 6-3 

L
Labeling, buttons, 6-11 
Language, System messages, A-1 
Language change, 6-6 
Language switch, 2-3 
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Languages
changing, 6-6 
number of, 2-3 

Layout, recipe view, 7-10 
LED, 6-5 
LED control, 3-16 
Length, message text

alarm messages, 2-1 
event messages, 2-1 

Level, Password, 6-36 
Library , symbols, 6-41 
License disk, 4-1 , 5-5 
Limit monitoring, 2-3 
Limit value check, 6-16 
Limit values, Trend view, 6-28 
Line, 3-5 
Lines per message

alarm messages, 2-1 
event messages, 2-1 

List, passwords, 6-37 
Load_Data_Record, function, 7-20 
Local tags, 3-10 
Log on, 6-7 , 6-36 
Logging off, 6-37 
Login, 6-36 
Logoff, 6-37 
Logoff_user, Function, 6-37 
Lucky Goldstar, 2-4 , 3-18 

M
Management, passwords, 6-37 
Maximum value, bar graph, 6-27 
Message acquisition, 2-2 
Message archive, 3-8 
Message buffer, 2-2 , 3-8 , 6-23 

capacity, 2-2 
print, 3-16 

Message categories, 6-25 
Message classes, 3-8 
Message events, 2-2 , 3-8 
Message indicator, 6-21 
Message line, 3-8 , 6-19 
Message logging, 2-2 
Message page, 3-8 , 6-22 
Message view, 3-6 , 3-8 , 6-24 

simple, 3-6 , 6-26 
Message window, 3-8 , 6-19 

Messages, 3-8 
buffering, 3-8 
display, 3-8 
edit, 6-20 , 6-25 
print, 3-16 
simulation, 5-14 

Minimum value, bar graph, 6-27 
Mitsubishi, 2-4 , 3-18 
Modbus, 3-18 
Modicon, 2-4 , 3-18 
Multi Panels, 4-2 

N
Navigation, Trends, 6-29 
New_Data_Record, function, 7-20 
non–return pointer, 6-33 
Number

alarm messages, 2-1 
entries, 7-8 
event messages, 2-1 
languages, 2-3 
passwords, 2-3 
Recipes, 2-3 
recipes, 7-8 

Numeric input field, 6-16 

O
Objectives, 1-2 
Objects in a projects, 3-3 
Offline

editing data records, 7-21 
tags, 7-7 

Offset, Status/Force, 6-39 
Omron, 3-18 
Online, editing data records, 7-21 
OP37/Pro

Connectable PLCs, 4-5 
settings, 5-10 

OPC, 2-4 , 3-18 
Operand, Status/Force, 6-39 
Operate, simulator, 5-17 
Operating

runtime software, 6-1 
screen objects, 6-9 

Operating elements, recipe view, 7-11 
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Operating system, 1-1 , 4-3 
Operating units, 4-2 
Operation

unauthorized, 6-36 
via keyboard, 6-1 

Operation acknowledgement, 6-11 
Operator prompting, 2-3 
Output field, 3-4 

P
Panel PCs, 1-2 , 4-2 
Parameters, system messages, A-1 
Password

delete, 6-38 
management, 6-37 
set up, 6-38 

Password hierarchy, 6-36 
Password level, 6-36 
Password levels, number of, 2-3 
Password list, 3-7 , 6-36 , 6-37 
password list, export/import, 6-38 
Password protection, 2-3 
Passwords

entry, 6-16 
import/export, 6-38 
number of, 2-3 

PC, connectable PLCs, 4-6 
PC Loader, 5-12 
PLC

connecting, 3-17 
Connection, 4-2 
simulation, 5-14 

PLC jobs, 7-23 
PLC operands, 6-39 
Pointer instrument, 6-33 
Polygon, 3-5 
Polyline, 3-5 
Positioning, 7-21 
Power Tags, 4-1 
Print

message buffer, 3-16 
Messages, 3-16 
protocols, 3-16 

Print functions, 2-3 
Printing, 3-16 

event, 6-11 , 6-13 , 6-42 
Process tags, 3-10 

Process values
alarm messages, 2-1 
event messages, 2-1 

Process visualization software, 1-1 
Processor, 4-4 
Product Description, 3-1 
Project

Automatic start, 5-20 
compilation, 5-11 
downloading, 5-10 
languages, 6-6 
simulation, 5-14 
start, 5-11 , 5-20 
test, 5-6 
transfer, 5-11 

Project , start via PC Loader, 5-21 
Protocols

SIMATIC 505, 2-4 
SIMATIC S5, 2-4 
SIMATIC S7/M7, 2-4 

ProTool/Pro, 1-1 
Components, 1-1 

ProTool/Pro components, 1-1 
ProTool/Pro RT Start menu, 3-1 
ProTool/Pro Runtime, Installation, 5-4 
PU functions, Status/Force tag, 2-3 
Purpose of recipes, 7-1 

Q
Quick selection of data records, 7-13 

R
RAM , 4-4 
Random, Simulator, 5-18 
Read, data record from PLC, 7-18 
Read line

backwards, 6-30 
forwards, 6-30 
functions, 6-28 
on/off, 6-29 

Realtime trend, 6-28 
Recipe functions

return values, 7-13 , 7-23 
Status message, 7-13 , 7-23 

Recipe screens, 3-2 , 7-19 
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Recipe view, 3-2 , 3-7 , 7-10 , 7-19 
layout, 7-10 
operating elements, 7-11 

Recipe_Tags_Online_Offline, Function, 7-20 
Recipes, 2-3 , 7-1 

Application examples, 7-4 
Application scenarios, 7-3 
change structure, 7-27 
configuring, 7-7 
data flow, 7-3 
definition, 7-1 , 7-2 
example, 7-2 
name, 7-7 
number, 7-8 
overview, 7-1 
Use, 7-3 

Rectangle, 3-5 
Reduce, trend view, 6-30 
Releasing, event, 6-11 , 6-13 , 6-42 
Renaming, data records, 7-17 
Reports, 3-14 

print, 3-16 
Reset, Password level, 6-37 
Resolution, 4-4 
Return values, Recipe functions, 7-13 , 7-23 
Runtime

Exit, 6-7 
operation, 6-1 
Software, 1-1 
Start configuration, 5-20 

Runtime software, 5-13 

S
Save

data record, 7-14 
simulation, 5-15 

Save_Data_Record_from_Display, Functions,
7-20 

Save_Data_Record_from_Display_as,
Function, 7-20 

Save_Date_Record, function, 7-20 
Scenarios , test project, 5-10 
Scheduler, 3-15 
Scope of functions, 2-1 
Screen, 2-3 
Screen change, 6-2 
screen keyboard, 6-4 
Screen objects, 2-2 , 2-3 , 6-9 

coloration, 5-4 
Screen saver, 5-4 , 6-8 
Screens, 2-2 , 2-3 , 3-4 

Scripting, 3-15 
Scripts, 3-15 
Scrolling, Trends, 6-29 , 6-30 
Section

zoom In (trend view), 6-29 
zoom out (trend view), 6-29 

Selection field, 3-4 , 6-18 
Selection list, 6-18 
Separator , 7-24 
Service Pack, Windows, 4-3 
Set up

direct cable connection, 5-21 
Password, 6-38 

Set up program icon, 5-20 
Settings

Date/Time, 6-34 
full screen, 6-7 
OP37/Pro, 5-10 
Runtime software, 6-7 

Shift bit, 5-14 
Shift report, 2-3 
Show_alarm_message_buffer, Function, 6-23 
Show_alarm_message_page, Function, 6-22 
Show_event_message_buffer, Function, 6-23 
Show_event_message_page, Function, 6-22 
SIMATIC HMI Symbol Library, 3-7 
SIMATIC manager, 5-8 
SIMATIC Panel PC, 1-2 
SIMOTION, 3-17 
Simple message view, 3-6 , 6-26 
Simulating archive tags, 5-16 
Simulation

example, 5-19 
save, 5-15 

Simulation table, 5-15 , 5-17 
Simulator, 2-4 , 3-2 , 5-6 , 5-14 

operate, 5-17 
Sinus, Simulator, 5-18 
Slider control, 3-7 , 6-31 
Sorting

Message buffer, 6-23 
Message display, 6-25 
Message page, 6-22 
password list, 6-37 

Source file, storage location, 5-13 
Spreadsheet program, 3-12 , 7-23 
Square, 3-5 
Standard PC, 1-2 
Start, Update trends, 6-29 
Start menu for PC, 5-12 
Starting a project, 5-20 
State view, 3-6 
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Status button, 3-6 , 6-13 
Status change, event, 6-13 , 6-15 
Status message, Recipe functions, 7-13 , 7-23 
Status value, 6-40 
Status/Force, 2-3 , 3-7 , 6-39 
Stop, Update trends, 6-29 
Storage location

data records, 7-7 , 7-14 
project file, 5-13 
runtime software, 5-13 

Superuser, 6-36 
Swap file, 4-4 
Switch, 3-6 , 6-15 

Status button, 6-13 
Symbol Library, 6-41 
Symbol library, 6-41 
Symbolic output field, 3-4 
Synchronization, data records, 7-7 
Synchronize, data record, 7-19 
Synchronize_Data_Record_in_Display,

Function, 7-20 
System limits, 7-8 
System messages, 3-8 , 6-20 
System requirements, 4-3 

T
Tabulator sequence, 6-2 
Tags, 3-10 

initial value, 7-27 
offline, 7-7 
Simulate values, 5-16 
synchronizing, 7-7 
value simulation, 5-14 
VB script, 3-10 

Target devices, 4-2 
Task switching

lock, 6-7 
Simulator, 5-15 

Telemecanique, 2-4 , 3-18 
Test, 3-2 , 5-6 
Text, 3-4 
Text Displays, 4-2 
Text editor, 7-23 
Text–based display units, 4-2 
Time, 6-16 , 6-34 

simulation, 5-16 
Time specification, Date/Time, 6-34 , 6-35 
Time stamp, 6-22 , 6-23 , 6-34 
Time zone, 6-8 

setting, 5-4 
Time/Date, 3-5 

Time_expired, event, 3-15 
Tips on the recipe view, 7-13 
Touch Panel, 4-2 
Touch panels, 3-2 , 6-4 
Transfer, 3-1 
Trend type, 6-28 
Trend view, 3-6 , 6-28 

uncertain status, 6-28 
Trend_view_read_mark_forward, functions,

6-28 
Trend_view_read_mark_on_off, functions, 6-28
Triggering, Trends, 6-28 

U
Unauthorized use, 6-36 
Uncertain status, trend view, 6-28 
Update

Status/Force, 6-40 
Trends, 6-29 

Use, Recipes, 7-3 
Use_On_Screen_Keyboard_ON/OFF, function,

6-4 
User data length, 2-3 , 7-8 

V
VB Script, 2-4 , 3-2 
VB script, tags, 3-10 
Vector graphics, 3-5 
View, Password list, 6-37 
Virtual key, 6-11 

W
WinAC, 2-4 , 3-17 
Windows, 1-1 

configuring, 5-3 
install, 5-3 

Windows–based systems, 1-2 , 4-2 
Writing, data records to PLC, 7-18 

Z
Zoom

trend view, 6-29 , 6-30 
Zoom area, enlarge/reduce (trend view), 6-30 
Zoom in, trend view, 6-29 
Zoom out

trend view, 6-28 , 6-29 
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